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Warning and Disclaimer

ThreatQuotient, Inc. provides this document “as is”, without representation or warranty of any
kind, express or implied, including without limitation any warranty conceming the accuracy,
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providing this information.
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Introduction

The following provides an introduction to the ThreatQ platform.

« ThreatQ Introduction

o Concept Overview

ThreatQ Introduction

ThreatQ is a cyber threat intelligence platform that focuses on centralizing, structuring, and

strengthening a security organization's intelligence-driven defensive posture against attacks.

Concept Overview

The following describes how ThreatQ helps organizations manage threat intelligence, allow-

ing them to defend against sophisticated cyber-attacks.

o Threat Library

o Adaptive Workbench

« Open Exchange

Threat Library

A central repository combining global and local threat data to provide relevant and con-
textual intelligence that is customized for your unique environment. Over time, the library
becomes more and more tuned to your environment and fills in the intelligence gaps created

by different sources, all providing only some pieces of the puzzle.
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Adaptive Workbench

An open and extensible work area for security experts across the organization to work within
your processes and tools. A customizable workflow and customer-specific enrichment

streamlines investigations and analysis, and automates the intelligence life cycle.
Open Exchange

ThreatQ is the only threat intelligence platform specifically designed for customization to
meet the requirements of your unique environment. Get more from your existing security
investments by integrating your tools, teams and workflows through standard interfaces and

an SDK/API for customization.
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Navigation Menu

The table below outlines the ThreatQ navigation menu and its related processes.

Name Description References
ThreatQ Icon | Clicking on the ThreatQ icon will navigate you | N/A
back to the home page and dashboard.
Threat Access and search the Threat Library and o Threat
Library view system object details. Library
« Advanced
Search
« Object
Details Page
« System
Objects
Investigations | Navigates to ThreatQ Investigations, a cyber- o ThreatQ
security situation room that enables col- Investigations
laborative threat analysis, investigation, and User Guide
coordinated response.
Analytics Navigates to the Analytics section which  Analytics
provides a summary view of Adversary, Event,
File, Indicator, and Signature Object Types.
Create Button | Create system objects. « Adding
Adversaries
« Adding

ThreatQ User Guide, Version 4.30
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# Name Description References

Events

« Adding Files
« Adding an

Indicator

« Parsing for
an Indicator

» Adding a Sig-
nature

« Adding a

Yara Sig-
nature

6 | Searchlcon | Perform a basic search for a system object or « Search

perform an Indicator Search. « Indicator

Search

7 | Message Receive in-app notifications of system job pro- « Notification

Center Icon cesses such as Bulk Actions. Center

g N

ﬂ Administrator and Main-
tenance account users will
also receive feed health noti-
fications.

(. J

8 | Site Settings | Configure site settings such as user man- « User Man-

agement, incoming feeds, TLP etc. agement

« Incoming
Feeds Over-

view
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# Name Description References
« Exports Over-
view

« Operations
Overview

« Reports Over-

view

 Licensing
Overview

9 | Userlcon Access your user profile. « Managing

your User
Account

Notification Center

The Notification Center alerts you, via an in-app notification icon, when a Bulk Action job
has been queued and/or completed. Administrator and maintenance accounts will also
receive feed health notifications via the Notification Center. The icon is located on the nav-
igation menu for the application. This allows you to monitor system processes while working
within ThreatQ.

Analytics =+ Create Q A

+ Create Q A o NOTIFICATION CENTER MARK ALL AS READ
rc

SYSTEM NOTIFICATION
NOTIFICATION CENTER E
© Bulk Status Job #1 completed successfully. .

alew seconds ago
SYSTEM NOTIFIGATION Bulk Status Job #1 completed successfully.

A 'Alienvault OTX' has encountered errors

2hours ago

Related Topics:
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« Bulk Actions

« Feed Health Notifications
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System Access

The following describes how to login and log out of the platform.

o System Access Overview

« System Login

« Managing your User Account

« 2 Step Verification

System Access Overview

To access the ThreatQ web Ul, you must authenticate yourself with a username and pass-

word. You can use the main menu to access ThreatQ functionality.

System Login

When you installed ThreatQ, you set up the default user account, Maintenance Account,

which you can use to log into the web UL.

Using this account, you can create additional user accounts.

"1

Passwords must be 15 characters or longer. There is no limit on the char-
acter type.

Related Topics:

« Logging into ThreatQ

« Session Timeout
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Logging into ThreatQ

When you installed ThreatQ, you defined an IP address for the web Ul, and set up the Main-

tenance Accountand password.

1. In your web browser, navigate to https://your-ThreatQ-web-ip-

address.

THREATQ )

LOGIN

Copyright © 2019 ThreatQuotient, inc.

2. Enter your username (email address) and password.

3. Optionally, if you have 2-step verification enabled, complete the following steps:
« Enter your verification code from Google Authenticator.
« Optionally, choose to Remember this computer for 30 days.

4. Click Login or Submit.
Session Timeout

User sessions time out after 60 minutes of inactivity. Users with administrator and main-
tenance roles can update this setting or, disable session timeouts for that specific user, by

viewing the user's account profile. See the Editing a User topic for more details.

ThreatQ User Guide, Version 4.30 32



THREA TO n System Access

"1

The initial account created when installing ThreatQ does not have a set
session time by default. This setting can be updated as well from the user
profile account.

Managing your User Account

When you click on your User Avatar and select My Account, the system directs you to the
Edit User page for your current login. From here, you can edit your user account, set up 2-

step verification, view your API credentials, or view your login history.

Procedure

1. Click on your user avatar icon, located at the top-right of the screen, and select My

Account

My Account

User Guide

Product Updates

Log Out

2-5TEP VERIFICATION

ThreatQ User Guide, Version 4.30 33



THREA TQ ” System Access

The User Profile page loads.
THREATQ

Edit User

User Profle Lo Aty

Profile Information User Avatar:

> Th

Brop Image here or browse

Change Password

Change Password

Enable 2-5tep Verification Disabied )

APl Credentials
Eaehy DV i Mg 1040 YOUF SO00ANL O] D8 TEgiared 10 NG DOSh yOUF DaSSHOnd and 3
VEnfCAtion code.

Session Timeout

L)

Déxable Timeous

2. On the User Profile tab, you can view and/or edit the following settings of your user

account:
Field Description
Name You can update your name.
Title You can update your job title.
Email You can update your email address.
Password You can click on the Change Password link to update your

password.

API Credentials | You can view your API credentials, a unique Client ID, which

will allow you to connect with ThreatQ's API.
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Field Description

Session You can update or disable your session timeouts.

Timeout

User Avatar You can update your user avatar; see Update User Avatar for
more details.

2-Step Veri- Optionally, you can set up 2-step verification; see 2 Step Veri-

fication fication for more details.

3. Optionally, you can click on the Login Activity tab to view:
THREATQ 3

Edit User

User Prafile Login Activity

TIMESTAMP = IP ADDRESS ACTION

10/06/2019 07:04pm 10.102.0.1 Successful Login

« The last date and time you logged in.
« The IP Address where you logged in.
« Whether the login was successful or not.

4. Click Save.

User Avatar Icons

User avatar icons provide a personalized look to your ThreatQ dashboard. Clicking on the

avatar icon will reveal the My Account and Log out options.
Users can update their avatars by clicking on the avatar and selecting My Account.

« Update User Avatar Graphic
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Update User Avatar Graphic

1. Click on avatar icon located to the top-right on the screen and select My Account.
The Edit Userform will load.

2. Select one of two options:
« Click browse and select the icon graphic to upload.
« Click and drag the new icon graphic onto the page.

3. Click Save at the bottom of the page.

2 Step Verification

When you enable 2-Step Verification (also known as two-factor authentication), you add an
extra layer of security to your account. After 2-Step Verification is active, you sign in with your

password and a code sent to your mobile device.

o Enabling 2 Step Verification

Enabling 2 Step Verification

Procedure:

—

. Choose the User Settings icon> My Account.

N

Under Enable 2-Step Verification, click Enabled.

w

. In the Enable 2 Step Verification dialog box, complete the following:
« Scan the gr code using your Google Authenticator mobile app.

« Enter the validation code delivered to your mobile device via Google

Authenticator.
o Click Submit.
4. Click Save.
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What to do next

The nexttime you log in, you must use the newest verification code.
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Licensing

The following provides an overview of licensing for the ThreatQ platform.

o Licensing Overview

o Viewing the License Status

« Updating a License

Licensing Overview

Your ThreatQ deployment requires a license to initialize the platform. ThreatQ Support
provides the initial license and any subsequent licenses provided to maintain the platform.

You apply the initial ThreatQ license during first boot, as described in the ThreatQ Getting

Started Guide. Any subsequent license updates can be applied in the ThreatQ user inter-

face.

Viewing the License Status

ThreatQ licenses are not perpetual. To view the license expiration date, complete the fol-

lowing steps:
Procedure

Choose the Settings icon >About .

Updating a License

If you receive a new license from Support, apply the new license by accessing the About

page.

Procedure
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1. Choose the Settings icon > About.
Choose Update License.

Enter the new license key.

W N

Click Submit.
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User Management

The following describes how to manage user accounts.

o User Management Overview

« User Account Creation

« User Account Modification

User Management Overview

ThreatQ uses role-based access control to manage user accounts. The system provides sev-
eral user roles, each containing a set of permissions for accessing system functionality. You
create user accounts, and assign them to a user role. The user role determines each

account's set of permissions.

After you create a user account, you can modify the user role group, full name, and email

address.
« User Roles
User Roles

The following details the user roles and their associated permissions.

User Role Permissions

Members have access to the
Maintenance Account entire ThreatQ user interface and

can edit all data.
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User Role Permissions

Note: The initial main-
tenance account, cre-
ated when installing
ThreatQ, can not be

deleted

Members have access to the
Administrative Access entire ThreatQ user interface

and can edit all data.

Members have access to most of
the ThreatQ user interface, except

for:

User Management

Incoming Feeds

Exports

OAuth Management

Primary Contributor Access System Configurations

Members can edit:

« Theirown userinfo
« Whitelist Management

Operations Management

Object meta data

Saved Searches
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User Role Permissions

Members have access to most of
the ThreatQ user interface, except

for:

User Management

« Incoming Feeds

« Indicator Management

« Whitelist Management
Read Only Access . Exports
« Operations Management

o OAuth Management

« System Configurations
Members cannot edit any data.

Members can export search res-
ults.

User Account Creation

When you firstinstall ThreatQ, the system creates a default user account, the Maintenance
Account. You cannot delete this account, and you can use it to initially create other user

accounts. Each user account must have a unique username.

Only the Maintenance Account and Administrative Access user role have permissions to
access user management functionality. You can only create new user accounts if logged in

as one of these roles.
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o User Account Properties

« Adding a User

User Account Properties

. full name of the user asso-  any alphabetic character and
ame
ciated with this account spaces

. . . any alphabetic character and
Title optional user title
spaces

roles which this user
Group at least one role selected
account belongs to

Email email address associated  valid email address, such as user-
mai
with this account @domain.com

initial password asso-
Password _ . all characters
ciated with the username

Adding a User

1. From the main menu, choose the Settings icon > User Manangement.
Click Add User.
Enter the user's Name.

Optionally, enter the user's Title.

o &~ B

Select the level of access for the user from the Group drop-down menu.

Choose from the following options:
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« Maintenance Account
o Administrative Access
« Primary Contributor Access
o Read Only Access
Enter the user's Email address.
Enter a password for the user.

Retype the password.

© © N ©

Click Add User.

User Account Modification

After you create a user account, you can modify the account's role group, full name, title,

email address, and password.

o Editing a User

o Resetting User Passwords from the Command Line

« Deleting a User
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Editing a User

1. From the main menu, choose the Settings icon > User Management.

2. Click the name of the user whose profile you wish to edit.

The User Profile page loads.

THREATQ

Edit User

Uier Profle  Legin Achin

Profile Information User Avatar:

Drop Image here o browse
Change Password
Charge Paiswod d
Enable 2-Step Verification tisabled ()
APl Credentials
Eadch ime you Iog Inko yOur 3000unt, youTTl be requined 10 enter Doth your passwornd and 3
ANACHION Code.
Session Timeout
0
Disable Timeout

3. On the User Profile tab, you can view and/or edit the following settings:

Field Description
Name Update the user's name.
Title Update the user's job title.
Email You can update the user's email address.
Password You can click on the Change Password link to update the
user's password.
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Field Description

API Credentials | You can view the user's API credentials, a unique Client ID,

which will allow him/her to connect with ThreatQ's API.

Session You can update or disable the user's session timeouts.
Timeout
User Avatar You can update the user's user avatar; see Update User

Avatar for more details.

2-Step Veri- Optionally, you can disable 2-step verification; see 2 Step Veri-

fication fication for more details.

4. Optionally, you can click on the Login Activity tab to view:
THREATQ 3

Edit User

User Profile Login Activity

TIMESTAMP = IP ADDRESS ACTION

10/06/2019 07.04pm 10.102.0.1 Successful Login

« The last date and time the user logged in.
« The IP Address where the user logged in.
« Whether the login was successful or not.

5. Click Save.

Resetting User Passwords from the Command Line

If you have root access to your ThreatQ installation, you can reset any user's password from

the command line.
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1. SSH to your ThreatQ installation as root.

2. Navigate to the api directory:

cd /var/www/api

3. Run the following command:

php artisan threatqg:password-reset

4. Atthe prompt, enter the email address for the user whose password you are reset-

ting.
5. Atthe prompt, enter the new password.

6. Atthe prompt, re-enter the new password to confirm.

Deleting a User

A\ Deleting a user cannot be undone.

1. From the main menu, choose the Settings icon > User Management.
Select the user(s) you wish to delete.

Click the Delete. icon.

B W b

Confirm the deletion when prompted. If the user has any shared custom dash-

boards, select whether to delete the dashboards or reassign them to another user.
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Delete User

User 1 has shared dashboards, how would you like to proceed?

'I [ Reassign to another user v J !’

W Do not reassign. Delete these dashboards.
| @ Aviison Abraham
l ° Ari Ryan

@ Bobby Riccard

—
Q Davida Kraseak

5. Click Delete User.
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System Configurations

The following describes how to manage various system configurations in ThreatQ.

« Indicator Statuses

o Indicator Types

« Event Types

o Proxy
LDAP Authentication

Date and Time Format

Indicator Statuses

Indicator Statuses page allows you to view, duplicate, add, edit, and delete available sys-
tem-wide indicator statuses. You cannot edit nor delete indicator statuses provided by
ThreatQ (Active, Expired, Indirect, Review, Whitelisted), but you can add, edit, and delete

your own custom statuses.

Related Topics:

o Viewing Indicator Statuses

« Indirect Indicator Status

Adding an Indicator Status

Editing an Indicator Status

Deleting an Indicator Status
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Viewing Indicator Statuses
To view existing indicator statuses, complete the following procedure.

Procedure:

1. Navigate to Settings E] > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Active Poses a threat and is being exported to detection toals,
Expirad Mo longer poses a serious threat.

Indirect Associated to an actiee indicator or event fi.e. pONS)L
Review Requires further analysis.

Whitelisted Poses NO risk and should never be deplayed.

66000868

O Dema This Is 2 dema

Statuses found within ThreatQ are listed by status, number, and description within the
Indicator Statuses table.

2. Optionally, to sort the table by a column, click the column header. To reverse the

column sorting order, click the header a second time.

Indicator Statuses Table Functions:

Function Description

Change the number of entries displayed in the table. 1. Click the dropdown

menu at the top right of
the table and select

the desired option.

Sort the table by a column. 1. Click the column
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Function Description

header.

2. To reverse the column
sorting order, click the

header a second time

Indirect Indicator Status

For feeds that set multiple statuses, A status of Indirectis assigned to indicators that meet the

following criteria:
« Indicators created from the relations array are imported with a status of Indirect.

« Ifanindicator already exists, its original status value will remain the same. However, if
the status is Indirect, and itis received as a parent indicator, its value will be updated

as defined in the connector configuration.
Currently, this status only applies to CrowdStrike and iSight feeds, where:

« For CrowdStrike, Indirectindicates that ThreatQ received the indicator from the

relations list for the parent indicator.

« ForiSight Partners, Indirectindicates that ThreatQ received an indicator that does

not have an attribute of Attack or Compromised.

Adding an Indicator Status

To add an indicator status that can be applied to any system indicator, complete the fol-

lowing procedure.

Procedure:
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1. Navigate to Settings E1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations At oy St
" 1 Type

ATUSTE « DESCRPMON & EOTECTFRDM FEID OVERR] o8 ATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad Mo longer poses a serious threat, Q
Indirect Associated to an active indicator or event fi.e. pONS). ®))]

Revlew Requires further analysts. CD A5t
Whitelisted Poses NO risk and should never be deplayed. c
O Dema This Is a dema @

2. Click Add New Status.

The Add a Status dialog box opens.

Add a Status

Status Name

Status Description

Add Status | Cancel

3. Enter a Status Name.

4. Optionally, enter a Status Description.
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5. Click Add Status.

System Configurations

Editing an Indicator Status

To edit an existing indicator status, complete the following procedure. You cannot edit indic-
ator statuses provided by ThreatQ.

Procedure:

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Indicator Statuses beaker Types Everit Types Bty LDAF

DESCRPTION &

Actrn Prmes a threat and is being sxparted to detection toals, [ &
Expired Mo longer poses a serious threat. §)]
Indirect Associated to an active indicator or event {i.e. pOMSL [E]
Resview Requires further analysis. CB
Wihitelisted Poses NO risk and should rever be deplayed. O

O oema This Is a dema &)
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2. Determine the indicator you want to edit and click Edit in the far right column.

The Edit Status dialog box opens.

Edit Status

Status Name

Demo

— Status Description

This is a demo

3. Optionally, enter a new Status Name.
4. Optionally, enter a new Status Description.

5. Click Save Changes.

Deleting an Indicator Status

To delete an indicator status, complete the following procedure. You cannot edit and delete
indicator statuses provided by ThreatQ. Custom statuses can only be deleted if there are no

indicators using that status.

Procedure:
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1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations Al e Status

Indicator Stanuses chcator Types Eveernt Types Browy LOAP General
FTATUSTE - DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL MDICATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad MO |onger poses a serious threat. $)]
Indirect Associated to an active indicator or event fi.e. pONS). ®))]
Revlew Requires further analysts @ 195
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This is a dema @

2. Determine the indicator you want to delete and select the corresponding checkbox

in the first column.

3. Click the Delete icon in the upper right hand corner.

A confirmation dialog box appears.

Are You Sure?

Are you sure? This action cannot be undone

Delete statuses | Cancel

4. Click Delete Statuses.
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System Configurations

Indicator Types

The Indicator Types table allows you to view a list of indicator types found in ThreatQ and
the total number of indicators associated with each type.

To view Indicator Types found within ThreatQ:

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens.

Indicator Statuses beaker Types Everit Types Bty LDAF

DESCRPTION &

Actrn Prmes a threat and is being sxparted to detection toals, O
Expired Mo longer poses a serious threat. ®))]
Indirect Associated to an active indicator or event {i.e. pOMSL [E]
Resiew Requires further analysis CB

- \
Whitelisted Poses NO risk and sheuld never be deplayed. O
O oema This Is a dema &)
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2. Click the Indicator Types tab.

The Indicator Types tab opens.
THREATQ )

System Configurations

indkcator Statuses redicatar Types Evert Types Prouy LOAF Genera

INCECATOR TYPIS ~ TOTAL INDICATORS
Binary String [}
CI0R Block [}
CVE [}
Email Address ]
Email Astachment a
Email Subject 1
File Mapping a
File Fath a
Filename a
OO 24
Fuzzy Hash a
GOST Hash a
Hash IGN ]
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Event Types

The Event Types page allows you to view, add, edit, and delete system events.

System Configurations Addd Neew Evert Type
Indicator Statuses Tdicator Types vant Types Proxy LDAP GEneral
25
TOTAL EVENTS & TOTAL INCICATORS &

Anonymizatian a

Camrmand and Cortral 1

Compromised PKI Certificate a

Dof Attack 1

Exfiltration a

Host Characteristics a

necident a

Login Compromise 0

Malware a

Spearphish a

S0L Injection Attack a

Watchlist a

Watering Hole a

Event Types provided by ThreatQ cannot be edited or deleted, but you can add, edit, and

delete your own custom event types.

System provided Event Types include:

« Anonymization « Malware

o Command and Control « Sighting

o Compromised PKI Certificate « Spearphish

« DoS Attack « SQL Injection
« Exfiltration » Attack

« Host Characteristics « Watchlist

« Incident » Watering Hole

« Login Compromise
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Related Topics:

Viewing Event Types

Editing an Event Type

Editing an Event Type

Deleting an Event Type

Viewing Event Types
To view existing event types, complete the following procedure.

To view Event Types found withing ThreatQ:

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens.

nnnnnnnn ] PROTECT FROM FEED OVERRIDE TOTAL MDICATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad MO |onger poses a serious threat. $)]
Indirect Associated to an active indicator or event fi.e. pONS). ®))]
Revlew Requires further analysts @ 195
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This Is a dema $)]
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2. Click the Event Types tab.

System Configurations
Indicator Statuses Indicator Types Event Types Frosy LOwP General
25
TOTAL EVENTS 8 TOTALINDICATORS 8
Anonymizatian [
Camrmard and Cantral 1
Campromised PRI Certificate a
DS Aftack 1
Exfiliration a
Host Characteristics a
neident Q
Lagin Compromise a
Malware 1}
Spearphish a
S0L Injectian Attack a
Watchlist Q
Watering Hole 0

Event Types Table Functions:

Function Description

Changing the number of entries displayed in the table 1. Click the dropdown
menu at the top right of
the table and select

the desired option.

Sorting the table by a column 1. Click the column

header.

2. To reverse the column
sorting order, click the

header a second time.
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Adding an Event Type

To add an Event Type, complete the following procedure.

Procedure:

1. From the main menu, select Settings [ > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations Adk New Status

indicatnr Statuses dcator Types Eveernt Types Browy LOAP General
STATUSES = DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL MDICATORS &
Actrn Prmes a threat and is being sxparted to detection toals, )
Expirad MO |onger poses a serious threat. ®))]
Indirect Associated to an actiee indicator or event fi.e. pONS)L @
Review Requires further analysts 9)] 4
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This Is a dema @)
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations
Indicator Statuses Indicator Types Event Types Frosy LOwP General
25
TOTAL EVENTS 8 TOTALINDICATORS 8

Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics

ncidert

Lagin Compromise

Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Click Add New Event Type.

The Add Event Type dialog box opens.

Add Event Type

‘ Event Name

Add Type Cancel

4. Enter a Event Name.

5. Click Add Type.
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System Configurations

Editing an Event Type

To edit a user-generated Event Type, complete the following procedure.

ﬁ You cannot edit an Event Type provided by ThreatQ.

Procedure:

1. Navigate to Settings E1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations

Akl Waw Starus
Indicatar Slatuses Scator Types et Types Proay 0P General
STATUSES & DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL INDICATORS &
Active Poses a threat and is being exparted to detection toals, O
Expired Mo lenger poses a serious threat. '9)]
Indirect Associated to an actie indicator or event {i.e. pOMS). @
Revlew Requires further analysts: 9)] A5t
Whitelisted Poses NO risk and should never be deplayed, O
O Demo This Is 2 dema '$)]
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations

Indicator Statuses Indicator Types Event Types Frosy LOWP General

TOTAL EVENTS & TOTAL INDICATORS &

Anonymizatian
Camrmand ard Cantral
Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics

ncidert

Lagin Compromise

Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Determine the Event Type you want to edit and click Edit in the far right column.

The Edit Event Type dialog box opens.

Edit Event Type

— Event Name
‘ Ransomware

Save Changes Cancel

4. Enter a new Event Name.

5. Click Save Changes.
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System Configurations

Deleting an Event Type

To delete a user-generated Event Type, complete the following procedure.

-

A Custom Event Types can only be deleted if there are no events using that
event type.

ﬂ You cannot delete an Event Type provided by ThreatQ.

.

Procedure:

1. Navigate to Settings £ > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

DESCRIPTION &

Active Poses a threat and is being exported to detection toals.
Expired Mo longer peses a serious threat.

Indirect Assaciated to.an active indicator or event fi.e. pONS).
Review Requires frther analysts

Whitelisted Poses NO risk and should never be deplayed.

CH N R N N,

O Dema This isa dema
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations

Indicator Statuses Indicator Types Event Types Frosy LOWP General

25

EVENT TYPES = TOTAL EVENTS & TOTAL INDICATORS &

Anonymizatian

Camrmand ard Cantral

Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics
ncidert

Lagin Compromise
Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Determine the event type you want to delete and select the corresponding check-

box in the first column.

4. Click the Delete icon in the upper right hand corner.

A confirmation dialog box appears.

Are You Sure?

Are you sure? This action cannot be undone

Delete statuses | Cancel

5. Click Delete Types.
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Proxy

The System Configuration: Proxy page allows you to enable or disable proxies.

A Users are required to set their proxy server settings to use http: for their
https: traffic. The ThreatQ Proxy Configuration page can be found by nav-
igating to Settings > System Configuration > Proxy.

Access Proxies
To access proxies:
1. Navigate to Settings £*1 > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

2. Click the Proxy tab.

The Proxy Configuration tab loads.

System Configurations

Indicator Typas Ewant Types Precey LDwR

Enable proxy for HTTP traffic
@ Enable proxy for HTTRS traffic
Protocal

-]
hatpe

Proxy Table Functions:
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Function Description

Enabling a proxy for HTTP or HTTPS 1. Check the correct proxy type and
traffic enter configuration details. Click
Save Changes. ThreatQ will check

that the proxy has been configured

properly.
Disabling a proxy for HTTP or HTTPS 1. Uncheck the proxy you wish to dis-
traffic able, and click Save Changes.

LDAP Authentication

ThreatQ allows you to configure system access via LDAP, the Lightweight Directory Access

Protocol. You have two configuration options:

« Anonymous Bind (previously referred to as basic)

« Authenticated Bind

"l

It is highly recommended that you review the Required Information for
Creating LDAP Authentication topic before configuring your LDAP set-
tings.

To Access the LDAP tab:
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1. From the main menu, select Settings 1 > System Configurations.

System Configurations

The System Configurations page opens to the Indicator Statuses tab.

System Configurations

Ak W Staus
Indicanr Statuses whator Types Even Types Proay L0AP General
STATUSES = DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL INDICATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expired Mo longer pedes a serious threat. 8)]
Indirect Associated to an active indicator or event fi.e. pONS). ®))
Resiew Requires further analysts CD 1S5S
Whitelisted Poses NO risk and should never be deplayed. C
O Dema This is a dema '$)]
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2. Click the LDAP tab.

The LDAP tab opens with the Legacy LDAP form loaded by default.
THR EATQ in Y & Investigations

System Configurations

Indicator Statuses Indicator Types Event Types Proogy LOwP General

LDAP @ Enabled

Lightweight Directory Access Protocol (LDAF) is a lightweight client-server protocol for accessing directory services and is used for authentication and
storing information. Complete the fields below to set the primary server settings and map your permission levels to LDAP.

egacy LDAP Settings Updated LDAP Settings
Primary Server Settings Map Your Permission Levels to LDAP
Server Addre (Note: You can not list the same LDAP User Group for Mulftiple permission
|dap:/ftgldap.threatg.com levels)
Part # administratar
389

AP Domalr
threatq.com

IldapSuper

Ne N Idapanalyst

memberUid

IdapObs;_‘r_\rer_\
E‘I‘I
Yes . -
Peo-p.;le

uid

Switching LDAP Connections
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To switch between using the Anonymous (Legacy) and Authenticated (Updated) Bind LDAP

connections, open the desired connection type’s form in the LDAP section and click on the

Save button.

4 Y

ﬂ Example: A User is using the legacy LDAP Settings option. He switches
to the Updated LDAP tab and clicks on Save. ThreatQ will now use the
Updated LDAP Settings. If he switches back to the Legacy LDAP tab and
clicks on Save again, ThreatQ will start using the Legacy LDAP settings
again.

Related Topics:

« Required Information for Creating LDAP Authentication

« Configuring Anonymous Bind LDAP Settings

o Configuring Secure LDAP

o Configuring Authenticated Bind LDAP Settings

Required Information for Creating LDAP Authentication

Before you configure a connection to your LDAP server, you should work with your LDAP

administrator to collect, at minimum, the following information:
Anonymous Bind
o LDAP Server URL

LDAP Port

LDAP Group Field Name

LDAP Filter Field Name

LDAP group mappings for super, maintenance, analyst, and observer

Authenticated Bind
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o LDAP Server name or IP Address

o LDAP port

o LDAP base DN

o LDAP Group Member Field Name

o LDAP Primary Group Name

o Whetherto use LDAP over SSL (Idaps or Idap)
o LDAP Userld Key Field Name

« LDAP User Group Member Key Field Name

« LDAP group mappings for super, maintenance, analyst, and observer

Configuring Anonymous Bind LDAP Settings

+ . . . .
O Only users with an Administrative or Maintenance account can access
LDAP settings.

Procedure:
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System Configurations

1. Navigate to Settings £*1 > System Configurations.

2. Click on the LDAP option.

The Legacy LDAP Settings form will load by default.
THREATO i) Threat Library

Ll Analytics

System Configurations

Indicator Statuses Indicator Types Event Types

LDAP

General

@ Enabled

Lightweight Directory Access Frotocol (LDAF) is a lightweight client-server protocol for accessing directory services and is used for authentication and
storing information. Comnplete the fields below to sat the primary server settings and map your permission levels ta LDAP.

f‘g.’l(')l DAP ':!".’If‘Eﬁ l.l'lﬂ.'u[x"ﬂ DAP ‘19_.If'g".
Primary Server Settings
|dap://tgldap.threatg.com
389
AP Do
threatg.com
Mo
memberUid
1 Narr

tn

Yes
Peaple

uid

Map Your Permission Levels to LDAP

{Note: You can not fist the same LDAP User Group for Multiple permission
levels)

administratar

ative Access
IdapSuper

Ida p.‘lkr:.aryst

IdapObserver

ThreatQ User Guide, Version 4.30

73



THREA TQ H System Configurations

3. Complete the following server settings:

Field Description

Server Address Enter the name of the server where LDAP is hosted.

Example: |dap:/[servername]

Port # 389 for LDAP

636 for LDAPS

"1

If LDAPS is used, the Port # will default
to 636.

LDAP Domain Enter the domain for which LDAP is configured to authen-

ticate.

Example: threatq.com

Append Domain to Choose from the following options:

Username _ _
« Yes for most Active Directory servers

« No for most Open LDAP servers

Filter Field Name This field is specific to your LDAP directory configuration.
AD Example: memberuid

OpenLDAP Example: uid

Group Field Name This field is specific to your LDAP directory configuration.
AD Example: memberof

OpenLDAP Example: cn
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Field Description

Use RDN? Choose from the following options:

« Yes to use Relative Distinguished Names.

« No to use full Distinguished Names

Organizational Unit This field is specific to your LDAP directory con-
(OU) figuration. Your LDAP administrator should provide the

correct value for this field.

User Lookup Name This field is specific to your LDAP directory configuration.
AD Example: memberUid

OpenLDAP Example: uid

4. Complete the MAP your Permission Levels to LDAP section:

"

You can not list the same LDAP User Group for multiple permission
levels. For roles not mapped, you should enter a hyphen: "-." You
cannot save the configuration without entering a value in each field.

Field Example

Maintenance OpenLDAP Example: [dapSuper

Account
AD Example:

CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=com

Administrative OpenLDAP Example: administrator

Access
AD Example:

CN-=linux-admins,CN=Builtin,DC=yourdomain,DC=com
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Field Example

Read Only Access | OpenLDAP Example: IdapObserver

AD Example:
CN=read-onlyCN=Builtin,DC=yourdomain,DC=com

Primary Contributor | OpenLDAP Example: IdapAnalyst

Access
AD Example:

CN=primary-contributor, CN=Builtin,DC=yourdomain,DC=com

5. Click Save Changes.
6. Click on the Enable/Disable toggle switch to enable LDAP.

"1

If your LDAP fails to enable or fails to function properly, validate your
inputs. If the configuration continues to fail, please contact ThreatQ Sup-
port.

Configuring Secure LDAP

"l

This topic is for Anonymous Bind LDAP connections only. The steps
needed to create a secured connection authenticated bind are included in
the Configuring Authenticated Bind LDAP Settings topic.

To configure secure LDAP, you must complete the following steps:

1. Enter your LDAP settings in the ThreatQ user interface. See the Configuring

Anonymous Bind LDAP Settings topic for more details.

2. Access the ThreatQ appliance command line as root and edit and navigate to the

following directory: /etc/openldap/.

ThreatQ User Guide, Version 4.30 76



THREA Tﬂ H System Configurations

3. Use vi to edit Idap.conf and update/confirm that your settings are as follows:

#
# LDAP Defaults
#

# See ldap.conf (5) for details

# This file should be world readable but not world writable.

BASE dc=[your domain],dc=com

URI ldap://[your servername] :389 ldaps://[your servername]:636

#SIZELIMIT 12
#TIMELIMIT 15

#DEREF never
TLS CACERTDIR /etc/openldap/certs

# Turning this off breaks GSSAPI used with krb5 when rdns =
false
SASL NOCANON on

TLS REQCERT allow

( M)

A ThreatQ recommends that you edit Idap.conf on the appliance,
rather than editing off box and uploading it. If you do edit the file off
box, ensure that you use a linux editor. Windows and Mac editors
may corrupt the file.

(& J

If your LDAP fails to enable or fails to function properly, validate your inputs. If the con-

figuration continues to fail, please contact ThreatQ Support.

Configuring Authenticated Bind LDAP Settings

A It is recommended that you contact ThreatQ Support before configuring an
authenticated bind connection.
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"1

Only users with an Administrative or Maintenance account can access
LDAP settings.

Procedure:
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1. Navigate to Settings £*1 > System Configurations.
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2. Click on the LDAP option and select the Updated LDAP Settings tab.
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The Updated LDAP Settings form will load.
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System Configurations

THREAT()

System Configurations

ndCator Statises Indicator Typs Event Types Pray LCAP General

LDAP @) Enabled

Lightwelght Directory Access Protocol (LDAP) [s a lightwelght client-server protocol for accessing directory services and s usad for authentication and storing informarten. Complete the fields
below to set the primary server settings and map your permission levels to LDAP.

pEacy LOKP Settings Updated L&P Sattmngs
Server Connection Settings Protocols
@threatg.com Use 881 Yo

tgad.threatg.com

Map Your Permission Levels to LDAP

(Nate: Woer san nat st the sarme LDAP User Graup for tultiple permissian levels)

administrator

389
tgadmin idapSuper
idapAnalyst
-
’ dapCbserver

Connect To Retrieve Data

LDAP Schema

DC=threatg,0C=com
List Users

dn

user

TEuSErs

memberof

sAMACcountName

uid

ThreatQ User Guide, Version 4.30 82



THREA TQ M System Configurations

3. Complete the Server Connections Settings section:

Field Description

Account Suffix The LDAP account suffix.

Host Address Name of the LDAP domain controller

without the protocol.

Example: tgldap.threatg.com

Port Number The LDAP port; either 636 or 389.

( N
"

ﬂ Only standard ports for
secured and unsecured
connections are sup-
ported. Use port 636 if
using SSL to create a
secured connection.

\

Admin Usemame The LDAP administrative username.

Admin Password The LDAP administrative password.

4. Click on Test Connections to verify the settings are correct.

5. Complete the LDAP Schema section:

Field Description

Base DN The Base DN of the LDAP server con-

nection.

Example: DC=[server], DC="com"

DN Field Name The field used to retrieve the DN or users

and groups.
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Field Description

/' This field should be
DN for both OpenLDAP
and Active Directory.

User Search Filter The field to search for users.

For

OpenLDAP: objectClass=posIxAccount

For Active Directory: objectClass=user

Group Search Filter The field to search for grpups.
For OpenLDAP: objectClass=posIxGroup

For Active Directory: objectClass=group

Primary Group Name The primary group hame.

Group Member Field Name This field is used to search for groups that a

user belongs to.
For OpenLDAP: cn

For Active Directory: memberof

User ID Key Field Name Field used to search for users based on

email.
For OpenLDAP: uid

For Active Directory: sSAMAccountName

User Group Member Key Field Name | Field used to search for groups that user
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Field Description

belongs to.

For OpenLDAP: memberUid

For Active Directory: uid

6. Under the Protocols section, use the Yes/No toggle switch to select whether the

connection will use SSL.

"1

If the connection will use SSL, confirm that the port number, setin
step 3, is 636 to create a secured connection.

7. Complete the MAP your Permission Levels to LDAP section:

"1

You cannot use the same LDAP User Group for multiple permission
levels. For roles not mapped, you should enter a hyphen: "-." You
cannot save the configuration without entering a value in each field.

Field Description

Maintenance Account | The LDAP account the ThreatQ Maintenance group will

map to for permissions.
Open LDAP Example: IdapSuper

AD Example:
CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=com

Administrative Access | The LDAP account the ThreatQ Administrative group will

map to for permissions.

Open LDAP Example: administrator
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Field Description

AD Example:

CN-=linux-admins,CN=Builtin,DC=yourdomain,DC=com

Primary Contributor The LDAP account the ThreatQ Primary Contributor group

Access will map to for permissions.
Open LDAP Example: IdapAnalyst

AD Example:

CN=linux-admins,CN=Builtin,DC=yourdomain,DC=com

Read-Only Access The LDAP account the ThreatQ Read-Only group will map

to for permissions.
Open LDAP Example: IdapObserver

AD Example:

CN=read-onlyCN=Builtin,DC=yourdomain,DC=com

8. Use the Connect to Receive Data section connect to your LDAP using the settings

on this page to pull group information and user lists
9. Click on Save.
10. Click on the Enable/Disable toggle switch to enable LDAP.

ﬂ Green indicates the feature is active.

Date and Time Format

You can configure the date and time format of your choice system-wide within the ThreatQ

platform.
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If you make changes to the date and time format while another user is
working concurrently in the same ThreatQ installation, that user must
refresh their browser for the changes to take effect.

Related Topics:

« Configuring Date and Time Format

Configuring Date and Time Format

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations A ow Status

Indicstor Statuses  indicator Types  EvenTypes  Browy  LDAP  Genersl
STATUSES « DISCRIPTION & PROTECT FROM FEED OVERRIDE TOTAL IWDICATORS &
Active Poses a threat and is being exparted to detection toals, O
Expired Mo longer poses a serious threat. @
Indirect Associated to an active indicatar or event §L.. pONS). 9)]
Review Requires further analysts [9))] 49
Whitelisted Posss NO risk and sheuld never be deplayed. O

O Dema This Is a dema {:D

2. Click the General tab.

The Date and Time Format tab opens.
THREATQ) 9

System Configurations

Indicator Statuses ndicacar Types Ewent Types Prooy LW General

DATE AND TIME FORMAT

Date Format Time Format
MMDDATYY @ 12 haur -]
COMMATYY 24 hour

Y MMTD
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3. Select the desired Date Format. Options include: MM/DD/YYYY, DD/MM/YYYY,
YYYY/MM/DD

4. Selectthe desired Time Format. Options include: 12 hour, 24 hours.

5. Click Submit to save your settings.
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Traffic Light Protocol (TLP)

Traffic Light Protocol (TLP) schema provides a set of designations used to ensure that sens-
itive information is shared with the appropriate audience. ThreatQ provides a method for des-
ignating the availability of intelligence information by their sources. Users can also use TLP

schema to filter objects when creating an export - see the Adding an Export topic for more

details.

Administrators have the ability to configure TLP visibility settings for the ThreatQ application.
THREATQ )

Data Management
Jematic Exgpiralic Seoring Whitelsied Indicatar
TLP (Traffic Light Protocol) Enabled

TLF I5 a set of des|gnations used to ensure that sensitive information i shared with the appropriate audience; it provides a method for designating the avallability of intelligence information by thair
sources. TLP employs four colors to indicate expected sharing boundaries for data,

Sowice Mame Default TLP
abuse ch Feodo Tracker Botnet C2 IP Blocklist NOME
admin@thraatg.com NOME
Analyst@threatg.oom NOME
ATTELCK Tooks @ RED

Cofense Inteligence NOME

TLP employs four lights to indicate the expected sharing boundaries for data:

Light | Designation Description
® Red Not for disclosure, restricted to participants only.
Amber Limited disclosure, restricted to participant's organizations.
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Green Limited disclosure, restricted to the community.
White Disclosure is not limited.
TLP Assignment Hierarchy

The ThreatQ TLP assignment hierarchy is as follows (highest to lowest precedence):

Method Details
Manually Using the Add New Source option when creating an object will allow
Set you to select a TLP designation.
Source
Provided TLP information received from ingested data.
Data
Source Administrators can set a source's default TLP designation. See the
Default Apply TLP Designation to Source topic for more details.
No TLP A TLP designation has not been set for the source.
Access TLP Settings

Users can manage TLP settings for system sources by accessing the TLP tab under the

Data Management page.

1. From the main menu, select Settings 1> Data Management.

The Data Management page will load with Automatic Expiration tab selected by
default
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2. Click on the TLP tab.

The TLP Setting page will open.

THREATQ )

Data Management

Auioenatic Expiation  Scering Whikeksted Indicatars

TLP (Traffic Light Protocal) ) cnabled

TLP Is a set of designations used to ensure that sensitive information s shared with the appropriate audience; it provides a method for designating the avallability of intelligence information by their
sources. TLF employs four colors to indicate expected shanng boundarias for data,

Source Hame Detault TL?
abuse ch Feods Tracker Batnetl £2 1P Blocklist NOMNE
admin@thraatg.com NONE
Analyst@threaty com NONE
ATTRCK Took @ RED

Cofense Inteligence HONE

Configure TLP Visibility

System administrators can set visibility settings to either hide or show TLP designation lights

to users.

From the TLP Settings Page (see the Access TLP Settings topic):
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1. Click on the Enable/Disable toggle switch.
THREATQ )

Data Management

Automatic Expiration Seoring
TLP (Traffic Light Protocol) @ enabled

TLP Is a set of des|gnations used to ensure that sensitive information s shared with the appropriate audience; it provides a method for designating the avallability of intalligence information by their
sources. TLP emplays four colors to indicate expected shanng boundaries for data, i I K

Source Name Detault TLP
abwge ch Feods Tracker Botnet C2 1P Blocklist NOMNE
admini@threatg.com NONE
Analyst@threatg.com NONE
ATTECK Took @ RED

Cofense Intefligence NONE

Enabled indicates that TLP designations are visible to users.

"

Administrators will not need to click on the Save button, changes
will be made upon clicking on the switch.

Apply TLP Designation to Source

From the TLP Settings Page (see the Access TLP Settings topic):

1. Locate the source to update from the list provided.
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e A
&
E' You can use the Filter by Source Name field to locate the desired
source.
THREATQ 3
Data Management
sulornatic Expiration  Seoring Whiteissed indicatars
TLP (Traffic Light Protocol)
TLP is a set of designations used to ensure that sensitive infarmation is shared with the appropriate audience; it provides a methed for designating the avallability of intelligence inform
sources. TLF employs four colors to indscate expected sharing boundaries for data. b rk
Source Name Default TLP
caf
Cofense Intelligence NONE
- J

2. Click on the TLP dropdown to the right of the source and select the appropriate

TLP designation.
THREATQ )

Data Management

Ausomartic Expisation

scoring T Wwihitalisted indicatars

TLP (Traffic Light Protocol) ) Enabled

TUP s a set of designations used to ensure that sensitive infarmation is shared with the appropriate audience; it prosides a method for designating the availability of intelligence information by their
spurces, TLP employs four colors to indicate expacted shanng boundaries for data, How it work

Saurce Nams Default TLP
LP Status
abiuse.ch Feodo Tracker Botnet C2 IP Blocklist NOME
L L=
adrnin@threatg eam AMEBER -
GREEN
Analyst@threaty com WHITE
NENE
ATTRLCK Tools & RED
Cofense Intelligence NOME

3. Click on Save.
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Update TLP Schema using TLP Default - Command

Use the following command to update the TLP schema for an Object Source or Object Attrib-

ute Source with the source's default TLP designation.

See Apply TLP Designation to Source topic for more details on setting a
default TLP designation for a source.

You should use this command to update your system to match default TLP configurations,
specifically attributes and sources that were added to the Threat Library prior to the release
of the TLP feature introduced with ThreatQ 4.11. This command will override previous

TLP schema settings for a source including ones set by users. You will be prompted to con-

firm the action after entering the command. All updates will be recorded in the audit log.

The command will update using the default TLP designation. If a default
designation is set to None, all references to the source will be updated to
None.

Update All Sources
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command:

sudo php artisan threatqg:apply-tlp-defaults

4. The application will warn you that this action is not reversible and will require user

confirmation before proceeding.
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5. Type Yes to confirm and proceed with the action.

The application will automatically be placed into maintenance
mode. After the command has completed its operation, the applic-
ation will be automatically be brought out of maintenance mode.

Update a Specific Source
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command:

sudo php artisan threatqg:apply-tlp-defaults --

sources="<your source>"

* . af
G You can apply the command to multiple sources by listing the
sources in a comma-delimited format.
Example: --sources="CrowdStrike, AlienVault"

4. The application will warn you that this action is not reversible and will require user

confirmation before proceeding.

5. Type Yes to confirm and proceed with the action.

The application will automatically be placed into maintenance
mode. After the command has completed its operation, the applic-
ation will be automatically be brought out of maintenance mode.
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Convert TLP Command

Use the following command to update all object sources and object attribute sources that
have TLP stored as an object attribute. This command will not affect TLP attributes that have
already been converted. Users should use this command for new incoming data, such as

migrating data into the system, which has TLP attributes but no TLP set.
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatqg:convert-tlp-attributes

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Use Scenarios:

Object has one or more TLP Attributes with an invalid TLP (not currently in the TLP

options)

« Ifthe Object has just one TLP Attribute - none of its Sources or Attribute Sources

will be updated.

« Ifthe Object has more than one TLP Attribute - any Sources or Attribute Sources
that match the Attribute Source of the TLP Attribute will not be updated.

Object has a single valid TLP Attribute
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« All of the Object Sources and Object Attribute Sources will be updated to match the
value of the TLP Attribute.

Object has multiple TLP Attributes

« Each TLP Attribute will be evaluated separately.

« Any Object Sources or Object Attribute Sources whose source matches that of the
TLP Attribute will be updated with the value of the TLP Attribute.

« Any Object Sources or Object Attribute Sources whose sources do not match will

not be updated.

« Ifthere are no matches at all between the source of the TLP Attribute and any of the
Object Sources or Object Attribute Sources, a new Object Source will be added using
the Attribute's TLP value. Each of the Object Attributes will receive a new Object Attrib-

ute Source with the TLP value as well.

ThreatQ User Guide, Version 4.30 97



THREA TQ n Job Management

Job Management

"l

The Job Management page is only accessible to users with Administrator
or Maintenance accounts.

The Job Management page allows you to view the status and outcome of Bulk Actions.

To access the Job Management page:

1. Navigate to Settings 1 > Job Management.

Job Management

= = FERCENT ESTIMATE
s = ALTHIR ACTION QUERT STATUS & COMPLETED  TOTAL ME husamn amuss

2 threatg@hreats com Update Stams Waiting 24 24 5689

1 threatg@threatg.com Dedete

Completed 9 9 5725

Related Topics:

« Viewing Job Details

Viewing Job Details

The Job Management page allows you to view the following details about a Bulk Action job:

Field Description

Job ID The unique ID assigned to the job.
Author The user that initiated the job.
Action The Bulk Action selected.
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Job Management

Field Description

Query

The search filters used to select the system objects for the job.

Status

The current status of the job.
Possible statuses include:

« Created - The job has been queued.
« In-Progress - The job is running.
« Error-The job failed.

« Waiting - The job is waiting for indexing to be complete. This

only applies to the Bulk Change process.

o Completed - The job has completed.

Completed

The timestamp of when the job completed.

Total

The total number of objects included in the job.

PID

The process ID of the worker executing the job.

Percent Com-

pleted

This represents the amount of system objects associated with the
job that have been processed.
Example: 100 indicators out of the 1000 associated with the job

have been deleted = 10%.

Estimated Time

Remaining

The estimated time remaining until the job is complete.

Date Created

The timestamp of when the job was created and queued.

Updated At The timestamp of when the job or an system object associated with
the job was last updated.
Start Time The timestamp of when the job was started.
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Field Description

Completed At The timestamp of when the job completed.

Failed At If the job failed. the timestamp of when it failed.
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Threat Library

The Threat Library is the central repository within ThreatQ that organizes and combines

external and internal threat data.
The Threat Library can be broken down into three segments:

System Objects

Threat data, both ingested and manually added, is referred to as System Objects and is sor-

ted and categorized by object type.

Advanced Search

The Advanced Search page is the primary interface for the Threat Library that allows you to

search, filter, and sort through System Objects.

Object Details
The Object Details page allows you view detailed information about a specific object.

Advanced Search

The Advanced Search page is the primary interface for the Threat Library. You can search
for any system object within the application, filter returned system objects, and apply bulk

changes to search results. You can click on an individual object to navigate to its details

page.
Depending on how you have navigate to the Threat Library will determine which object
types appear on the page.

Threat Library Navigation Menu

You can click on Threat Library > Object Type to open the advanced search for a particular
object type or select Browse All. You can also select which object types appear in your

Threat Library view - see Selecting Object Type View for more details.
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Search Link

You can click on Search > Advanced Search to open the advanced search for all object

types within the Threat Library.
Refining Search Results

You can use the Context, Date, Status, and Types filters to narrow down your search for a

specific object or object type.
Related Topics:

« Performing an Advanced Search

« Managing Search Columns

o Exporting Search Results to CSV

« Managing Saved Searches

« Bulk Actions

« Filter Sets

Performing an Advanced Search

"l

You can also click on Threat Library > Browse All to navigate to the
advanced search page or click Threat Library >Object Type to navigate to
the advanced search page for a specific object type.

To perform an advanced search:

1. Choose the Search icon.
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2. In the Search dialog box, choose Advanced Search.

The Advanced Search page opens.
THREATQ 3 i a8 Analytis

) soversaries 0 & Threat Library
@ Altack Patterns 0 All Objects - v T
o Campalgns o

= [ Save

@ Courses of Action 0

@ Exploit Targets ]

Files 1]

eln(iden[s a
O 2| @ icsors o)

D Add Another Filter Set

@ Intrusion Sets o
@ Malware 1]

| Type = Status = l | Seore

@ Signatures 0 VALUE 3 TWE = DATE CREATED =
@ Taske n @ ryrdu.crulsingsmallship.com FQDN D8/0B/2019 03:30pm
0 s . @ rttim-taxl.com FQDN D8/0B/2013 03:30pm
@ 70US.57M.SK FOQDN OB/0B/2019 03:30pm
O TP 0 @ zkic.com FQON D&/08/2019 03:30pm
@ zjjif croukwexdbyerr.net FQDN 08/0B/2019 03:30pm
@ ribup.csheaven.com FQDN 08/0B/2019 03:30pm
@ TIEEySr.oom FQDN 08/0B/2019 03:30pm
@ 77752.com FQDN D8/0B/2019 03:30pm
@ 732538.nb.host127-0-0-1.com FQDN 0&/08/2019 03:30pm
@ yumekin.com FODN 0D&/08/2019 03:30pm
@ youtuhe.com FQDN 0&/08/2019 03:30pm
u @ youtibe.com FQDN D8/0B/2019 03:30pm

s AOMO PO A AN

3. Choose your object search category by selecting an object type from the Filters

dropdown list or selecting an object type from the left-hand list.

See the Filter Sets topic for more information on narrowing down
your search.

4. Press Enter or Return.

5. Optionally, repeat steps 3 and 4 to further narrow your search.

Managing Search Columns

You can choose which columns to display in your search results.
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To select columns:

1. Navigate to the Advanced Search page.

2. Choose Manage Columns.

@ Threat Library
All Objects v O, Search for keywords, Y Clear Filters
oad 5earch ~ [@ Save You currently have 1 filter set.

© Add Another Filter Set

@ Indicators (2,211) @ Manage Columns =

[ Type - ] ‘ Status - ‘ l Score - .\ earch
VALUE 2 TYPE % [ Date Created
@ zyrdu.cruisingsmallship.com FQDN O Description
@ .um-taxi.com FQDN [# Expiration Date
@ zous.szm.sk FQDN ,
N Q = Last Modified
@ zkic.com FQDN
O Related Adversaries
@ zjjif. croukwexdbyerr.net FQDN
) 4 Score
@ zibup.csheaven.com FQDN
Sources
@ zgsysz.com FQDN &
@ z7752.com FQDM [ Status

3. Select the columns you wish to display. Clear the columns you wish to hide.

Selecting Object Type View

You can select which object types appear in your view of the Threat Library using the fol-

lowing methods:
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"1

The methods listed below will not be added to your filter set. See the Fil-

tering by Object Type topic for details on how to add object type filtering to
your filter sets.

Threat Library Navigation Menu:

1. Click on the Threat Library navigation dropdown and select an Object Type.

i\ Threat Library A Investigations il Analytics

A& Adversaries {'i} Exploit Targets & Malware

= Attack Patterns [ Files @ Signatures

l Campaigns é" Incidents @ Tasks

&  Courses of Action (M Indicators A Tools

™) Events (8) Intrusion Sets A TTPs

Browse All
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Threat Library

The Advanced Results page opens with the applied object type filter.
THREATQ 3

dicators 15.8K

@ Threat Library

indicators -

T B v

Filter Set 1

0 add Arather Filter Set

Indicators (15,440)

WALUE = TVPE 2

&

P Addrass
FOON

P Address
P Address

P Arddress

E & & & @

P Address

Object Type Dropdown List

DWTE CREATED

L8
0aM1/2
0a12
[E=T R
D&M 1V

D&M 1D

118 11:47pm
013 1147
119 11:47pm
019 11:47pm
013 11:47pm

019 11:47pm

LAST MODIFIED =

QEN22M e aE11am
0BM220M 9 1202am
QBN 1 202am
08N 2/2019 12:02am
DBMZA019 1202am

08N22M I 1 202am

You can use the Global Filter dropdown list to select more than one object type.
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1. Click on the Object Type dropdown list and select one or more object types.
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@ Threat Library

Indicators v Q_ Search for ki

All Objects

Adversaries

Attack Patterns

Campaigns

Courses of Action

Events

Exploit Targets

Files
Incidents .
v] Indicators
_ Intrusion Sets
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The Advanced Search Results page updates the list with the selected object type
(s)

THREA TQ 3 i\ Threat Library

e Adversaries 2 @ Threat Library

Indicators 15.4k | Adversaries, Indic...~

Load Search = [2] Save

Filter Set 1

Filter Sets

Filter Sets allow you to create multiple sets of filters that can be applied to the threat library at

the same time using AND/OR logic. You can also save your Filter Sets using the Save
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Search option - see the Saving Searches topic for more details.
THREATQ

e Adversaries a @ Threat lerary
@ Attack Patterns 1] Al Objects - O, Search for keyward ¥ Clear Filters
o Campaigns a

Load Search = @ Save You currently have 2 filter sets

@ Courses of Action a

@ Events a Filter Set 1 m n -

@ Exploit Targets 0
INDICATOR TYEE m Al
@ Files

e ®
INCRCATOR STATUS m Add Status - 5]
9 Incidents Q

@ Indicators 353 |
o
@ Intrusion Sets 0

@ Mahware a CREATED AT Before OB/08/2079 01:42pm & @

O Add Anather Filter Set

Tools Q . B
o @ Indicators (398) M Manage Columns =

WALUE = T™PE = DATECREATED =

@ 216.81.6254 IP Address OBAOES20719 12:49pm

Related Topics:

Adding Filter Sets

Editing Filter Sets

Deleting Filter Sets

And/Or Order of Operations

Filter Options:

« Date Filters

« Context Filters

« Types Filters

« Status Filters
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Adding Filter Sets

To Add a Filter Set to the search results:
From the Advanced Search page:

1. Select one or more filters for the search.
@ Threat Library

All Objects - ), Search far keywords... Y Clear Filters

oad Search ~ [@ Save You currenthy have 1 fllter set

Pl Sat -
INDICATOR TYPE IP Address X Add Type

INDICATOR 5TATUS

© Add Another Filter Set

2. Click on Add Another Filter Set.

A new Filter Set table will load below the first set.
@ Threat Library

All Objects - | Search for keywords.. T Clear Filters

ch » [@ Save You currently have 2 filter sats
o
INDICATOR TYPE IP Address X Add Type = @
INDICATOR STATUS m Add Status o

(@] s o

© Add Another Filter Set

3. Use the Filters dropdown next to the new filter set to add filters.
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@ Threat Library

All Objects - Q. Search for keywords... Y Clear Filters

Load Search * [B Save You currently have 2 filter sets.

INDICATOR TYPE IP Address X RN ®
®

INDICATOR STATUS Active X Add Status =

mmo

M Dates
© Add Another Filter Set

Date Created

@ Indicators (398) Last Modified |

@ Context

ﬁ Repeat steps 2-3 to add additional filter sets.
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4. Click on the Or button to switch between And/Or logic for the Filter Sets. See the

And/Or Order of Operations topic for more details.

@ Threat Library

All Objects - Q. Search for keywords Y Clear Filters
Load Search ~ [ Save You currently have 2 filter sets.
Filter Set 1 Filters  ~ u .
INDICATOR TYPE P Address X Add Type = ®
INDICATOR STATUS Add Status o]

o
. CREATED AT Before 08/08/2019 01:42pm & @

© Add Another Filter Set

Editing Filter Sets

The steps to editing a filter within a Filter Set may differ based on the type of filter.

Editing Filter Set Filter Values

Filter Steps

Dates

Date Created 1. Click on the pencil & icon located to the right of the value.

The Date Created dialog box opens.

2. Update the date values and click Save.

Last Modified 1. Click on the pencil & icon located to the right of the value.

The Last Modified dialog box opens.
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2. Update the date values and click Save.

Context

Keyword Keywords already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing keyword to delete it.

2. Click on the Filters dropdown and select Keyword.
The Filter by Keyword dialog box opens.

3. Enter the new keyword and click Add.

Relationship Related objects already applied to the filter cannot be edited and must

be deleted. Perform the following:

1. Click on the X next to the existing related object to delete it.

2. Click on the Filters dropdown and select Relationship.
The Filter by Relationship dialog box opens.

3. Use the search box to locate the object and click Add.

Indicator Score 1. Click on the Update Score option next to the existing score fil-

ter.
The Define Your Score dialog box opens.

2. Adjust the score range and click Submit.

Source Sources already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing source to delete it.
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2. If another source filter exists, click on Add Source option oth-

erwise click on the Filters dropdown and select Source.
The Source dialog box opens.

3. Use the search box to locate the source.

Tag

Tags already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing tag to delete it.

2. If another tag filter exists, click on Add Tag option otherwise

click on the Filters dropdown and select Tag.
The Tag dialog box opens.

3. Use the search box to locate the tag.

Value Contains

Values already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing value to delete it.

2. Click on the Filters dropdown and select Value Contains.
The Value Contains dialog box opens.

3. Select an Object, enter a Value, and click Add.

With Attribute

With Attribute values already applied to the filter cannot be edited and

must be deleted. Perform the following:

1. Click on the X next to the existing value to delete it.

2. Click on the Filters dropdown and select With Attribute.

The With Attribute dialog box opens.
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3. Select an Attribute, enter a Value, and click Add.

Without Attribute | Without Attribute values already applied to the filter cannot be edited

and must be deleted. Perform the following:

1. Click on the X next to the existing value to delete it.

2. Click on the Filters dropdown and select Without Attribute.
The Without Attribute dialog box opens.

3. Select an Attribute, enter a Value, and click Add.

Types
Object Type 1. Click on the Add Type next to the existing types.
(Indicator, Event, The Type dialog box opens.

Signature, File)
2. Use the checkboxes to select and unselect types.

Statuses

Object Status 1. Click on the Add Status next to the existing status.

(Indicator, Sig- The Status dialog box opens.

nature, Task) 2. Use the checkboxes to select and unselect statuses.

Deleting Filter Sets

"l

Deleting a Filter Set removes it from the search results and cannot be
undone.

To Delete a Criteria Set:
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1. Click on the delete BM icon located next to the right of the Filter Set's name.

@ Threat Library

All Objects - Y Clear Filters

arch = [§) Save

You currently have 2 filter sets

o-

INDICATOR TYPE P Address x EEETERY he ®
INDICATOR STATUS Add Status ®

CREATED AT  Before 08/08/2019 01:42pm & @

© Add Another Filter Set

"l

You can click on Clear Filters, located at the top-right of the search,
to remove all filter sets from the current search.

And/Or Order of Operations

Filter Set AND/OR logic follows the standard mathematical order of operations with ANDs

being executed before ORs. The table below provides different scenarios and examples for
Filter Sets.
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Scenario Order Example

Single AND Filter 1 AND Filter 2

Filter Set 1
INDICATOR TYPE IP Address X Add Type =

Filter Set 2

INDICATOR STATUS m Mdd Stat

© Add Another Filter Set

Single OR Filter 1 OR Filter 2

Filter Set 1
INDICATOR TYPE m Add Type =

Filter Sat 2

INDHCATOR STATUS Add Staty

@ Add Another Filter Set
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Scenario Order Example

Single AND, Single (Filter 1 AND Filter 2) OR Filter 3
OR

Filter Set 1

UPDATED AT Before DB/06/2019 05:39pm

Filter Set 2

INDICATOR STATLS -,q Ardd Staty

Filter Set 3

CREATED AT Before|08/D6/2019 05:40pn

© Add Anather Fllter Sat
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Scenario Order Example
Multiple ANDs, (Filter 1 AND Filter 2 AND Filter 3)
Single OR OR Filter 4 Flter Set
UPDATED AT Before 08/06/2)
Filter Set 2

© Add Anather Filter Set

INDICATOR STATLUS

Filter Set 3

CREATED AT Befi

Filter Set 4

INDICATOR STATUS

D19 05:39pm

hre 08/06/2019 05:
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Scenario Order Example
Multiple ANDs, Mul- | (Filter 1 AND Filter 2) OR (Filter 3
tiple ORs AND Filter 4) Flter Set
UPDATED AT Before 08/06/2019 05:39pm
Filter Set 2

INDICATOR STATLUS

Filter Set 3

CREATED AT

Filter Set 4

Bef

INDICATOR STATUS

© Add Anather Filter Set

hre 08/06/2019 05:

Date Filters

Date filters allow you to filter advanced search results by date-related values.

Additional Topics:

Filtering by Date Created

« Filtering by Last Modified

Filtering by Published Date

Filtering by Source Ingest Time

Filtering by Expiration Date
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Filtering by Date Created

Complete the following procedure to filter Advanced Search results by the date the objects

were created.

To filter by Date Created:

1.

Click on the Filters option and select Date Created.

The Date Created dialog box opens.

Date Created %

is before -

‘ May - g 2019 B 03117 PM ® uTC -

Select one of the following options to determine how the filter is applied:

Option Result

is before Search results include items before a selected date

is after Search results include items after a selected date

is in the range _ _ _
¢ Search results include items in a selected range of dates
o

L Search results include items within the selected number of
is within the last
days.

Use the controls to select date options based upon the selection in step 2.

Click Save.
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Filtering by Last Modified

Complete the following procedure to filter Advanced Search results by the date objects were

last modified.

Tofilter by Last Modified:

1.

Click on the Filters option and select either Last Modified.

The Last Modified dialog box opens.

. X
Last Modified
is before -
Date Time Time Zone
May - g A 2019 - 03:19 PM © uTc -

Select one of the following options to determine how the filter is applied:

Option Result

is before Search results include items before a selected date

is after Search results include items after a selected date

is in the range _ _ _
¢ Search results include items in a selected range of dates
o

L Search results include items within the selected number of
is within the last

days.

Use the controls to select date options based upon the selection in step 2.

Click Save.
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"1

The Published Date is the date that an object was originally published by

the source. This is not to be confused with when the object was ingested
into ThreatQ.

To filter by Published Date:

1. Click on the Filters dropdown option for a filter set and select Published Date.

& Threat Library

All Objects -

= M Save

ltersar m '

@ add Anodher Fiter Set

Yate Created

@ Indicatars (114) Published Date m

Source Ingest Time
b | | Status i | | SCore

Last Modified

WALUE @ TVPE ® Contest
& 2131762000422 CIDR Blodk
mpart 1D
@ 213.130BB0v22 CIDR Block
Feyrwiord
@ 21255144002 CIDR Block
e e | athonship
CIDR Blogk (RO N P
2B.0MB CIDR Block 11042015 06 3dpm
20E.12.64.0/M9 CIDR Block 110472019 06:34pm
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The Published Date dialog box opens.

Published Date

The published date is the date that the source originally published the object. This is not to be confused with when the object
was ingested Into Threatd,

published before

Wowvernber u - v 06:37 PM

2. Select the Source that published the object.

3. Select one of the following options to determine how the filter is applied:

Option Result

published before Search results
include items before

a selected date

published after Search results
include items after a

selected date

published between Search results
include items in a
selected range of

dates

published within the last Search results
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Option Result

include items within

the selected number

of days.

4. Select Date, Time, and Time Zone for the filter to use.

5. Click Save.

Filtering by Source Ingest Time

"1

The Source Ingest Time is the date that an object was ingested into
ThreatQ.

To filter by Source Ingest Time:

1. Click on the Filters dropdown option for a filter set and select Source Ingest Time.
@ Threat Library

All Dbgects - arch far keyvs T

|+ [ Save Yau currerily havs 1 filter set

& Add Arather Flter Set Date Created

Piilslished Date
@ vamare 59 i |
Last Maodified
WALLIE = DATE CREATED =

@ 055 _OCEANLOTUS.D 11/04/201 % 06:39pm D Context

@ FlawedAmmyy 1170472019 D6:39pm
Impart 1D

& ROFSMIFFER 117047201 % D6:39pm
Keynwrord

& MNETWIRE 11042019 D6:39pm
Relationshi

@ FakeM 117044201 % D6:39pm T I ukractd 1 Ut | pm
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The Source Ingest Time dialog box opens.
Source Ingest Time

The Source Ingest time |s the date that the object was initially ingested into Threat(),

created before

November - ol - 07:49 PM

2. Select the Source that published the object.

[ ﬂ You have the option to select Any Source.

3. Select one of the following options to determine how the filter is applied:

Option Result

created before Search results
include items before

a selected date

created after Search results
include items after a

selected date

created between Search results
include items in a

selected range of
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Option Result

dates

Search results

. include items within
created within the last
the selected number

of days.

4. Select Date, Time, and Time Zone for the filter to use.

5. Click Save.
Filtering by Expiration Date
You can narrow down the Indicators in your search results by the expiration date.
Tofilter by Expiration Date:

1. Click on the Filters dropdown option for a filter set and select Expiration Date.

@ Threat Library

Indicators - Q. search for keywords, Y Clear Filters

Load Search = [§) Save You currently have 1 filter

Filter Set 1 m R
© Add Another Filter Set
@ Indicators (0) @ Manage Columns  ~

No Results Found

If you are currently viewing system indicators in the Threat Library,
you can click on the Expiration button located above the search res-
ults.
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@ nocaors ©

| Type ~ I | Status v I | Score v I | Expiration ~

Y Expiration Date

is "

— Month —— — Day
| Jan v

m cancel

The Expiration Date dialog box opens.

2. Select one of the following options to determine how the filter is applied:

Option Result

is Search results include the specified date.

is not Search results exclude items from a range of dates.

is after Search results include items after a selected date.

is before Search results include items before a selected date.

is between Search results include items in a selected range of
dates.

is within the last Search results include items within the selected num-
ber of days.

is within the next Search results include items within a range of future
dates.

is protected from auto- Search results include items that are protected from

expiration auto-expiration.

3. Select Day, Month, and Year for the filter to use.
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4.

Click Submit.

Context Filters

Contextfilters allow you to filter advanced search results by specific details associated with

an object.

Additional Topics:

Filtering by Attribute

Filtering by Value Contains

Filtering by List of Indicators

Filtering by Keyword

Filtering by Relationship

Filtering by Score

Filtering using Tags

Filtering by Attribute

You can filter the Threat Library list to include or exclude objects with a specific attribute.

From the search results:

1.

Click on the Filters option and select either With Attribute or Without Attribute.

The Attribute Filter dialog box opens.

With Attribute "
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2. Select an Attribute Type.

3. Enter an Attribute Value associated with the Attribute Type.

Users can leave the Attribute Value field blank to filter for any value
associated with the selected Attribute Type.

4. Click on the Plus icon to the right of the dialog box to add another attribute and
repeat steps 2-3. This step is optional.

5. Click on the Add button.
The filters will be applied to the search results.

The following section applies to using multiple attribute filters.

-

ﬂ The Match Any/All toggle option will allow users to configure the filter to
include objects that either fit one attribute filter or all. The Any option will
be selected by default. This means the filter will display results that fit any
of the attribute filters. The All option means the filter will display results that
fit all attribute filters.

Example:
ANY - Match Toggle Selection
Setting Field Value
Attribute Type Attack Phase
Filter A
Attribute Value C2
Attribute Type Severity
Filter B
Attribute Value High
Filter Options Any/All Toggle Any
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Result Search Results are filtered to include/exclude objects with Attack
esu
Phase: C2 OR Severity: High attributes.
ALL - Match Toggle Selection

Setting Field Value

Attribute Type Attack Phase
Filter A

Attribute Value C2

Attribute Type Severity
Filter B

Attribute Value High

Filter Options Any/All Toggle All

Result

Search Results are filtered to include/exclude objects with Attack

Phase: C2 AND Severity: High attributes.

Common Scenarios

The following scenarios demonstrate the Attribute Filter option in use with search results.

Applying a "With Attribute" filter (All items with an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filters button and select With Attribute.

The Attribute Filter dialog box opens.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
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listed. The search results update to show all Indicators with an attribute of Attack
Pattern: C2.

Applying a "Without Attribute" filter (All items without an Attribute Type and Value)

. User clicks on the Threat Library tab and selects on the Indicators tab.

User clicks on the Filter button and select Without Attribute.

The Attribute Filter dialog box opens.

User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.
User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators without an attribute of
Attack Pattern: C2.

Applying a "Without Attribute" filter (All items Without a specific Attribute Type with any

Value)

1.
2.

User clicks on the Threat Library tab and selects on the Indicators tab.

User clicks on the Filters button and select Without Attribute.

The Attribute Filter dialog box opens.

User selects Attack Pattern as the Attribute Type and leave the Attribute Value
blank.

User clicks on Add.

The User will now see a search parameter Without Attribute with Attack Pattern
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listed. The search results update to show all Indicators that do not have an Attrib-

ute Type of Attack Pattern assigned to them.

Applying keyword filters then applying a "With Attribute" filter

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User searches for keyword: demo.

The User will see a search parameter listed Keyword: "demo" and the results

update to show only indicators that mention demo.

3. Userclicks on the Filters button and select With Attribute.

The Attribute Filter dialog box opens.

4. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

5. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results will update to show all Indicators that mention the
keyword demo AND have an attribute of Attack Pattern: C2.

Editing multiple attributes that were applied as part of the search parameters

1. User clicks on the Threat Library tab and navigates to the Indicators tab.

2. User clicks on the Filter button and select With Attribute.

The Attribute Filter dialog box opens.
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3. The User specifies two attributes:
« Attack Pattern:C2
« Severity: High

4. User clicks on Add.

The User will now see two search parameters under the With Attribute section -
Attack Pattern: C2 and Severity: High. The search results updates to show all
Indicators with an attribute of Attack Pattern: C2 and Severity: High. The search
parameter for attributes is defaulted to Any. This indicates that objects with an

attribute of Attack Pattern: C2 or Severity: High are displayed.

5. User clicks on the Filters option and selects With Attribute.

A form will load with all applied filter attributes.

6. The User clears the Attack Pattern's Attribute Value field and clicks Add.

The User will now see two search parameters under the With Attribute section:
Attack Pattern: Any and Severity: High. The search results updates to show all
Indicators with an attribute type of Attack Pattern OR Severity: High.

Add multiple attributes and toggle Match from Any to All

1. User applies two attribute filters to the indicators results: Attack Phase: C2 and

Severity:High.

The filtered results will display any indicators that has either of those attributes.

2. User clicks on the Any/All Match toggle button and select All.

The filtered results will display any indicator that has both of those attributes
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Filtering by Value Contains

You can now filter Threat Library objects by a specific value or string within the value using
the Value Contains filter.

To filter by contains:

1. Click on the Filters option and select Value Contains.

The Contains dialog box opens.

Value Contains *

2. Select an Object, enter a Value, and click Add to apply the filter.
Filtering by Keyword
You can filter the Threat Library items on the Advanced Search by keyword.
To filter by keyword:

1. Navigate to the Advanced Search page.

2. Enter a keyword in the Keyword text field and press <Enter> or <Return>.

ﬂ Repeat Step 2 to apply multiple keyword filters
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Each keyword filter appears in a box below the keyword text field. "
) Global Filters

All Cojacts - I

oorss (I D

3. Click on the X for each filter to remove it or select Clear All Filters to remove all fil-

ters
Filtering by List of Indicators

The List of Indicators Filter option allows you to filter the Threat Library by pasting a list of

indicators, in raw text.

"l

The filter will return indicators that are an exact match. It does not return
partial matches.

To Filter by a List of Indicators:
From the search results:

1. Click on the Filters option and select List of Indicators.

@ Threat Library

ThreatQ User Guide, Version 4.30 137



THREA TQH Threat Library

The List of Indicators dialog box opens.

List of Indicators

2. Enter or paste your list of indicators into the textbox provided.

List of Indicators

list of indicators
8asfe76feee344165258beSd50faa5d585013¢f
jBada691783¢166f7506bbf340637169a9¢ 8610
abd34c09da5f043d8211210eb286792e4743ed39
76f3ad6eedefadbecSeaaldd0fee7ch7dc241d25

{ ﬂ The accepted list format is one indicator per line.

3. Click on Add to apply the filter.
Filtering by Relationship

The Relationship Filter option allows you to filter the Threat Library by related objects. Using

the Relationship filter, you can:

« Filter search results to include objects related to a specific object.

« Filter search results to include objects using multiple related object filters. You will

also have the option to set the filter to include objects that fit one of the multiple fil-

ters or all.
To Filter by Related Object:

From the search results:
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1. Click on the Filters option and select Relationship.

The Filter by Relationship dialog box opens.

Filter By Relationship

‘» Search for keywords...

Threat Library

2. Use the textbox provided to select an object.

o

Repeat step 2 to add multiple object filters.

3. Click on Add to apply the filter.

-~

AN

“

The Match Any/All toggle option will allows you to configure the fil-
ter to include objects that either fit one related object filter or all. The
Any option will be selected by default. This means the filter will dis-
play results that fit any of the related object filters. The All option
means the filter will display results that fit all related object filters.

Examples:
ANY - Match Toggle Selection
Setting Related Object
Filter A ABC Indicator
Filter B DEF Event
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Filter Option Any
Search Results are filtered to
Result include objects related to the ABC
Indicator OR the DEF Event.

ALL - Match Toggle Selection
Setting Related Object
Filter A ABC Indicator
Filter B DEF Event
Filter Option All
Search Results are filtered to
Result include objects related to the ABC
Indicator AND the DEF Event.

Filtering by Score

You can filter indicators in the advanced search results by score.

ﬂ“ This o

ption is only available for indicators.

To filter by score:

1. Navigate to the Advanced Search results page by selecting Search > Advanced

Search then selecting Indicators from the left-hand object type menu.

You can also select Threat Library > Indicators from the main

menu.

2. Click on the Filters dropdown and select the Indicator Score filter option.

The Indicator Score dialog row will load in the filter set.
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Update Score w

Define your score Clear

ﬁ The scale offers a range of 1-10.

3. Adjust the score scale to filter the results.
Filtering by Scoring Range
You can move the two scale markers to select a scoring range.

Example: Move the left marker to 6 and the right marker to 8 to filter the search

results to include indicators with a score between 6 and 8.
Filtering by Specific Score

You can move the scale makers to the same scoring number to filter by a specific

score.

Example: Move the left and right markers to 8 to filter the search results to

only include indicators with a score of 8.
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"1

Select the Update Score filter again and select Clear to remove the
filter.

Filtering using Tags
Using the Tags filter allows you to filter search results based on tags applied to an object.
From the search results:

1. Click on the Filters option and select Tags.

The Filter by Tag row opens.

Filter Set 1

TAG Add Tag ~
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2. Select Add Tag.
The Add Tag dialog box opens.

Filter Set 1

TAG

3. Use the supplied text field to select a tag.

4. Repeats steps 2-3 to apply multiple tag filters.

G The Match Any/All toggle option will allows you to configure the filter to
include objects that either fit one tag filter or all. The Any option will be
selected by default. This means the filter will display results that fit any of
the tag filters. The All option means the filter will display results that fit all-

tag filters.
Examples:
ANY - Match Toggle Selection

Setting Tag
Filter A Phishing
Filter B DDoS

Filter Option Any
Result Search Results are filtered to
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include items with either Phishing
OR the DDoS tags.

ALL - Match Toggle Selection

Setting Tags

Filter A Phishing

Filter B DDoS
Filter Option All

Search Results are filtered to
Result include items with both Phishing
AND DDoS tags.

Types Filters
Types filters allow you to filter advanced search results by object or subtype.
Additional Topics:

o Filtering by Object Type

Filtering by Object Type

You can filter Indicators, Events, Signatures, and Files by specific types of each.
Example: Filter the Signature list to include YARA types only.

To filter by status:

1. Click on the Filters dropdown and select <Object Type>Type.

ﬂ\ The Type filter row will appear in the filter set.
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2. Click on Add Type.

ﬂ You can select multiple types using the check boxes.

The search results will update with the applied filter.

Status Filters

Status filters allow you to filter advanced search results an object's Status.

ﬂ\ Only Indicators, Signatures, and Tasks can be filtered by their Status.

Additional Topics:

o Filtering by Status

Filtering by Status
You can filter Indicators, Signatures, and Tasks by Status.
To filter by status:

1. Click on the Filters dropdown and select <Object Type>Status.

[ ﬂ The Status filter row will appear in the filter set. ]

2. Click on Add Status.

{ ﬂ You can select multiple statuses using the check boxes. }

The search results will update with the applied filter.
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Bulk Actions

The Bulk Actions feature gives you the ability to update and delete large groups (1000+) of
system objects from the Advanced Search page. Once selected, the job process will run in
the background and allow you to continue working within ThreatQ. You can review the

status of the job and its results on the Job Management page.

You will also receive in-app notifications, via the Notification Center, when a Bulk Action job

has been queued and when it has been completed.

il Threat Library & Investigations Ll Analytics

@ Threat Library

Indicators - T Clear Filters

Load Search = [§ Save

INDICATOR TYPE CIDRBlock x TR &

& Add Anather Filter Set

| Type - | | Status - | Score - % Bulk Changes
VALUE = TYPE % DATE CREATED

@ 223.254.0.0M16 CIDR Block 09/04/2019( * Ex

@ 223.173.0.0M16 CIDR Block 09/04/2019( i

& 223169.0.0M16 CIDR Block 09/04/2019 Uz.'-nup_r;l

"

Currently, you can use this feature to update the status of system objects
and to delete indicators only.

Related Topics:

o Bulk Status Change

« Bulk Delete
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« Job Management

Bulk Status Change

You can use the Bulk Change option to update the status for a group of objects on the

Advanced Search page.

This function can only be performed on objects that use the status field

such as Indicators, Signatures, etc.

To Perform a Bulk Status Change

From the Advanced Search Page:

1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.

Indicators ) | @ Threat Library

Indicatars hd

Load Search « [ Save

Filter 5et 1

INDHCATOR TYPE CInR Bloce x [

@ Acd Another Filter Sat

Indicators (963)

WPE 2
CIDR Block
CIDR Block

CIDR Block

T Clear Filters

M Manage Columns =

DATE CREATED =
09/04/2019 D2:40pm
089/04/201% 02:40pm

03/04/201% 02:40pm

2. Click on the Actions dropdown and select All <System Object> under the Bulk

Changes heading.
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i\ Threat Library

@ Threat Library

Indicators - ) Search for keywarc

Load Search = [§ Save

Filter Set 1

INDICATOR TYPE coRBlock x TR

© Add Anather Filter Set

| Type M | [ Status - ] | Score -

VALUE = T™PE =
@ 223254.0.0116 CIDR Block
@ 223173.0.0M16 CIDR Block
@ 223.169.0.0116 CIDR Block

T Clear Filters

You currently have 1 filter set

N

@ Manage Columns m

@& Bulk Changes

All Indicators (963)

DATE CREATED

09/04/20191 * EX

09/04/2019¢

09/04/2019 Dzmupm

You will see the number of system objects affected next to the link in

parentheses.
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The Bulk Actions form will load.

THREATO 3 i\ Threat Library 2. Investigations Ll Analytics

Bulk Actions Your changes will affect 963 objects

Status

indicator Status [ R

3. Use the dropdown provided to select a new status to be applied to the selected

objects.

4. Click on Apply Changes located at the bottom of the form.

The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

MOTIFICATION CENTER
F Clear
SYSTEM NOTIFICATION
© Bulk Status Job #1 queued. §
a faw seconds ago
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The system will also notify you, via the Notification Center, that the job has been com-

pleted.
Analytics 4 Create Q A

NOTIFICATION CENTER
rc

SYSTEM NOTIFICATION

© Bulk Status Job #1 completed successfully. e [°

afew seconds ago
Bulk Status Job #1 completed successfully.

You can also view the status and other details of the job on the Job Management

page.
Bulk Delete

You can use the Bulk Delete option to delete a group of indicators on the Advanced Search

page. This feature is only available if you have a maintenance or administrator role.

e N

ﬂ Deleting an indicator also deletes its child records such as attributes and
relationships. The number of child records will influence the overall time it
takes to complete the job.

A The Bulk Delete function permanently deletes selected indicators from
the system. Once deleted, you will be unable to undo the action. If you are
executing a Bulk Delete on a large group of indicators, ThreatQuotient
highly recommends performing a backup of your system before per-
forming this function.
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To Perform a Bulk Delete
From the Advanced Search Page:

1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.

2. Click on the Actions dropdown and select All <System Object> under the Bulk
Delete heading.

@ Manage Columns = Actions =

@ Bulk Changes
All Indicators (19)
W Bulk Delete

All Indicators (19)

L3

Export

csv

1L!UD!LU 12 VLS

You will see the number of system objects affected next to the link in
parentheses.
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The Bulk Action Confirmation dialog box will load.

Confirm Bulk Action

O Permanently delete 19 items.

Cancel

3. Click on the checkbox to confirm deletion and then click on Delete.

The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER MARK ALL AS REAL

[ Cle:
SYSTEM NOTIFICATION
ve 1f
©  Buk Delete Job #1 queued. ®

a few seconds ago
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The system will also notify you, via the Notification Center, that the job has been com-

pleted.

NOTIFICATION CENTER MARK ALL AS BEAD
I Cle:
SYSTEM NOTIFICATION
ﬁ Bulk Delete Job #1 completed successfully. [ ] velf

a few seconds ago

SYSTEM NOTIFICATION

©  Buk Delete Job #1 queued. .

a few seconds ago

You can also view the status and other details of the job on the Job Management

page.

Managing Saved Searches

If you are following a particular area of interest, you can create a Saved Search. Saved

Searches can then be run at any time.
Related Topics:

o Saving Searches

« Running Saved Searches

o Deleting Saved Search

ThreatQ User Guide, Version 4.30 153



THREA TQH Threat Library

Saving Searches

To save a search:

—

. Choose the Search icon.

2. In the Search dialog box, choose Advanced Search.

"1

You can also select Threat Library > Object Type to navigate to the
advanced search page for a specific object type.

3. Perform an Advanced Search.

4. Choose Save.

The Save Search dialog box opens.

Save Search

Name Your Search

5. Enter a name for the search in the Save Search dialog box.
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6. Choose Save Search.

The name of the saved search will appear at the top of the page.

THREATQ 3 ii\ Threat Library A Investigations Lul Analytics

e Adversaries 0 | @ Last Modified

@ Attack Patterns 0 All Objects -

Load Search = [8) Save

@ Events 0 Filter Set 1

CREATED AT Before 10/21/2019 09:31pm

Identities 0 M AdA Anathar Ciltar Car

Running Saved Searches
To run a saved search:

1. Navigate to the Advanced Search page.
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2. Click on the Load Search dropdown list and then select the desired saved search

from the list.

@ Threat Library

All Objects v Q search for keyw

Load Search = [8) Save

SaveThatSearch

ThreatQ Search T

3. The saved search will load. The name of saved search will appear at the top of the

page.

THREATQ 3 i\ Threat Library & Investigations Lul Analytics

e Adversaries 0 | @ Last Modified
e Attack Patterns 0 All Objects - Q. Search for keywords...
o Campaigns 0

Load Search * [5 Save

@ Events 0 Filter Set 1
@ Exploit Targets 0

. Files 0
Identities

CREATEDAT  Before 10/21/2019 09:31pm

[=]

MM AdA Anathar Cilkar Catr
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Deleting Saved Search
To delete a saved search:

1. Navigate to the Advanced Search page.

2. Click on the Load Search dropdown, hover the mouse over the saved search to
delete, and click on the 'l icon.

3. Click on Delete Search to confirm.

Are You Sure?

This will delete your search from the list.

Delete Search ‘ Canc

Exporting Search Results to CSV

You can export your search results as a CSV file, which allows you to use the data in

another application, such as external spreadsheet software.

e N

ﬂ If you export a file with too many search results, the file may be too large to
open in desktop applications. If you encounter this issue, you should sep-
arate your exports into smaller chunks of data.

s N

ﬂ When exporting search results to a CSV file, if you include additional
columns beyond the default, this modification will impact the performance
of the export process.

A\ J

To export search results to a CSV file:
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1. Navigate to the Advanced Search page.

2. Perform your search.

3. Choose Export.
@ Threat Library

All Objects -

* [ Save

Filter Set 1

@ Add Another Filter Set

@ Indicators (2,211)

I Type - I I Status - | ‘ Score

VALUE = T™PE =

@ zyrdu.cruisingsmallship.com FQDN

The CSV file downloads to your desktop.

System Objects

M@ Manage Columns =

DATE CREATED =

08/08/2019 03:30pm

Threat data, both ingested and manually added, is referred to as System Objects and is sor-

ted and categorized by object type.

See the topics below to learn more about each object type and how to manage them.

System Objects:

Adversaries

« Events
« Files

Indicators
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« Signatures
« STIX Overview

Adversaries
Adversaries are the suspected groups that are attempting to do malicious activity.
Related Topics

o Adding Adversaries

o Editing Adversaries

o Deleting Adversaries

Adding Adversaries
To create an Adversary:

1. Go to Create > Adversary.
The Add an Adversary dialog box opens.
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Add An Adversary

Add new source

Description

Farmal

Related Objects (optional)

All Objects d

2. Enter a name.

3. Select a Source from the dropdown provided.

-~

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
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opic for more information on TLP schema.

Source

Threat Library

Demo () w

Select a source
® RED

Status
@ AMBER
0 GREEN

WHITE

(¥) NONE

4. Enter a description.

5. Select any Related Objects you need to link to the adversary. This field is optional.
6. Click Add Adversary.

Editing Adversaries
To edit the name of an Adversary:

1. Locate and click the adversary.

The Adversary Details page opens.
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THREATQ 3 i\ Threat Library

Claw ¢ Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17pm

@ Context

@) Attributes (2) | (0 ATTRIBUTETYP

@ Attributes

&3 Sources (1) Q Start typing

2. Click on Edit next to the Adversary name.

The Edit Adversary dialog box opens.

Edit Adversary

‘ Claw

3. Make the desired change to the Adversary name.
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4. Click on Save Adversary.
Deleting Adversaries
To delete an Adversary:

1. Locate and click on the adversary.

The Adversary Details page opens.
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THREATQ 3 i\ Threat Library

Claw ¢ Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17pm

@ Context

@) Attributes (2) | (0 ATTRIBUTETYP

@ Attributes

&3 Sources (1) Q Start typing
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2. Click on the Actions menu and select Delete Adversary.
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Claw & Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17f

@ Attribu

@ @ Context

(

o | ® Add Attribute O  ATTRIBUT
2 Add Comment

(= Q Starti
¢ Add Relationship

R O Confidenc
5 Add Source

& | O MalwareT

© Create Task

&
Generate PDF
J

@I il Delete Adversary =1 Source

Tasks (2)
@ () Self Monitor
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A confirmation dialog box appears.

Are You Sure?

Deleting this Adversary can not be undone.

Delete Adversary | Cancel |

3. Click on Delete Adversary.

Events

Events are observations made by the threat intelligence community of adversaries’ mali-

cious attempts.
Related Topics:

« Adding Events

« Editing Events

« Deleting Events

Adding Events
To add an Event:

1. Go to Create > Event.
The Add Event dialog box opens.
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Add Event

Spearphish

Add new source

Provide the content you'd like to be parsed for the spearphish event.

&b

Drag your file here or click to browse

Supported files include: eml, emlx, msg, and txt.

Related Objects (optional)

All Objects

L )

2. Select the Event Type.

3. Select a Source from the dropdown list provided.

r

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
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opic for more information on TLP schema.

Source

Demo -

Select a source
® RED

Status )
) AMBER
0 GREEN

WHITE

<) NONE

Add the date and time the event occurred in the Date of Occurrence fields.
Add an Event Title.
Select any Related Objects you need to link to the event. This field is optional.

Click Add Event.

N o g s

Editing Events

To edit an Event:

n,

You can also update the Event Type by clicking on the Type dropdown
located to the top-right of the Event's Object Details page.

1. Locate and click on the event.

The Event Details page opens.
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THREATQ 3 i\ Threat Library A In

Help Desk DoS Attack ¢edit
EVENT: DOS ATTACK

Created: 04/17/2019  Event Date: 04/17/2019 10:38am  F

@ Context

@ Attributes (1) | (0 ATTRIBUTE TYPE

@ Attributes (1)

O Sources (2) Q Start typing...
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2. Click on Edit next to the Event name.

The Edit Event dialog box opens.

Edit Event %

‘ Help Desk DoS Attack ‘

‘ April v 17 - 2019 v 10:38 AM ® uTC -

3. Make the desired change to the Event Name and Event Date.

4. Click on Save Event.
Deleting Events
To delete an Event:

1. Locate and click the event.

The Events Details page opens.
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THREATQ 3 i\ Threat Library A In

Help Desk DoS Attack ¢edit
EVENT: DOS ATTACK

Created: 04/17/2019  Event Date: 04/17/2019 10:38am  F

@ Context

@ Attributes (1) | (0 ATTRIBUTE TYPE

@ Attributes (1)

O Sources (2) Q Start typing...
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2. Click on the Actions menu and select Delete Event.
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Created: 04/17/2019 Event Date: 04/1

G Context

[¢

@ «
o © Add Attribute ]

2 Add Comment
=1
& Add Relationship

< C
5 Add Source

@ |
© Create Task

& |
Generate PDF

@| E
] Delete Event |

] . .
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A confirmation dialog box appears.

Are You Sure?

Deleting this Event can not be undone.

Delete Event Cancel

3. Click on Delete Event.

Files

Files are received from various intelligence providers and contain information on indicators,

adversaries, and events within ThreatQ.

Related Topics:

o Adding Files
« Editing Files

o Deleting Files

Adding Files
To add a File:

1. Click Create New > File.

The Add a File dialog box opens.
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ADD A FILE

&

Drag your file here or click to browse.
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2. Drag the file into the dialog box or browse and locate the file.
The Add a File Dialog box will update.

Add a File

Add new source

CrowdStrike Intelligence

off (Q) oN

‘ & ‘ Enabling this will .zip files for safer download. To
unzip, use the password "infected".

Tags

Type here and press enter
Related Objects (optional)

All Objects
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3.
4.

8.
9.

Update the Title if desired.

Select a Source from the dropdown list provided.

Threat Library

e

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)

topic for more information on TLP schema.
i

Source

Demo

| N

Select a Category.

Select whether to have the Malware Safety Lock on or off.

"l

Enabling the safety lock will create a password-protected .zip file so
any malware is safer for download. The system default password is
"infected."

Add any desired tags.

ﬂ Tags added appear on the File Details page.

Select any Related Objects you need to link to the file. This field is optional.
Click Save File.

Editing Files

To edit a File Name:
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1. Locate and click on the file.

The File Details page opens.

THREATQ 3 i\ Threat Library

spam_email.txt ¢ Edit
FILE: GENERIC TEXT

Created: 03/12/2019 First Seen: 03/12/2019 07:27am

@ Context

2 Attrilabac 113 I M ATTRIBUTE TY

@ Attribute

2. Click on Edit next to the File name.

The Edit File dialog box opens.

Edit File
sﬁam_email.txt

spam_email.txt

3. Make the desired change to the File Name.
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4. Click on Save File.
Deleting Files
To delete a File:

1. Locate and click the file.

The File Details page opens.
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THREATQ 3 i\ Threat Library

spam_email.txt ¢ Edit
FILE: GENERIC TEXT

Created: 03/12/2019 First Seen: 03/12/2019 07:27am

@ Context

2 Attrilabac 113 I M ATTRIBUTE TY

@ Attribute
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2. Click on Actions menu and select Delete File.
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G Context

@ Add Attribute

DIy,
2 Add Comment
af
& Add Relationship
79
& Add Source
> 1
© Create Task
3 |
Generate PDF ,
) |

3' ] Delete File

A confirmation dialog box appears.
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Are You Sure?

Deleting this File can not be undone.

Delete File Cancel

3. Click on Delete File.

Indicators

Indicators are the so called "finger prints" associated with a malicious attempt or adversary

group.

Indicators can be scored to allow you to apply weighting using contextual information, such
as sources, attributes, and indicator types, as they are added to ThreatQ. You can also seta

manual score per indicator.

You can also apply expiration dates to an indicator to when it is determined to pose less of a

threat to your infrastructure than other indicators.
Related Topics:

Adding an Indicator

Parsing for an Indicator

Indicator Search

Indicator Expiration

Automatic Expiration and Policies

Indicator Scoring
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« Whitelisted Indicators

« Indicator URL Normalization

Adding an Indicator
To add an Indicator:

1. Click on Create > Indicator.

"1

You can also select Indicator Parser from the Create menu if import-
ing a file. The option is located under the Import section of the
Create menu. See the Parsing for an Indicator topic.

The Add Indicators dialog box opens.

Add Indicators

Parse For Indicators Add Indicator

Add new source

Related Objects foptional)

All Objects v

2. Enter a value in the Value field.

3. Select the Type of Indicator.
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4. Select a Source from the provided dropdown list.

4 Y

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Selact a source

Status

| N

5. Select a Status for the indicator.

6. Select any Related Objects you need to link to the indicator. This field is optional.

7. Click Add Indicator.
Parsing for an Indicator

1. Click on the Create button, located at the top of the dashboard and select Indicator

Parser under the Import heading.

"1

You can also click on Create > Indicator and then select the Parse
for Indicators option at the top of the Add Indicators modal.
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The Add Indicators dialog box will load.

Add Indicators "

Parse For Indicators Add Indicator

Provide the content you'd like to be parsed for indicators.

& :

Drag your files here or click to browse

Supported files include: xml, plain text, csv.

Normalize URL Indicators

e — |

2. Do one of the following:
« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

3. Select the Parser to use and click on Next Step.

4. Select whether to save or delete the file after the import.

"

Steps 5-7 pertain to saving the file. Skip to step 8 if you are not sav-
ing the file after import.

5. Update the File Title if needed.

6. Enter an optional File Description.
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7. Confirm or update the File Category.

8. Select a Source from the dropdown menu provided.

e

ﬂ Users can also click on Add a New Source if the desired source is
not listed in the dropdown menu. If administrators have enabled TLP
view settings, users can select a TLP classification light for the new
source in the dropdown menu provided. See the Traffic Light Pro-
tocol (TLP) topic for more information on TLP classifications.

Add Indicators

Parse For Indicators Add Indicator

demao

Select a source

[ |
9. Select a Status to be applied to the extracted indicators.
10. Select any optional Attributes to be applied.
11. Click on Next Step.
ﬂ If the file contains events that are detected, the Step 2: Review
Events page opens. Indicators may be new or pre-existing. Pre-exist-
ing indicators are identified by a badge within the table. You can isol-
ate new and pre-existing indicators by using the tabs at the top of the
right hand panel.
12. Locate and select one or more indicators using one of the following options:
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« From within the contents (on the left)
« From the table (on the right)
» By using the Select dropdown menu
13. Once you have selected one or more indicators, you can perform these functions:

1. Add Info - Click the Add Info button to open the Add Info dialog box where you

can perform the following functions:

« Add Attributes to the indicator: add one or more attributes to the selected

indicator(s). Once completed, click Add Attributes.

« Link to Another Object: Link the selected indicator(s) to another object

(indicator, event, adversary, file) and click Link Object.
« Set Status: Select a status and click Set Status.

2. Edit the type or status of an indicator by clicking its type or status in the table and

selecting an option from the dropdown menu.

3. Add Indicator - If you notice an indicator on the left that was not extracted, you

can add it by clicking Add Indicator and completing the process.

4. If you wantto search within the table, use the fields at the top of the columns.

If at any point, you wish to abandon the import, click x ABANDON THIS
IMPORT.

15. Click on Finish Import.
CSV File Format - Parsing

When importing a .csv file to parse for indicators using the ThreatQ CSV File Parser, the .csv

file must meet the following criteria:
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o The file must be comma-delimited.
« The file mustinclude at least the following columns:
o Indicator

o Type: This column cannot contain types that are not already established in
ThreatQ. You cannot add custom indicator types and indicator types are case

sensitive. Choose from the following:
« CIDR Block
« CVE
« Email Address
« Email Attachment
o Email Subject
» File Path
» Filename
« FQDN
o Fuzzy Hash
o GOST Hash
« IP Address
. MD5
o Mutex
» Password
« Registry Key
o SHA-1
o SHA-256
. SHA-384
o SHA-512
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o String
. URL
« URL Path
« User-agent
» Username
« X-Mailer

o Status

If the file is not properly delimited, missing a required column, or containing a valid type, it

will fail upon upload.
Editing Indicators
To edit an Indicator:

1. Locate and click on the indicator.

The Indicator Details page opens.

THREA TQ 3 i\ Threat Library

2.50.52.255 & Edit
INDICATOR: IP Address

Created: 04/17/2019  First Seen: 04/12/2019 07:49pi
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2. Click on Edit next to the Indicator name.

The Edit Indicator dialog box opens.

Edit Indicator

Value
zzygdx.com

Type
FQDN v

3. Make the desired change to the indicator Value and Type.

4. Click on Save Indicator.
Deleting Indicators
To delete an Indicator:

1. Locate and click on the Indicator.

The Indicator Details page opens.
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Demo & Edit
INDICATOR: Email Subject

Created: 04/17/2019  First Seen: 04/17/2019 07:16pm  Expires: add date =

@ Attributes

@ Context
@ «
@ Add Attribute No attributes have
@ ! Click the Add button to add atl
& Add Comment
B¢
& Add Relationship
] Add S
jua} ource
7 =7 sources
|

@ Create Task

‘5) I ATT&CK Tools

[ Generate PDF

O

W Delete Indicator

= ) Tags

x Operations

2. Click on Delete this Indicator located to the top right of the page.

A confirmation dialog box appears.

Are You Sure?

Deleting this Indicator can not be undone.

Delete Indicator Cancel

3. Click on Delete Indicator.
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Indicator Search

Indicator Search allows you to search indicators based on a wide range of modifiers and
search criteria. For example, when searching for an event, the results will include all indic-

ators related to that event.

Using indicator search will provide the total number of indicators matching
the criteria of your search, however, the page will only load 1,000 indic-
ators within the results table.

With respect to searching for IP Address or CIDR Block indicators, your results will be as fol-

lows:

« If searching for an IP Address, CIDR blocks will be returned if they fall within the

range.

« If searching for CIDR blocks, IP addresses will be returned if they fall within the

range.

This will search indicator values as well as Attribute of type “IP Address”
(for instance, if an IP address is associated to another IP address through
a passive DNS relationship).

Performing an Indicator Search

To perform an Indicator Search:
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1. From the main menu, click the Search icon.

The Search dialog box appears.

SEARCH

Advanced Search Indicator Search

During a search, you may use a percent sign (%) ta match characters in a string. For example,
specifying net% matches netwark, netware, netscape, and so on: See more examples.

2. Click Indicator Search.
The Indicator Search page appears.
THREATQ 3 iy Threat Library A Inw Lk Analytics

Q, Indicator Search

Select a search filter - - u
e ] lide Form =

3. Select the desired search parameters and operators using the dropdowns, and

enter the values.

Parameter Operator
Is
' Is not
Indicator Class
Is Blank
Is Not Blank
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Parameter Operator

Indicator Value

Contains

Does Not Contain
Is

Is not

Is Blank

Is Not Blank

List of Indicators

Contains

Does Not Contain
Is

Is not

Is Blank

Is Not Blank

Indicator Status

Is

Is not

Is Blank

Is Not Blank

Indicator Type

Is

Is not

Is Blank

Is Not Blank

Date Created

Is

Is not

Is after

Is before

Is in the range of
Is Blank

Is Not Blank

Date Last Modified

Is

Is not

Is after

Is before

Is in the range of
Is Blank

Is Not Blank
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Parameter Operator

Contains
Does Not Contain
) Is
Attachment Title
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Adversary
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Event Title
Is not
Is Blank

Is Not Blank

Is

Is not

Is Blank

Is Not Blank

Event Type

Contains
Does Not Contain
) Is
Attribute
Is not
Is Blank

Is Not Blank

Click + to add more parameters. When your search consists of more than one para-

meter, you can select and or or using the dropdown between the search parameters.
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4. Click Search.
Search results are displayed in a search results table.
THREATO 3 il Threat Library Lo Investigations Lid Analytics

Q, Indicator Search

Indicator Status - Is - Active - n

[ Reset Recent Searches = Hide Form =
Search :QESU|[._: ‘Make Bulk Changes to 1,000 Indicators
Showing 1 te 25 of 1000 Row count: 25 3

M INDICATOR & TYPE & S{EU.CE STATUS & SCORE & DATE CREATED & EXPIRATION DATE & AE‘WERS#.RIES

1.178.179,217 IP Address J:yhlj‘ Active a 03/15/2019 07:04pm

1.179.170.7 |P Address J:yT' Active Q 03/15/2019 07:04pm

101.187.28.8 IP Address Jrf’yhlj" Active a 03/15/2019 07:04pm

B 103.13.29.158 1P Address J:JI‘_’," Active 0 03/15/2019 07:04pm

103.16.131.20 IP Address JI'ID;"T- Active ] 03/15/2019 07:04pm

5. (Optional) Change the number of entries shown in the search results table by

clicking the dropdown menu at the top right and selecting the desired option.

6. (Optional) Click a column header to sort the data by column, and click again to

reverse sort order.

7. (Optional) Search within a column by clicking within the search field at the top of

the column, entering a search keyword, and pressing Enter.
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Results will be shown below the search query.
THREATQ )  m ety

Q Indicator Search

Indicator Status - Is - Active - n
m [ Recent Searches Hide Form =

Search Resulis Make Bulk Changes to 1,000 Indicators

Showing 1 to 25 of 1000 Row count: 25 3
M INDICATOR & TYFE & s?UICE STATUS @ SCORE & DATE CREATED & EXPIRATION DATE & aEVFRSARIES
1.178.179.217 IP Address J:thj‘ Active 0 03/15/2019 07:04pm
B 1.1791470.7 1P Address JI'IC;'T- Active 0 03/15/2009 OT:04pm
101.187.28.8 IP Address J:yhl;" Active 0 03/15/2019 OT:04pm
@ 103.13.29.158 1P Address J:JI‘J’" Active 0 03/15/2019 07:04pm
103.16.131.20 IP Address J:y?- Active 1] 03/15/2019 O7:04pm

You can hide the query to view more of the search results.
Making Bulk Updates to Search Results

The bulk update tool allows you to make batch changes to the objects in your Search res-

ults. The tool is limited to 1000 objects per update.

To make bulk updates to search results:

ThreatQ User Guide, Version 4.30 199



THREA TQH Threat Library

1. From the main menu, click the Search icon.

The Search dialog box appears.

SEARCH

Advanced Search Indicator Search

During a search, you may use a percent sign (%) ta match characters in a string. For example,
specifying net% matches netwark, netware, netscape, and so on: See more examples.

2. Click Indicator Search.

The Indicator Search page appears.
THREATQ 3 i\ Threat Library

Q, Indicator Search

Select a search filter - - u
, ‘ Hide Form =

3. Perform your Indicator Search.
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4. Atthe top of the Search Results, choose Make Bulk Changes to 1,000 Indicators.

The Bulk Update Tool appears.
THREATO 3 () Home ) Threat Library ~ s Investigations

Bulk Update Tool Your changes will affect 1,000 Indicators
Apply a new status

Provide an additional source
Select a source o
Add new source

Apply Attributes

- v Selact a source -

Add new source

Relate 1o ancther object (e.g. an indicator, event, adversary, etc...)

Update Expiration Policy

Extend Date

Add a number of days to expiration date:

5. Optionally, apply a new object status by choosing from the dropdown.
6. Optionally, enter an additional source.
7. Optionally, apply one or more attributes:

a. Choose an Attribute Type from the dropdown.

b. Enter an Attribute Value.

c. Enter an Attribute Source.

d. Optionally, choose the add icon to apply additional attributes.

8. Optionally, relate your search results to another object in the platform. As you

enter the related object, ThreatQ offers type-ahead suggestions.
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9. Optionally, update the object's expiration policy, by choosing an option from the

Update Expiration Policy dropdown.

10. Click Apply Changes.

Indicator Status
Every indicator in the system will have a status applied to it.

The default statuses that ship with a standard installation of ThreatQ are as follows:

Status Description

Active Poses a threat and is being exported to detection tools.
Indirect Associated to an active indicator or event (i.e. pDNS).
Review Requires further analysis.

Whitelisted | Poses NO risk and should never be deployed.

Expired Indicator has reached its expiration and has been is deemed by an ana-

lyst to pose less of a threat to their infrastructure than other indicators.

"1

You cannot delete a default status but you can add new custom statuses
to be used. See Adding an Indicator Status and the Related Topics sec-
tion below for more details.

A J

Most exports in ThreatQ are configured to use the Active status to signal deployment to
external devices. However this can be modified and each status can be used however your

organization sees fit.
Related Topics:

« Changing the Status of an Indicator

« Indicator Statuses
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o Indicator Expiration

« Automatic Expiration and Policies

Changing the Status of an Indicator

Changing an indicator’s status is straightforward, except in the case of whitelisting CIDR
Block indicators. When whitelisting a CIDR Block indicator, this process generates a whitel-

isting rule. See Whitelisted Indicators for more information.

Changing the status of an indicator:

1. Locate and click the indicator to open its details page.

2. Click the status dropdown menu, and select the desired status.

SCORE: o0-Verylow =~ (i) STATUS: [ Active

Expired

No longer poses a serious threat.

Indirect

iated to an active indicator or event (i.e. pDNS).

Review
Requires further analysis.

ided. Whitelisted
to this object. Poses NO risk and should never be deployed.

The status will be updated.
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N

ﬂ If an Administrator or the Primary Contributor are whitelisting a CIDR
BLOCK indicator, there is a different process, as this actually gen-
erates a whitelisting rule. For more information, see the Creating a
Whitelist Rule topic.

. J

Indicator Expiration

Expiration ("Expired") is a status that can be assigned to an indicator. The expired status
should be used when an indicator is deemed by an analyst to pose less of a threat to their

infrastructure than other indicators.
Related Topics:

Ways an Indicator can Expire

Expiration Date Displays

Changing an Individual Indicator's Date

« Automatic Expiration and Policies

Ways an Indicator can Expire

- An analyst manually changes an indicator(s) status to "Expired"

This can be achieved by visiting an individual indicator's details page, then using the

Status dropdown in the top right hand comer of the page to change the status.

If the analyst wishes to change the status of multiple indicators at the same time, they
can use the advanced search tool to find the indicators they'd like to update, then click

the Bulk Update button found directly to the right above the search results.
« An analyst manually sets an expiration date for a specific indicator

Each indicator has the option to have an expiration date set, which once past, will

toggle the status of that indicator from it's current status to "Expired".
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« An expiration policy has been applied to the source reporting an indicator and

therefore an expiration date is automatically set for that indicator during inges-

tion

Using the “Expiration” tab on the Indicator Management page, a ThreatQ admin has
the ability to apply expiration policies to all ingested information, both new and exist-

ing, coming from a specific intelligence source.

ﬂ If an indicator is reported by multiple sources that have expiration policies,
the date will be set using the greater expiration date. For example, if both
Feed A (with a 5 day policy) and Feed B (with a 3 day policy) report the
same indicator on the same day, that indicator will automatically expire 5
days from now.

&

Changing an Individual Indicator's Date

When viewing a specific indicator, its expiration date can be changed by clicking on the link

next to the expiration information.

THREATO 3 iify Threat Library 2 Investigations Lul Analytics

195.123.245.83:447/tt0002/william-
pc_w629200.f71819bb1edf5078c2b2ab2aff931102/5/bcclientdll64/
INDICATOR: URL

Created: 05/09/2019  First Seen: 05/09/2019 07:31am  Expires: add date -
Add 7 days
. Add 14 days
@ Attributes (10) Y
(@ context Protect from auto-expiration
@ Attributes (10) | O ATTRIBUTETYPE = Remove current expiration date JE =

= Caciemns AL

Options include:
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Add 7 Days This will extend the current expiration date by 7 days.
Add 14 Days This will extend the current expiration date by 14 days.
Protect from This will set the indicator to "Never Expire". Once set, this indic-

Auto-Expiration ator will be exempt from all automated expiration processes
regardless of circumstances. The only way for this indicator to

expire moving forward is by analyst choice.

Remove Current | This will remove the currently set expiration date. If this indicator

Expiration Date | is reported by an intelligence feed (with an expiration policy) in

the future, a new expiration date will be added at that point in time.

Expiration Date Displays

Option Image Description
No expir- . In this example, the indicator will not automatically expire
ation date E‘m:”rl)E'Si %gg—gﬁ-te%(ﬁramon date has not been specified.

has been set
This status will be changed if an analyst sets an expiration date
or a new source (wjth an expiration policy applied to it) reports

this indicator in thelfuture.

An expir- Expires I thigsexample, the indicator has an expiration date set of
ation date is 1/20/2017. This means that this indicator will expire when the cal;
set endar day changes frgm the 19th to the 20th of January (based

on ThreatQ's server tir|ne, not the user's local time).

ExpiresYMh)e@a?@ %Rj@}i(;n date is less than 7 days away, ThreatQ will
switch to show a relative version of the date.

Protected %ometim s an analyst will want an indicator to stay "Active" regard-
Never Expire (change) =
from auto- less of any automated circumstances. In this case you can set an
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Description
matic expir- indicator to be protected from auto-expiration, which will display the
ation (Never words "Never Expire". This can only be "overwritten" by an analyst.
Expire)

Automatic Expiration and Policies

Automatic expiration allows you to deprecate stale intelligence based on a set of defined cri-
teria. As the data becomes less relevant, ThreatQ sets the status to Expired, which relieves

the data burden on your team or infrastructure.
You can configure automatic expiration from the Data Management page.

1. From the navigation menu, click on settings icon 1 and select Data Management.

The Data Management page will open with the Automatic Expiration tab selected by
default.

Related Topics:

 How ThreatQ Calculates Expiration Dates

Selecting an Expiration Policy per Feed

Applying Expiration Policy Changes to Data

Adding Exceptions

Common Expiration Policy Scenarios

How ThreatQ Calculates Expiration Dates

Scenario Description

Indicator If an indicator has an expiration date and it's reported by a new

Reported by source that has an expiration policy, ThreatQ will set the expiration
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Source with an | date using the policy with the greater expiration date.

Expiration

Policy

Indicator If an indicator has an expiration date and it's reported by a new
Report by a source that has an expiration policy of Never Expire, ThreatQ sets

Source with an | that indicator to Never Expire.
Expiration
Policy of Never

Expire

Indicator If an indicator is reported by a source that has an exception for the
Reported by a | indicator, the exception expiration date will be used regardless of
Source with an | the greater expiration date.

Exception for

that Indicator G An exception takes precedence over the source’s

expire policy.
Indicator If an indicator is reported by a source with an Expiration Policy and
Reported by then reported by a second source with another Expiration Policy, the

Two Different | greatest expiration date is selected to set the expiration date. The
Sources expiration date will be set based on the date the second source

reported the indicator.

Indicator If an indicator is reported by a source that has an exception for the
Reported by indicator and then reported by a second source, the greatest expir-
Two Different | ation date is selected despite the exception. The expiration date will
Sources, one be set based on the date the second source reported the indicator.
with an Excep-

tion
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Selecting an Expiration Policy per Feed

You can choose from three options when configuring an expiration policy for a source of

intelligence:
Option Description
Don't automatically ThreatQ sets all feeds to Don't Automatically Expire until an
expire (No policy set) analyst decides otherwise. When set, indicators reported from

this specific feed do not have an expiration date automatically
applied to them.

If an indicator is reported by Source A (an intelligence feed
without an expiration policy), and is later reported by Source B
(an intelligence feed that expires data in 7 days), ThreatQ sets

the indicators to automatically expire in 7 days.

Automatically Expire When setting a specific intelligence feed to Automatically
Indicators Expire Indicators, ThreatQ requires you to provide a specific
number of days. After you configure this setting, it applies to all
intelligence currently in the system, as well as new intel-
ligence as itis ingested. ThreatQ calculates the appropriate
expiration date based on the number of days from ingestion.
Once an indicator's expiration date is met, its status changes

to Expired.

Automatic Expiration

Unburden your teamn from the task of manually deprecating intelligence. Based on a set of eriteria defined and controlled by you, threat intelligence will automatically
expire as it becomes |ess relevant to your team and infrastructure. How it works

abuse.ch SSLBL IP Blacklist Don't automatically expire - & Exceptions =

Exceptions

INDICATOR TVPE & POLIEY &

Binary String - Expire | 25 days after ingestion. | Delete
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Option Description

Never Expire Using this setting ensures that all intelligence reported by a

specific feed is protected from automatic expiration, regard-

less of scenario.

Applying Expiration Policy Changes to Data

When updating an expiration policy, the system now applies the update to all selected
existing data in the platform to honor the new policy. This process can take a while based on

system resources and the number of indicators in the system.

Refer to the following table for estimates on the total time required for the system to apply the

selected policy to existing data, based on the following criteria:

« Dataset: 6 Million Indicators

« System Specifications: 32GB VM 4 vCPU

Indicators to reset

Reset and Recal- Total Time for
expiration out of - Expire Indicators
culate Expiration Reset
6m total indicators
50,000 3 hours and 30 53 seconds
_ 3 hours 31 minutes
minutes
100,000 4 hours and 51 1.8 minutes
. 4 hours 53 minutes
minutes
200,000 10 hours 20 minutes | 3.5 minutes 10 hours 24
minutes
1.2 million 2 days 7 hours 4 35 minutes 2 days 7 hours 40
minutes minutes
3.1 million 3 days 16 hours 42 | 3.5 hours 3 days 20 hours
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Indicators to reset .
Reset and Recal- Total Time for

expiration out of - Expire Indicators
culate Expiration Reset

6m total indicators

minutes

4 days 7 hours 17
5.3 million _ 4.7 hours 4 days 12 hours
minutes

Adding Exceptions

ThreatQ allows you to add exceptions based on specific indicator types within in a feed in
addition to setting an expiration policy at a global level for all intelligence ingested by a spe-

cific feed.
To Add an Exception:

1. Navigate to the Automatic Expiration tab under Data Management.
2. Locate the source.

3. Click Exceptions to expand the option.

The Exceptions option menu opens.

Data Management

Whitelisted Indicatars Autpenatic Expiration Seoring

Automatic Expiration

Unburden your team from the task of manually deprecating intelligence, Based on a set of criteria defined and controlled by you, threat intelligence will automarically expire as it becomes less
Falevant Do your team and infrasiructure, How il works

abuse.ch Feodo Tracker Botnet C2 1P Don't automatically expire - Exceptions »
Blecklist

admin@threatg.com Don't automatically expire - Exceptions ¢
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4 N\
"1

The number of existing exceptions for a source will be listed next to
its Exceptions link.

€ Exceptions »

4. Click Add Exception.
5. Select the Indicator Type from the dropdown.

6. Enter the number of days after the item has been ingested before expiring.

ﬁ Repeat steps 4-6 to add multiple

7. Click on Delete next to the row to delete an exception.

8. Click on Save.

Common Expiration Policy Scenarios

Scenario Description

An indicator is reported by a single 1. On 10/1, Source A reports the indicator
source (with an expiration policy) and the expiration date is setto 10/8.

2. When the date switches from 10/7 to 10/8,
this indicator is queued to have its status

changed to Expired.

An indicator is reported by Source A 1. On 10/1, Source A reports the indicator
(with an expiration policy of 7 days) and the expiration date is setto 10/8.

and 3 days later is reported by 2. Source B reports the same indicator 3
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Scenario Description

Source B (with an expiration policy of days later (10/4). The indicator's expir-

10 days). ation date is set using the greatest expir-
ation date between the two sources. In
this example, the new expiration date will
be 10/14 (10 days from when it was repor-
ted by Source B).

3. When the date switches from 10/14 to
10/15, this indicator is queued to have its

status changed to Expired.

An indicator is reported by Source A 1. On 10/1, Source A reports the indicator

(with an expiration policy of 7 days) and the expiration date is set to 7 days.
and is later reported by Source B 2. Source B reports the same indicator 3
(with an expiration policy of Never days later with a policy of Never Expire.
Expire). The indicator’s expiration date is removed

and the indicator is now set to Protect

from auto-expiration.

An indicator is currently set to 1. On 10/1, an indicator is in ThreatQ with a
Expired and is reported by Source A status of Expired.

(with an expiration policy of 7days). | 2 On 10/1, Source A reports the indicator.
The status of the indicator changes to
whatever the default status is for Source A

and the expiration date is set to 10/8.

3. When the date switches from 10/7 to 10/8,
this indicator is queued to have its status

changed to Expired.

An indicator is currently set to 1. Anindicator is in ThreatQ with a status of
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Scenario Description

Expired and is reported by Source A

(with an expiration policy of Never

Expire).

. Source A, with an expiration policy of

Expired.

Never Expire, reports the indicator. The
expiration of that indicator changes to Pro-

tect from auto-expiration.

A FQDN indicator is reported by
Source A (with an expiration policy of
10 days with an exception for 5 days
for FQDN indicators) and is later
reported by Source B (with an expir-
ation policy of 15 days).

. On 10/1, Source A reports the FQDN indic-

. Source B reports the same indicator 1 day

. When the date switches from 10/17 to

ator and the expiration date is set to 10/6.

"

An exception takes pre-
cedence over the
source’s expire policy.

later (10/2). The indicator's expiration date
is set using the greatest expiration date
between the two sources. In this example,
the new expiration date will be 10/17 (15
days from when it was reported by Source
B).

10/18, this indicator is queued to have its

status changed to Expired.

Indicator Scoring

Indicator scoring allows you to apply weighting to indicators and their contextual information,

such as sources, attributes, and indicator types, as they are added to ThreatQ. Indicator scor-

ing allows you to set manual scores or you can rely on ThreatQ’s scoring algorithm to cal-
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culate scores. After scores are calculated, you can change the score as desired to your cus-

tom value or accept the calculated value.

Related Topics:

« Configure Indicator Scoring

« Building a Scoring Algorithm

o Overriding the Scoring Algorithm with a Manual Score

Configure Indicator Scoring

1. From the navigation menu, click on settings icon 1 and select Data Management.

The Data Management page will open with the Automatic Expiration tab selected by
default.

2. Click on the Scoring tab.
THREATQ )  m wvesions

Data Management

wWhitelisted indicators Automiatic Expiration 5 {1 utl

Scoring Sensitivity Configuration

Indicator scoring allows you to apply weighting to contextual information, such as sowrces, attributes, and indicator types, After scores are caloulated, you can change the score as desired on
the individual indicator pages. For each subset of data below, you can increase or decrease the score,

\dicator Source Adributes Adversary Relationship
it

Blnary String DECREASED ? INCREASED | 10 :

CIDR Block DECREASED ? INCREASED | 0 -

CVE DECREASED : ? = INCREASED | 0 ¢

Email Address DECREASED - ? — IMCREASED | O

“ After clicking save, these changes will take time to process and will noc immedately take effect

ThreatQ User Guide, Version 4.30 215



THREA TQH Threat Library

Building a Scoring Algorithm

As you build a scoring algorithm, you influence indicator scores based on the following cri-

teria:

Indicator Type

Indicator Source

Attributes

Adversary Relationship

Use the slider to determine the sensitivity of the criterion you select. By default, the slider is
positioned in neutral position, which in isolation produces an indicator score of zero. You

may increase the score up to 10, which creates a score of Very High. You may also

decrease the score, which creates a score of Very Low.
THREATQ )  mmeescinny

Data Management

‘Whitelisted Indicators Automatic Expiration

Scoring Sensitivity Configuration

Indicatar scoring allows you to apply weighting to contextual informaticn, such as sowrces, attributes, and indicator types, After scores are calculated, you can change the score as desired on
the individual indicator pages, For each subset of data below, you can increase or decrease the score.

LoF 5 Anrik 4 f
Binary String DECREASED ? INCREASED 10
CIDR Block DECREASED ? INCREASED 0=
CVE DECREASED ? INCREASED ]
Email Address DECREASED . ? . INCREASED o =

m Afer clicking sawe, these changes will ke time 1o process and will not immesately take effect

Influencing Score Based on Attributes
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1. Navigate to the Attributes category under Scoring.
Scoring Sensitivity Configuration
Indicator scoring allows you to apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the

score as desired on the individual indicator pages. For each subset of data below, you can increase or decrease the score.

ndicater Type ndicater Source  Attributes Adversary Relationship

score ~ |is B DECREASEDF - - - - - - -~ - - = 4? S INCREASED 2 -

2. Click Add

3. Designate an Attribute Key / Value Pair
4. Adjust the sensitivity using the slider.

5. Click Save.

Influencing Score based on Adversary Relationship

1. Navigate to the Adversary category under Scoring.
Scoring Sensitivity Configuration

Indicator scoring allows you ta apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the
score as desired on the individual indicator pages. For each subset of data below, you can increase or decrease the score.

Indicator Type ndicator Source Attributes #dversary Relationship

[Agiia'.edﬂl'irwr.erus % DECREASED ——— — ? e +w— |NCREASED O = Delate

2. Click Add

3. Select an Adversary.

4. Adjust the sensitivity using the slider.
5. Click Save.

Overriding the Scoring Algorithm with a Manual Score

Setting a manual Indicator Score:
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1. Navigate to an Indicator's Details page.

2. Click the Score dropdown and select a score.

THREATQ 3

Demo
INDICATOR: Email Subject

£ Edit

Created: 041772019 First Seen: 041772019 07:16pm

(©) context

@ sxriaues 0)

¢§’ Relationships

{2} comments (0}
}& Operations

B audit Log

@ Attributes

& sources

W ATTRCK Toch

) Tags

[&7 Description

Expires: add dee -~

SCORE: | O-Verylow = | (i) STATUS:

10- Very High
- High
| 8 - Medium

© Add
7 - Madium

Fom
5-Llow
4 -Wery Low
3 -Very Low
2 -Very Low
1= Very Low

O -Very Low

& Edit
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Optionally, you may revert to the calculated score by clicking on the Score dropdown

and selecting Generated Score.

SCORE: (i) STATUS: Active ~

I 10 - Very High

8 Add to Watchlist

9 - High

8 - Medium

_ © Add
7 - Medium

6 - Low
5-Low
© Add
4 -Very Low
3 -Very Low
2 -Very Low

1 -Very Low

0 - Very Low

10 - Generated Score

Whitelisted Indicators

There are some indicators that should be considered to be whitelisted, or non-malicious,

and we do not want those indicators going out to other systems. For example, a company’s
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own domain name would never need to be blocked.

The whitelisting process creates rules that apply to particular indicators, so that when those

indicators come in in the future, they will be automatically whitelisted.
Within this section, the following options are available:

Viewing Existing Whitelist Rules

Creating a Whitelist Rule

Editing a Whitelist Rule

Removing a Whitelist Rule

Viewing Existing Whitelist Rules

To view existing whitelist rules:

1. Click on the settings icon E] and select Data Management.

2. Select the Whitelisted Indicators tab

The Whitelist Rules page opens. Existing whitelist rules are listed in the Whitelist
Rules table.
THREATQ 3

Data Management

cenatic Expiration Seoving

Whitelisted Indicators n

Whitelisting indicators designates therm as non-malicious, which ean apply 1o yeur company's demain name of any ether domain your rganization knows L be safe, Threatl) provides you with

the ahility to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted autemarically. How iTwork

(m] RULEVALUE INDICATOR TYPE AFFECTED 2 ACTIONS
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Creating a Whitelist Rule

The process of creating a whitelist rule is almost exclusively available via the Tools menu.
However, itis important to note that whitelisting a CIDR Block indicator also creates a whitel-

istrule.

To create a whitelist rule:

1. Click on the settings icon E! and select Data Management.

The Data Management page opens.
THREATQ 3

Data Management

Automatic Expiration

Unburden your team from the task of manually deprecating intelligence. Sased on aset of criteria defined and controlled by you, threat intelligence will automatically expire as it becomes less relevant
ta your team and infrastructure

abuse.ch Feodo Tracker Batnet C2 1P Blocklist | Doet automatically exgire - Exceptions ¢
admin@threatq. com Do Autormatically expire - Exceptions
ATTELK Teals Dierrt automatically expire v Exceptions ¢
Cofense inteliparce Disrit autarmatically expire - Excoptions ¢

m A ickieg apedy, i chargges il ke e 2 prscirss at wll ot invraciatty 1ok afToct
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2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.
THREATQ )  movestoony A esgaions 1o ansiyics

Data Management

Autormatic Expiration Stonng TP

Whitelisted Indicators n

Wiitelisting indicators designates them as sen-malicious, which can apply 1o yeur company’s demain name or any other demain your soganization knows to be safe, ThreatQ pravides you with
the ability to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted automatically. How T works

D RULE VALUE + INDICATOR TYPE AFFECTED 3 ACTIONS

3. Click Add Rule.

The Add Whitelist Rules page opens.

Add Whitelist Rule

— Which indicator type will this rule apply to?
CVE

— Rule Value

CVE-2015-1461

4. Selectthe Indicator type the rule will apply to.
5. Add a Rule Value.

6. Click Next.
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Affected indicators are listed in the dialog box.

Add Whitelist Rule

Continue Editing This Rule

7. Review the affected indicators to determine if you are satisfied with the rule.

"l

The rule has not been applied yet, so you still have time to edit it
based on whether you are satisfied with how it affects the indicators.

8. Click Continue Editing this Rule.
9. Ifyou are satisfied with the rule, click Add Rule.

The rule is applied to existing indicators, and it is entered into the Whitelist Rules

table.
Any new indicators will also have the rule applied to them as they enter the system.

Editing a Whitelist Rule

"

Important: Editing a whitelist rule will not undo any changes the rule had
made prior to being edited.

To edit a whitelist rule:
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1. Click on the settings icon ['3 and select Data Management.

The Data Management page opens.

THREATQ )

Data Management

Tk Vititmisted indlcators

Automatic Expiration

unburden your team from the task of manually deprecating intelligence. Based on aset of crireria defined and conerolled by you, threat intelligence wil automatically expire as it becomes bess relevant

ta your beam and infrastructure

abuse.ch Feodo Tracker Baret C2 IF Blocklist | Do automatically expire * Exceptions »
admin@threatq. com Dt automatically expire Exceptions ¢
ATTECK Tesals Dt autarmatically expine - Exceptions ¢
Cofanse intelipance Dot Butomatically expire Excoptions ¢

BEETI o s i s g i s s el ity b o

2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.

THREATQ :, B ThrestUbrory A (mestiabons Ll Anayics

Data Management

Automatic Expration Sonng TP

Whitelisted Indicators n

Whitelisting indicators designates them as non-malicious, which can apply to your company’s demain name or any other domain your organization knows to be safe, ThreatQ provides you with
the ability to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted automatically. How it work

D RULE WALUE INDICATOR TYPE AFFECTED = ACTIONS

3. Inthe Whitelist Rules table, locate the rule you wish to edit.
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4. Click Edit.

The Edit Whitelist Rule dialog box opens.

Edit Whitelist Rule

Which indicator type will this rule apply to?

CVE

— Rule Value

CVE-2015-1461

5. Make the desired edits and click Next.

Affected indicators are listed in the dialog box.

Edit Whitelist Rule *

Continue Editing This Rule
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6. Review the affected indicators to determine if you are satisfied with the rule.

The rule has not been applied yet, so you still have time to edit it
based on whether you are satisfied with how it affects the indicators.

7. If you are satisfied, click Edit Rule.
The rule is applied to existing indicators, and itis updated in the Whitelist Rules table.

Any new indicators will also have the rule applied to them as they enter the system.
Removing a Whitelist Rule

To remove a whitelist rule:

1. Click on the settings icon E and select Data Management.

The Data Management page opens.
THREATQ 3

Data Management

Automatic Expiration

Unburden your team frem the task of manually deprecating intelligence. Sased on aset of craeria defined and carerolled by yau, threat imtzlligence wil automatically expire as it becomes bess relevant
ta your team and infrastructurs

abusech Fecds Tracker Botnet C2 IP Blocklist | Don™ automatcally expire Exceptions

admin@rhrears. cam Dt autoratically expire Excepaions ¥

ATT&CK Toals Dot aUtormatically expine Excepeions
i Lefig Doer automatical Excups
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2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.

THREATQ 3 W ThrestUbrery A Investigotions Ll Analytcs

Data Management

Automatic Expiration Seoring TLe

Whitelisted Indicators n

wihitelisting indicators designates them as non-malicious, which can apply to yeur company’s demain name o any other domain your organization knows to be safe, ThreatQ provides you with
the ability to create rules that apply 1o those particular indicatars, so that when those indicators are ingested in the future, they will be whitelisted automarically. How 17 wocks

D RULE WALUE INDICATOR TYPE AFFECTED = ACTIONS

3. Locate and select the rule(s) from the table that you wish to remove.

4 Click on the delete Icon B

A confirmation dialog box opens, asking if you are sure.

Are You Sure?

This action cannot be undone.

The status of each indicator will remain whitelisted until manually changed.

Delete Whitelist Rule Cancel
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5. Click Delete Whitelist Rule.

The rule is deleted and a confirmation alert appears in an alert bar at the top of the

page.
Indicator URL Normalization
Remove Quotes from the Beginning and/or End of an Indicator

Single and double quote characters are removed if they are the first or last character of an

indicator.

Remove Unneeded Spaces found within an Indicator

All spaces irrelevant of their position in the Indicator value are removed (when applicable).
Adjust leading protocol from indicators

Indicators with a leading protocol [http:/, hitps:/, ftp://, or ftps://] are extracted and included as
an attribute. When applicable, this indicator adjustment could change the indicator type from
URL to FQDN.

Example: Original URL indicator of http://fevilsubdomain.no-ip.biz/ would convert to a FQDN

= evildomain.no-ip.biz.
Adjust the Port from an IP Address

An IP address with a port [ex. 199.7.136.88:8143] will be truncated to the IP address and the

port assignment will be added as an attribute.

Using the previous example the following indicator/attribute will be created:

Field Value

URL 199.7.136.88

Attribute > Port 8143

Adjust Defanged/Neutered Indicators
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Indicators that have been defanged/neutered in order to “safely” share them (i.e. www [dot]
3322 [dot] org or badguy [at] gmail.com) need to be adjusted during import in order to ensure

the indicators are properly deployed.
Create an IP Address from a URL (when applicable)

Using the previous example the following indicators will be created:

Field Value

URL 51.255.131.66/civis/viewforum.php

IP Address 51.255.131.66

Create a FQDN from a URL (when applicable)

When a URL contains a domain [ex. bat99-11611.co/gate777.php] a second indicator will
be created for the domain [bat99-11611.co].

Using the previous example, the following indicators will be created:

Field Value
bat99-11611.co/g-
URL
ate777.php
FQDN bat99-11611.co

Extract HTTP Parameters from a URL Indicator

HTTP parameters [chained.j3oil-
gasinc.net/civis/iviewforum.php?keywords=9obo&amp;fid0=c27] are important but can sig-
nificantly limit pattern-matching detection capabilities due to the likelihood of parameter
deviations, as well as, hamper the volume of URL indicators being deployed. To increase

the probability of detection the http parameters are extracted and created as attributes.

In this example:
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Field

Value

URL IOC chained.j3oilgasinc.net/civis/viewforum.php

Attribute =HTTP Para-

meter = keywords

9obo&amp;fid0=c27

Maintain “WWW” on FQDN Indicators

When parsing or importing a FQDN the “www” will be maintained.

Replace and/or Remove Special Characters

ASCIl Values <32
ASCII Values > 127

<space>

Replacement

Ascii 96

Ascii145

Ascii146

Ascii147

Ascii148

Ascii151

carriage return and line feed

<space>

Control Characters

Remove

Convertto UTF8

null characters.

Remove leading and trailing space, tab, newline, carriage return, vertical tabs and
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Supported Defanging Techniques
The table below lists all supported indicator defanging techniques.
[] =>
[dot] =>
(dot) =>
[d] =>
-dot- =>
_dot_ =>
hxxp:// => http://
hxxx:// => http://
hxxps:// => https://
hxxxs:// => https://
[hxxp] => http
hxtp:// => http://
htxp:// => http://
hxtps:// => https://
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htxps://

[http]

[hitp:/N

[https]

[https:/

[at]

-at-

_at_

_@_

(@]

[www]

Signatures

https://

http

http://

https

https://

WwWw

ThreatQ allows you to ingest and manage Signatures, such as Snort and OpenlOC. While

importing, ThreatQ parses the signature file for Indicators to add. Once signatures are

included in your deployment, you can add contextual information and correlate them with

Indicators, Events, Adversaries, and Files.

Related Topics:
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o Signhatures Management Page

« Adding a Signature

o Adding a Yara Signature

Signatures Management Page

The Signatures Overview page displays all signatures in the platform. For each signature,

the table displays the Date Created, Signature Type, and Signature Title.

You can filter the table based on criteria to view specific signatures. For each signature, you

can click to view expanded details.
From the Signatures Overview page, you can do the following:

« View all signatures in the platform and details for each signature
« Filter signatures by Date Created, Signature Type, and Signature Title

« Add new signatures
Adding a Signature

To add a Signature:
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1. From the main menu, choose Create > Signature.

The Add Signatures dialog box
THREATQ 9

opens.

18t Analytic

Add Signatures

tent yaud ke to be parsed for signatures.

8 Parse signature for indicators

Extracted Signatures

Apply attributes to all extracted signatures. (optional)

Relate signatures to another object (a.g. an indicator, event. adversary, atc_.)

All Obgjects

m Step 1: Tell is abaut the Impart > Step 2: Review Signatunes

2. Choose the type of signature from the drop-down .

ﬂ For Yara, see Adding a Yara Signature.

3. Select a Source from the dropdown provided.

e N
x

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.
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4 N\

E ."\ "
Source

Demo
Selact a source

Status

| N

5. Do one of the following:

« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste content into the right pane.

6. Optionally, select to parse the signature for indicators.
7. Choose a Signature Status from the drop-down menu.
8. Optionally, Apply attributes to all extracted signatures:

« Select an Attribute Type.

» Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, click the Add icon for additional attributes.

9. Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.
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10. Click Next Step.

If signatures are discovered, the Results dialog box appears.

Results

We've found 979 signatures.

How would you like to proceed?

11. You can either select Submit Import to finish adding the signatures or Review to
customize what data is imported.

If you selected to review signatures, the Add Signatures Step 2: Review page
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loads.
THREATQ )

B Threat Library

Add Signatures

979 Signatures Extracted

m]

BROWSER-IE Microsoft Internet Explerer CDocument use after free attempt (268 Active

20:1)

BROWSER-IE Microsoft Internet Explerer CTreeNode use after free memary corr Active

uption attempt (26889:1)

BROWSER-IE Microsoft Internet Explorer CTreeNode use after free memary corr Active

uption attempt (26888:2)

BROWSER-IE Microsoft Internet Explorer anscroll use after free attempt (26887 Active

5

BROWSER-IE Microseft Internet Explorer onscrall use after free attemnpt (26B86:  Active

5)

BROWSER-IE Microsoft Internet Explorer anscrall use after free attempt (26B85:  Active

5)

Step 1: Tell us about the impaort » Step 2: Review Signatures

12. Select one or more signatures and click Delete.

15 Attributes

15 Attributes

15 Attributes

13 attributes

13 attributes

14 Attributes

0 Indicators

0 Indicators

0 Indicators

O Indicators

O Indicators

0 Indicators

Show Details »

Show Details »

Show Details »

Show Details ¥

Show Detalls ¥

Show Detalls »

13. Click on Show Details for a signature to review individual items in a signature.

Use the checkboxes to select unwanted signature items and click Delete.

A warning dialog box appears.

[iS

Are You Sure?

This will delete the selected Signature items from the import.

Cancel

14. Click Delete to remove the unwanted items.
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15. Click Create Signatures when finished.
Adding a Yara Signature
To add a Signature:
1. From the main menu, choose Create > Signature.

The Add Signatures dialog box

opens.
THREATQ 3  mrvesioany & estgasons .

Lt Analytics

Add Signatures

& Parse signature for indicators

Extracted Signatures

Apply attributes ta all extracted signatures. (sptienal)

Relate SIgnatures 1o another alject (2.8, an indicator, event, adversary, e}

All Oljcts

m Spep 1: Tell us about the Import > Step 2 Review Signatures

2. Select Yara as the type of signature from the drop-down .

3. Select a Source from the dropdown provided.

"1

You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
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10.

N

ﬂ' in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo

Select a source

Status

| 5

Do one of the following:

« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste contentinto the right pane.

Optionally, select to parse the signature for indicators.

Determine the method to use if multiple signatures are discovered:
« Save independently as unique signatures

« Save as a single signature
Choose a Signature Status from the drop-down menu.
Optionally, Apply attributes to all extracted signatures:

« Select an Attribute Type.

» Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, click the Add icon for additional attributes.

Optionally, relate the signature to another object by entering the objectin the

Relate signatures to another object field.
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11. Click Next Step.

If signatures are discovered, the Results dialog box appears.

Results

We've found 979 signatures.

How would you like to proceed?

12. You can either select Submit Import to finish adding the signatures or Review to
customize what data is imported.

If you selected to review signatures, the Add Signatures Step 2: Review page
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THREATQ )

B Threat Library

Add Signatures

979 Signatures Extracted

m]

BROWSER-IE Microsoft Internet Explerer CDocument use after free attempt (268 Active

20:1)

BROWSER-IE Microsoft Internet Explerer CTreeNode use after free memary corr Active

uption attempt (26889:1)

BROWSER-IE Microsoft Internet Explorer CTreeNode use after free memary corr Active

uption attempt (26888:2)

BROWSER-IE Microsoft Internet Explorer anscroll use after free attempt (26887 Active

5

BROWSER-IE Microseft Internet Explorer onscrall use after free attemnpt (26B86:  Active

5)

BROWSER-IE Microsoft Internet Explorer anscrall use after free attempt (26B85:  Active

5)

Step 1: Tell us about the impaort » Step 2: Review Signatures

13. Select one or more signatures and click Delete.

15 Attributes

15 Attributes

15 Attributes

13 attributes

13 attributes

14 Attributes

0 Indicators

0 Indicators

0 Indicators

O Indicators

O Indicators

0 Indicators

Show Details »

Show Details »

Show Details »

Show Details ¥

Show Detalls ¥

Show Detalls »

14. Click on Show Details for a signature to review individual items in a signature.

Use the checkboxes to select unwanted signature items and click Delete.

A warning dialog box appears.

[iS

Are You Sure?

This will delete the selected Signature items from the import.

Cancel

15. Click Delete to remove the unwanted items.
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16. Click Create Signatures when finished..

STIX
The following describes how to use STIX in ThreatQ:

STIX Overview

ThreatQ STIX Object Types

« STIX Data Mapping

Parsing a STIX File for Indicators

STIX Overview
ThreatQ allows you to ingest and manage STIX files. You can ingest STIX data in two ways:

« You can setup a STIX/TAXII Feed, as described in STIX/Taxii Feeds.

« You can upload a STIX file orinsert STIX data to parse for indicators, as described

in Parsing a STIX File for Indicators.

¢ ThreatQ supports STIX 1.1.1, STIX 1.2 and STIX 2.0.

Related Topics

« STIX Data Mapping

o ThreatQ STIX Object Types

ThreatQ STIX Object Types
STIX integration provides ThreatQ with the following additional object types.

o Campaigns
o Courses of Action
« Exploit Targets

« Incidents
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o TTP objects
Identities (STIX 2.0)

Reports (STIX 2.0)

Vulnerabilities (STIX 2.0)

These objects enable better understanding and communication of STIX data. STIX data will

be mapped to these objects and existing objects in the system.
STIX Data Mapping

The following sections display how STIX data becomes mapped to indicator objects and
attributes in ThreatQ.

o STIX1.1.1, 1.2 Data Mappings

o STIX 2.0 Data Mappings

STIX1.1.1, 1.2 Data Mappings

You can click onthe = icon located to top-right of this topic to expand and collapse all map-

ping tables below.

Threat Actors Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Identity Adversary.value
ID Adversary.attribute STIX Reference ID
Title Adversary.value
Type Adversary.attribute Type
Timestamp Adversary.published_at
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STIX Field ThreatQ Field Mapping ThreatQ Name
Description Adversary.attribute Description
Motivation Adversary.attribute Motivation
Sophistication Adversary.attribute Sophistication
Intended_Effect Adversary.attribute Intended Effect
Role Adversary.attribute Role
Confidence Adversary.attribute Confidence
Handling Adversary tlp
Observed TTPs TTP
Associated_Actors Adversary
Associated_Campaigns Campaign

Indicators Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Indicator.attribute Indicator Title
ID Indicator.attribute STIX Reference ID
Timestamp Indicator.published_at
Type Indicator.attribute Indicator Type
Description Indicator.attribute Description
Short Description Indicator.attribute Short Description
Producer Indicator.source
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STIX Field ThreatQ Field Mapping ThreatQ Name
Observable Indicator
Indicated TTP TTP
Kill_Chain_Phases Indicator.attribute Kill Chain Phase
Likely_Impact Indicator.attribute Likely Impact
Suggested_COAs Course of Action
Handling Indicator.tlp
Confidence Indicator.attribute Confidence
Indicator.attribute.source
Related Observables
Related_Indicators Indicator
Related_Campaigns Campaign
Signature
Signature.type ="Snort"
Signature.value
Indicator.source
Course of Action
Indicator.attribute Start Time
Indicator.attribute End Time
Indicator.published_at

Exploit Targets Mapping
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STIX Field ThreatQ Field Mapping ThreatQ Name
Title Exploit Target.value
ID Exploit Target.attribute | STIX Reference ID
Description Exploit Target.attribute | Description
Short Description Exploit Target.attribute | Short Description
Weakness Exploit Target.attribute | CWE ID
Weakness Exploit Target.attribute | Weakness Description
Configuration Exploit Target.attribute | CCE ID
Configuration Exploit Target.attribute | Configuration Description
Configuration Exploit Target.attribute | Configuration Short Description
Vulnerability Exploit Target.attribute | CVE ID
Potential_COAs Course of Action
Related_Exploit_Targets | Exploit Target

Observables Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
ID Indicator.attribute STIX Reference ID
Indicator.attribute Description
Indicator.type IP Address

Indicator.value

Indicator.type Filename
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STIX Field ThreatQ Field Mapping ThreatQ Name
Indicator.value
Indicator.type File Path
Indicator.value
Indicator.attribute File Size
Indicator.attribute File Format
Indicator.attribute Packer
Indicator.type MD5
Indicator.type SHA-256
Indicator.type SHA-1
Indicator.type SHA-512
Indicator.value
Indicator.type SSDEEP
Indicator.value
Indicator.type FQDN
Indicator.value
Indicator.type URL
Indicator.value
Indicator.type Email Subject
Indicator.value
Indicator.type Email Address
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STIX Field ThreatQ Field Mapping ThreatQ Name

Indicator.value

Indicator.type IP Address

Indicator.value

Indicator.type User-agent

Indicator.value

Indicator.type Filename

Indicator.value

Indicator.type Mutex

Indicator.value

Indicator.attribute Port
Indicator.attribute Protocol
Object.Description

Spearphish.value

Indicator.type Registry Key

Indicator.value

Indicator.attribute Hive

Campaigns Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name

Title Campaign.value
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STIX Field ThreatQ Field Mapping ThreatQ Name
ID Campaign.attribute STIX Reference ID
Description Campaign.attribute Description
Short Description Campaign.attribute Short Description
Timestamp Campaign.started_at
Names Campaign.attribute Alias
Status Campaign.attribute Status

Intended_Effect

Campaign.attribute

Intended Effect

Confidence Campaign.attribute Confidence
Activity Campaign.attribute Activity
Related TTPs TTP

Related Incidents Incident

Attribution Adversary

Associated_Campaigns Campaign

Courses of Action Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Course of Action.value
ID Course of Action.attribute STIX Reference ID
Description Course of Action.attribute Description
Stage Course of Action.attribute Stage
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STIX Field

Objective

ThreatQ Field Mapping

Course of Action.attribute

ThreatQ Name

Objective

Objective Confidence

Course of Action.attribute

Objective Confidence

Type Course of Action.attribute Type

Short Description Course of Action.attribute Short Description
Parameter_Observables Indicator

Impact Course of Action.attribute Impact

Cost Course of Action.attribute Cost

Efficacy Course of Action.attribute Efficacy

Related _COAs

Course of Action

Incidents Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Incident.value
ID Incident.attribute STIX Reference ID
Timestamp Incident.published_at
Description Incident.attribute Description
Categories Incident.attribute Category

First Malicious Action

Incident.attribute

First Malicious Action

Initial_Compromise

Incident.attribute

Initial Compromise

First_Data_EXxfiltration

Incident.attribute

First Data Exfiltration
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STIX Field

Incident_Discovery

ThreatQ Field Mapping

Incident.attribute

ThreatQ Name

Incident Discovery

Incident_Opened

Incident.attribute

Incident Opened

Incident_Opened

Incident.started at

Containment_Achieved

Incident.attribute

Containment Achieved

Restoration_Achieved

Incident.attribute

Restoration Achieved

Incident_Reported

Incident.attribute

Incident Reported

Incident_Closed

Incident.attribute

Incident Closed

Incident_Closed

Coordinator

Incident.attribute

Coordinator

Incident.attribute

Coordinator

Reporter Incident.attribute Reporter
Incident.attribute Reporter

Responder Incident.attribute Responder
Incident.attribute Responder

Victim Incident.attribute Victim
Incident.attribute Victim

Related Indicators Indicator

Related Observables Indicator

Leveraged_TTPs TTP

Intended_ Effect

Incident.attribute

Intended Effect
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STIX Field ThreatQ Field Mapping ThreatQ Name
COA_Requested Course of Action
COA_Taken Course of Action
Confidence Incident.attribute Confidence

Attributed_Threat_Actors Adversary

Discovery_Method Incident.attribute Discovery Method
Related_Incidents Incident
TTP Mapping
STIX Field ThreatQ Field Mapping ThreatQ Name

Title TTP.value

ID TTP.attribute STIX Reference ID

Description TTP.attribute Description

Handling TTP.ilp

Kill_Chain_Phases | TTP.attribute Kill Chain Phase

Intended_Effect TTP.attribute Intended Effect
TTP.attribute CAPEC ID

Behavior TTP.attribute Attack Pattern
TTP.attribute Attack Pattern Description
TTP.attribute Attack Pattern Short Description
TTP.attribute Malware Type
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STIX Field

ThreatQ Field Mapping

TTP.attribute

ThreatQ Name

Malware Name

TTP.attribute

Malware Description

TTP.attribute

Malware Short Description

TTP.attribute

Malware Detection Vendor

TTP.attribute

Malware Family

TTP.attribute

Exploit

TTP.attribute

Exploit Description

TTP.attribute Exploit Short Description
Exploit_Targets Exploit Target
Related TTPs TTP
Resources TTP.attribute Tool

TTP.attribute Tool

TTP.attribute Tool Type

TTP.attribute

Tool Description

TTP.attribute

Tool Short Description

TTP.attribute

Infrastructure Type

TTP.attribute

Infrastructure

TTP.attribute

Infrastructure Short Description

TTP.attribute

Infrastructure Description

Indicator
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STIX Field ThreatQ Field Mapping ThreatQ Name
TTP.attribute Persona
Victim Targeting TTP.attribute Victim Name
TTP.attribute Victim <CIQ Identity Name>
TTP.attribute Targeted Systems
TTP.attribute Targeted Information
Indicator

CIQ Identity Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Party Name Object.attribute Name
Organization Name Object.attribute Organization
Industry Sector Object.attribute Industry
Nationality Object.attribute Nationality
Languages Object.attribute Language
Address Object.attribute Country
Email Address Object.attribute E-Mail Address
Chat Handle Object.attribute Chat Handle
Phone Object.attribute Phone
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STIX 2.0 Data Mappings

You can click onthe = icon located to top-right of this topic to expand and collapse all map-

ping tables below.

Attack Patterns Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Attack Pattern.Published_at
description Attack Pattern.Attribute Description
external_references|] See External References
kill_chain_phases.[le See Kill Chain Table
modified Attack Pattern.Attribute Modified At
name Attack Pattern.Value
revoked (if revoked == true) | Attack Pattern.Attribute Revoked
labels Attack Pattern.Attribute Label

Threat Actors Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

aliases Adversary * The Adversary cre-
ated will have all

the same attributes
and published_at
as the base Attrib-
ute. All alias
Adversaries will be

inter-related
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Adversary.Published_At
goals Adversary.Attribute Goal
labels Adversary.Attribute Label
modified Adversary.Attribute Modified At
name Adversary.Value
primary_motivation Adversary.Attribute Primary Motivation
resource_level Adversary.Attribute Resource Level
roles Adversary.Attribute Role
secondary_motivation Adversary.Attribute Secondary Motiv-

ation

sophistication Adversary.Attribute Sophistication
revoked Adversary.Attribute

(if revoked == true)

Revoked

external_references|]

See External References

personal_motivations

Adversary.Attribute

Personal Motivation

Indicators Mappings

STIX 2.0 ThreatQ Field Map-

ThreatQ Name

Field ping
created Signature.Published_
at
description Signature.Description
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STIX 2.0 ThreatQ Field Map-

ThreatQ Name

Field ping

external_ref- | See External Refer-

erences[] ences

labels Signature.Attribute Label

modified Signature.Attribute Modified At

name Signature.Name ThreatQ will default to using Indicator Pattern

as the signature name if a name is not
provided.
pattern Signature.Value
Signature.Type Indicator Pattern

valid.from Signature.Attribute Valid From

valid.until Signature.Attribute Valid Until

revoked (if Signature.Attribute

revoked == Revoked

true)

kill_chain_

See Kill Chain Table
phases.[]
Identities Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

contact_information Identity.Contact_Information

created Identity.Published_at

ThreatQ User Guide, Version 4.30 257



THREA TQ n Threat Library

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
description Identity.Description
external_references|] See External References
identity_class Identity.Attribute Identity Class
modified Identity.Attribute Modified At
name Identity.Value
sectors Identity.Attribute Sector
labels Identity.Attribute Label
revoked (if revoked == true) Identity.Attribute Revoked

Observables Mapping

STIX 2.0 ThreatQ Field Map-

ThreatQ Name

Field ping

created Observable.Published

at

modified Observable.Attribute Modified At

revoked (if | Observable.Attribute
revoked == Revoked

true)

external_ref- | Observable.Attribute External Reference

erences See External References.
number_ Observable.Attribute

Number Observed
observed
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STIX 2.0 ThreatQ Field Map-

ThreatQ Name
Field ping

Specifies Cyber Observable Objects rep-

objects[] resenting this observation. See the tables

below for parsing details.

Artifact Mapping

STIX2.0 ThreatQ Field Map-

ThreatQ Name
Field ping

e: arti- Indicator.Type
typ yp URL
fact

mime_type | Indicator.Attribute MIME Type

url Indicator.Value

hashes{} Indicator.relationship

hashes Indicator.Type MD5 / SHA-1/SHA-256 / SHA-384 / SHA-
{}.key 512 / Fuzzy Hash
hashes

Indicator.Value
{}.value

Autonomous System Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: autonomous-system | Indicator.Type ASN
number Indicator.Value
name Indicator.Attribute Name
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

rir Indicator.Attribute Regional Internet Registry

Directory Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: directory Indicator.Type File Path
path Indicator.Value
path_enc Indicator.Attribute Path Encoding
created Indicator.Attribute Created At
accessed Indicator.Attribute Last Accessed
contains_refs Indicator.relationship

Domain-Name Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: domain-name Indicator.Type FQDN
value Indicator.Value
resolves_to_refs|] Indicator.relationship

Email Addr Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: email-addr Indicator.Type Email Address
display_name Indicator.Attribute Display Name
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STIX 2.0 Field

value

ThreatQ Field Mapping

Indicator.Value

ThreatQ Name

belongs_to_ref]]

Indicator.relationship

Email Message Mapping

STIX 2.0 Field

type: email-message

ThreatQ Field Mapping

Event.Type
Indicator.Type

ThreatQ Name

Spearphish
Email Subject

subject** Event.Title
Indicator.Value
is_multipart Indicator.Attribute Is Multipart
date (if parsing as an Event.happened_at
event)* Indicator.Attribute
sent date (if parsing as an
indicator)
content_type Indicator.Attribute Content Type
from_ref Event.Relationship
From
Indicator.Relationship
sender_ref Event.Relationship
_ . _ Sender
Indicator.Relationship
to_refs Event.Relationship T
o
Indicator.Relationship
cc_refs Event.Relationship CC
bcc_refs Event.Relationship BCC
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

Indicator.Relationship

received_lines Event.Attribute _ _
_ _ Received Lines
Indicator.Attribute

additional_header_fields | Event.Attribute Additional Header - {key}

Indicator.Attribute p

ﬂ An attrib-
ute is cre-
ated for
each
key-
value
pair of
the addi-
tional_
header_
fields
object.

body Event.Attribute

Body
Indicator.Attribute

body_multipart[].body_ Indicator _
Filename

raw_ref***

raw_email_ref Event.Relationship

Indicator.Relationship

* To parse an event from an email message, the email must have a dateand subject
field.

** To parse an indicator from an email message, the email must contain a subject
field.

***If an objectin body_multipart has a body field (body_multipart[].body), an attribute
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STIX 2.0 Field

ThreatQ Field Mapping

ThreatQ Name

is created. The attribute's name is "Body Multipart" and the attribute's value is in the

format "Content Type: {body_multipart[].content_type}, Content Disposition: {body__

multipart]].content_disposition}, Body: {body_multipart[].body}".

Note: Parsing both an indicator and event from an email message will relate the two

objects .
File Mapping
STIX 2.0 Field fhreatQ !:ield MEP  hreataiName
ping

type: file Indicator.Type Filename

size Indicator.Attribute File Size

hashes{}

hashes{}.key Indicator.Type MD5S / SHA-1 / SHA-

256 / SHA-384 /
SHA-512 / Fuzzy
Hash

hashes{}.value

Indicator.Value

name

Indicator.Value

name_enc

Indicator.Attribute

File Name Encoding

magic_number_hex

Indicator.Attribute

Magic Number Hex

mime_type

Indicator.Attribute

MIME Type

created

Indicator.Attribute

Created At
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. ThreatQ Field Map-
STIX 2.0 Field . ThreatQ Name
ping
accessed Indicator.Attribute Last Accessed
parent_directory_ref Indicator.Relationship
is_encrypted Indicator.Attribute Encrypted
encryption_algorithm Indicator.Attribute Encryption Algorithm

decryption_key

Indicator.Attribute

Decryption Key

contains_refs[]

Indicator.Relationship

content_ref

Indicator.Relationship

extensions.archive-ext.contains_

refs|]

Indicator.Relationship

extensions.archive-ext.version

Indicator.Attribute

Archive Version

extensions.archive-ext.comment

Indicator.Attribute

Archive File Com-

ment

extensions.ntfs-ext.sid

Indicator.Attribute

Security ID

extensions.ntfs-ext.alternate

data_streams[].hashes{}

extensions.ntfs-ext.alternate

data_streams[].hashes{}.key

Indicator.Type

MD5 / SHA-1/ SHA-
256 / SHA-384 /
SHA-512 / Fuzzy
Hash

extensions.ntfs-ext.alternate

data_streams[].hashes{}.value

Indicator.Value
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STIX 2.0 Field

ThreatQ Field Map-
ping

ThreatQ Name

extensions.ntfs-ext.alternate

data_streams[].name

Indicator.Attribute

Alternate Data

Stream Name

extensions.ntfs-ext.alternate

data_streams|].size

Indicator.Attribute

Alternate Data

Stream Size

extensions.pdf-ext.version

Indicator.Attribute

PDF Specification

Version

extensions.pdf-ext.is_optimized

Indicator.Attribute

PDF Is Optimized

extensions.pdf-ext.document_

info_dict{}.key/value

Indicator.Attribute

Formatted as: 'PDF
{key title()}'

extensions.pdf-ext.pdfid0

Indicator.Attribute

PDF First File Iden-

tifier

extensions.pdf-ext.pdfid1

Indicator.Attribute

PDF Second File

Identifier

extensions.raster-image-ext.im- | Indicator.Attribute Image Height
age_height
extensions.raster-image-ext.im- | Indicator.Attribute Image Width

age_width

extensions.raster-image-ext.bits_

per_pixel

Indicator.Attribute

Image Bits Per Pixel

extensions.raster-image-ext.im-

age_compression_algorithm

Indicator.Attribute

Image Compression

Algorithm

extensions.raster-image-ext.exif_

tags{}.key/value

Indicator.Attribute

Formatted as: 'Image
EXIF {key.title()}
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STIX 2.0 Field

ThreatQ Field Map-

ping

ThreatQ Name

extensions.windows-pebinary-

ext.pe_type

Indicator.Attribute

Executable Extension

Type

extensions.windows-pebinary-

ext.imphash

Indicator.Attribute

Executable Imphash

extensions.windows-pebinary-

ext.machine_hex

Indicator.Attribute

Target Machine Hex

extensions.windows-pebinary-

ext.number_of sections

Indicator.Attribute

PE Binary Section

Count

extensions.windows-pebinary-

ext.time_date_stamp

Indicator.Attribute

PE Binary Created
Date

extensions.windows-pebinary-

ext.pointer_to_symbol_table_hex

Indicator.Attribute

Symbol Table Hex
Offset

extensions.windows-pebinary-

ext.number_of_symbols

Indicator.Attribute

PE Binary Symbol
Table Size

extensions.windows-pebinary-

ext.size_of _optional_header

Indicator.Attribute

PE Binary Optional

Header Size

extensions.windows-pebinary-

ext.characteristics_hex

Indicator.Attribute

PE Binary Char-

acteristics Hex

extensions.windows-pebinary-

ext.file_header_hashes{}

extensions.windows-pebinary-

ext.file_header_hashes{}.key

Indicator.Type

MD5 / SHA-1/ SHA-
256 / SHA-384 /
SHA-512 / Fuzzy
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STIX 2.0 Field

ThreatQ Field Map-
ping

ThreatQ Name

Hash

extensions.windows-pebinary-

ext.file_header_hashes{}.value

Indicator.Value

extensions.windows-pebinary-

ext.optional_header.magic_hex

Indicator.Attribute

PE Binary Magic Hex

extensions.windows-pebinary-
ext.optional_header.major_

linker_version

Indicator.Attribute

PE Binary Major

Linker Version

extensions.windows-pebinary-
ext.optional_header.minor_

linker_version

Indicator.Attribute

PE Binary Minor

Linker Version

extensions.windows-pebinary-
ext.optional_header.size_of

code

Indicator.Attribute

PE Binary Code Size

extensions.windows-pebinary-
ext.optional_header.size_of_ini-

tialized _data

Indicator.Attribute

PE Binary Initialized

Data Size

extensions.windows-pebinary-
ext.optional_header.size_of

uninitialized_data

Indicator.Attribute

PE Binary Unini-

tialized Data Size

extensions.windows-pebinary-

Indicator.Attribute

PE Binary Memory

ext.optional_header.address_of Address Entry Point
entry_point
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STIX 2.0 Field

ThreatQ Field Map-

ping

ThreatQ Name

extensions.windows-pebinary-
ext.optional_header.base_of

code

Indicator.Attribute

PE Binary Base
Code Memory
Address

extensions.windows-pebinary-
ext.optional_header.base_of

data

Indicator.Attribute

PE Binary Base Data
Memory Address

extensions.windows-pebinary-

ext.optional_header.image_base

Indicator.Attribute

PE Binary Base
Image Memory
Address

extensions.windows-pebinary-
ext.optional_header.section_

alignment

Indicator.Attribute

PE Binary Section
Alignment Bytes

extensions.windows-pebinary-
ext.optional_header file_align-

ment

Indicator.Attribute

PE Binary Image File
Alignment Bytes

extensions.windows-pebinary-
ext.optional_header.major_os_

version

Indicator.Attribute

Windows OS Major

Version

extensions.windows-pebinary-
ext.optional_header.minor_os_

version

Indicator.Attribute

Windows OS Minor

Version

extensions.windows-pebinary-
ext.optional_header.major_

image_version

Indicator.Attribute

Image Major Version
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STIX 2.0 Field

ThreatQ Field Map-
ping

ThreatQ Name

extensions.windows-pebinary-
ext.optional_header.minor_

image_version

Indicator.Attribute

Image Minor Version

extensions.windows-pebinary-
ext.optional_header.major_sub-

system_version

Indicator.Attribute

Subsystem Major Ver-

sion

extensions.windows-pebinary-
ext.optional_header.minor_sub-

system_version

Indicator.Attribute

Subsystem Minor Ver-

sion

extensions.windows-pebinary-
ext.optional_header.win32_ver-

sion_value_hex

Indicator.Attribute

Win32 Version Hex

extensions.windows-pebinary-
ext.optional_header.size_of

image

Indicator.Attribute

Image Byte Size

extensions.windows-pebinary-
ext.optional_header.size_of

headers

Indicator.Attribute

PE Binary Combined

Header Size

extensions.windows-pebinary-
ext.optional_header.checksum_

hex

Indicator.Attribute

PE Binary Checksum

Hex

extensions.windows-pebinary-
ext.optional_header.subsystem_

hex

Indicator.Attribute

PE Binary Required

Subsystem Hex
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. ThreatQ Field Map-
STIX 2.0 Field . ThreatQ Name
ping
extensions.windows-pebinary- Indicator.Attribute DLL Characteristics
ext.optional_header.dll_char- Hex

acteristics_hex

extensions.windows-pebinary- Indicator.Attribute Reserved Stack Size
ext.optional_header.size_of

stack_reserve

extensions.windows-pebinary- Indicator.Attribute Stack Commit Size
ext.optional_header.size_of

stack_commit

extensions.windows-pebinary- Indicator.Attribute Heap Space Reserve
ext.optional_header.size_of Size

heap_reserve

extensions.windows-pebinary- Indicator.Attribute Heap Space Commit
ext.optional_header.size_of Size

heap_commit

extensions.windows-pebinary- Indicator.Attribute Loader Flags Hex

ext.optional_header.loader_

flags_hex
extensions.windows-pebinary- Indicator.Attribute Number of RVA and
ext.optional_header.number_of Sizes

rva_and_sizes

extensions.windows-pebinary-

ext.optional_header.hashes{}

extensions.windows-pebinary- Indicator.Type MD5 / SHA-1 / SHA-
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STIX 2.0 Field

ThreatQ Field Map-

ping

ThreatQ Name

ext.optional_header.hashes{}.key

256 / SHA-384 /
SHA-512 / Fuzzy
Hash

extensions.windows-pebinary-
ext.optional_header.hashes

{}.value

Indicator.Value

extensions.windows-pebinary-

ext.sections[].hashes{}

extensions.windows-pebinary-

ext.sections[].hashes{}.key

Indicator.Type

MD5 / SHA-1/ SHA-
256 / SHA-384 /
SHA-512 / Fuzzy
Hash

extensions.windows-pebinary-

ext.sections[].hashes{}.value

Indicator.Value

extensions.windows-pebinary-

ext.sections[].name

Indicator.Attribute

PE Binary Section

Name

extensions.windows-pebinary-

ext.sections[].size

Indicator.Attribute

PE Binary Section

Size

extensions.windows-pebinary-

ext.sections[].entropy

Indicator.Attribute

PE Binary Section
Entropy

IPv4 Mapping
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STIX2.0 ThreatQ Field Map-

ThreatQ Name

Field ping
type: Indicator.Type CIDR Block (if value contains a / and does
ipv4-addr not end with /32)

IP Address (if the value ends with /32, the /32

is omitted and reported as an IP Address)

value Indicator.Value

resolves_ | Indicator.Relationship

to_refs[]
belongs_
to. refs[ Indicator.Relationship
IPv6 Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: ipv6-addr Indicator.Type IPv6 Address
value Indicator.Value
resolves_to_refs|] Indicator.Relationship
belongs_to_refs|] Indicator.Relationship
MAC Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: mac-addr Indicator.Type MAC Address
value Indicator.Value
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Mutex Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: mutex Indicator.Type Mutex
name Indicator.Value
URL Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: url Indicator.Type URL
value Indicator.Value

User Account Mapping

ThreatQ Field Map-

STIX 2.0 Field _ ThreatQ Name
ping
type: user-account Indicator.Type Username
user_id Indicator.Attribute UserID
account_login Indicator.Value
account_type Indicator.Attribute Account Type
display_name Indicator.Attribute Display Name
is_service_account Indicator.Attribute Is Service Account
is_privileged Indicator.Attribute Is Privileged Account
can_escalate_privs Indicator.Attribute Can Escalate Priv-
ileges

is_disabled Indicator.Attribute Is Disabled
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. ThreatQ Field Map-
STIX 2.0 Field . ThreatQ Name
Ping
account_created Indicator.Attribute Account Created
account_expires Indicator.Attribute Account Expires
password_last_changed Indicator.Attribute Password Last
Changed
account_first_login Indicator.Attribute Account First Login
account_last_login Indicator.Attribute Account Last Login
extensions.unix-account-ext.gid Indicator.Attribute Account Group ID
extensions.unix-account-ext.- Indicator.Attribute
Account Group
groups(]
extensions.unix-account- Indicator.Attribute Account Home Dir-
ext.home_dir ectory
_ _ _ _ Account Command
extensions.unix-account-ext.shell | Indicator.Attribute Shell
e

Windows Registry Key Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: windows-registry-key Indicator.Type Registry Key
key Indicator.Value
values[].name Indicator.Attribute Registry Name
modified Indicator.Attribute Registry Modified At
creator_user_ref Indicator.Relationship
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Campaigns Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
aliases Campaign
created Campaign.Published_at
description Campaign.Description
first_seen Campaign.Started_at
last_seen Campaign.Ended_at
modified Campaign.Attribute Modified At
name Campaign.Value
objective Campaign.Objective
revoked (if revoked == true) Campaign.Attribute Revoked
external_references|] See External References
labels Campaign.Attribute Label

Courses of Action Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Course of Action.Published_at
modified Course of Action.Attribute Modified At
name Course of Action.Value
description Course of Action.Description
action
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
revoked (if revoked == true) Course of Action.Attribute Revoked
external_references|] See External References
labels Course of Action.Attribute Label

Intrusion Sets Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
aliases Intrusion Set
created Intrusion Set.Published_at
description Intrusion Set.Description
first_seen
goals Intrusion Set.Attribute Goal
modified Intrusion Set.Attribute Modified At
name Intrusion Set.Value
primary_motivation Intrusion Set.Attribute Primary Motivation
resource_level Intrusion Set.Attribute Resource Level
secondary_motivations Intrusion Set.Attribute Secondary Motivation
external_references|] See External References
revoked (if revoked == true) Intrusion Set.Attribute Revoked

Malware Mapping
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Malware.Published_at
description Malware.Description

kill_chain_phases.[]

See Kill Chain Table

labels Malware.Attribute Label
modified Malware.Attribute Modified At
name Malware.Value

external_references|] See External References

revoked (if revoked == true) Malware.Attribute Revoked

Tools Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Tool.Published_at
modified Tool.Attribute Modified At
labels Tool.Attribute Label
name Tool.Value
revoked (if revoked == true) Tool Attribute Revoked
external_references|] See External References
description Tool.Description
kill_chain_phases.[] See Kill Chain Table
tool_version Tool.Attribute Tool Version
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Reports Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Report.Published_at
modified Report.Attribute Modified At
name Report.Value
description Report.Description
labels Report.Attribute Label
object_refs Report.Relationship.Link
external_references|] See External References
revoked (if revoked == true) Report.Attribute Revoked

Sightings Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
count Event.Attribute Count
created Event.published_at
first_seen Event.happened_at
last_seen Event.Attribute Last Seen
observed_data_refs Event.relationship.link
sighting_of_ref Event.relationship.link
where_sighted_refs Event.relationship.link
revoked (if revoked == true) Object.attribute Revoked
Event.name STIX Sighting
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
Event.type Sighting
external_references|] See External References
modified Event.Attribute Modified

External References

_ ThreatQ Field Map-
STIX 2.0 Field _ ThreatQ Name
ping

Object.external_references|].source_name | Object.Attribute External Refer-
ence*

Object.external_references[l.external_id Object.Attribute External Refer-
ence*

Object.external_references[].description Object Attribute External Refer-
ence*

Object.external_references[].url Object.Attribute External Refer-
ence*

* Formatted as: {source_name} ({external_id}): {description} - {url}

Kill Chain Phrases

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
kill_chain_phases][].kill_chain_name Object Attribute Kill Chain Name
kill_chain_phases[].phase_name Object Attribute Kill Chain Phrase
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Parsing a STIX File for Indicators

ThreatQ allows you to upload a STIX file orinsert STIX data to parse. for indicators.

To parse a STIX file for indicators:

1.

Click on the Create button, located at the top of the dashboard and select STIX

Parser under the Importheading.

The Parse For Intelligence dialog box will load.

Do one of the following:
« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

Select or clear the Normalize URL Indicators check box. See Indicator URL

Normalization for more information.

Click Next Step.
Enter an optional Name.

Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

Select any optional Attributes to be applied.

Optionally, enter a comment.

Optionally, use the Add relationships search field to add object relationships.

. Optionally, add any desired Tags.

G‘L If at any point, you wish to abandon the import, click Cancel.
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11. Click Apply.

New objects will become available in the Threat Library.

Object Details Page

You can click on an object within the ThreatQ application to access its details page. The
Object Details page provides you with an in-depth look at an individual object. You can
enter comments for others to view, link related objects, and view an audit log of all activity

associated with the object.

Specific objects, such as Indicators, will display additional information such as the indic-

ator's status, score, and expiration data.
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example.com e 1 STATUS:  Actwe

INDICATOR: FOOM

Created: 03/08/201%  First Seen: D208/2019 06:02pm  Expires: add cace ~ () A -
i |
(@) context @ Attributes 7 o
£ Autributes 7 19
B Sources (3] 19 . E Sources 3 3
@ gz 19
B Descrigtion (1] 19
(_@ Relationships ! G Tags 9
0 Adversaries 2) 19
®Fey 19
1 [Z Description 10 o
@ ndcsos 15 (19
@ s 19
£ comments (1} (19 ) Adversaries 11 .
ﬁ Operatiens 1’9
Files 12 # Link
[ Audicrog 19
@ Indicators 13 o -
® Tasks 14 © Croate .
{2 Comments 15 .
2& Operations 16
B Audit Log 17
=

ltems marked with an * in the Object Details Legend indicate an option
only available to specific object types.

Object Details Page Legend

Header Section

Number Field Description Reference
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Object Details Page Legend

1 Edit Object Link | The Edit link allows you to edit « Editing Adversaries
specific details about an object. . Editing Events
Edit fields will differ based on the
« Editing Files
type of object.
- Editing Indicators
2 Score Selection* | The Score Selection dropdown » Overriding the Scoring
Applies to Indicator | allows you to override an indic- Algorithm with a Manual Score
Object TypesOnly | ator's score set by the scoring
algorithm.
3 Scoring Influence* | You can click on the icon to » Configure Indicator Scoring
App'/ies toIndicator | review the criteria utilized by the . Building a Scoring Algorithm
Object Types Only | gpplication's scoring algorithm to
generate the Indicator's score.
4 Status* The Status dropdown menu « Indicator Status
Applies to Indicator | gllows you to manually set the
Object Types Only | statys of an indicator. Default
statuses include: Active,
Expired, Indirect, Review, and
Whitelisted.
5 Add to Watchlist | The Watchlist toggle button « Configuring the Watchlist
allows you to add and remove
the object from the Watchlist wid-
get.
6 Expiration*® The Expire link allows you to set « Indicator Expiration
App'/ies tondicator | an expiration date for the indic- « Automatic Expiration and
Object Types Only | ator, protect from auto-expiration Policies
policies, and remove an existing
set expiration date.
Details Section
Number Pane Description Reference
7 Attributes The Attributes pane displays « Attributes Pane
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Object Details Page Legend

attributes associated with the
object. You can Add, Edit, and
Delete attributes found in this

section.

8 Sources

The Sources pane displays
sources associated with the
object. You can Add additional

sources to an object.

Adding a Source to an Object

9 Tags

The Tags pane displays tags
associated with the object. You
can Add and Delete tags found in

this section.

Managing Tags

10 Description

The Description pane allows you
to add general information about

the object.

Description Pane

11 Adversaries

The Adversaries pane displays
adversaries associated with the

object.

Adversaries Pane

12 Files

The Files pane displays files

associated with the object.

Files Pane

13 Indicators

The Indicators pane displays
indicators associated with the

object.

Indicators Pane

14 Tasks

The Tasks pane displays tasks

associated with the object.

Tasks Pane

10 Related Objects

There are several different related
panes depending on the types of

objects linked to the object.

You can use these panes to view

and add/remove linked indicators,

Relationships Panes
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Object Details Page Legend

files, signatures, events, adversar-

ies, tasks, and investigations.

15 Comments The Comments pane allows you « Comments Pane

to record comments about the
object for other users to read and

reference.

16 Operations The Operations pane allows you to o Operations Overview

associate third-party attributes and « ThreatQ Operations Devel-

related indicators to the indicator.

opment Guide

Note: This options requires the
installation of Operations. See the
Operations Overview topic for
more details.

17 Audit Log The Audit Log panel displays all « Common Enrichment and
actions and changes made to an Audit Log Questions
Object.

Number Field Description Reference
18 Action Menu The Actions menu allows you to « Actions Menu

execute the following actions for

an object:

« Adda New Attribute
« Add a New Comment
« CreateaTask

« Generate a Report

« Add a Relationship

« Adda Source

« Delete Object

19 Details Navigation | This allows you to jump to a par- | N/A
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Object Details Page Legend

Tabs ticular pane on the Object Details

page.

Actions Menu

The Action Menu, located on the left-hand of the Object Details page, allows users to quickly

execute system object processes.
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G Context
{

@ Add Attribute
2 Add Comment
¢ Add Relationship

& Add Source

© Create Task

Generate PDF

| ] Delete Indicator

Actions Include:
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Action

Add Attrib-

ute

Function

Brings up the Add Details dialog box to add an

attribute to the object.

Reference

Adding an
Attribute to

an Object

Add Com-

ment

Creates a new text box entry in the comment

pane.

Adding Com-
ments

Add Rela-

tionship

Brings up the Add Relationships dialog box to link

other system objects to the object.

Linking
Adversaries
Linking
Events
Linking Files
Linking Indic-

ators
Linking Sig-
natures
Linking
Tasks

Add Source

Brings up the Add Details dialog box to add a

source to the object.

« Adding a
Source to

an Object

Create Task

Opens up the Add Task dialog box.

Assigning a
Task

Generate

Report

Generates a PDF report of the object.

Generating
Reports

Delete
Object

Delete the system object.

N/A
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Context Panes

The Context section of the object details page displays attributes, sources, and tags asso-

ciated with the system object.
Related Topics:

Attributes Pane

Adding a Source to an Object

Managing Tags

Description Pane

Attributes Pane

The Attributes Pane displays any attributes associated with the system object. You can
review attribute details as well as add and remove attributes from this pane.

@ Attributes (2) © pdd

O ATTRIBUTETYPE = ATTRIBUTE VALUE = SOURCES DATE CREATED -

- abusa.£h Foodo Trackes Bstnet 02 1P Bloc o

O  Destination Fort 3 b 05/05/2019 0311 prm
kit
abusa.£h Faodo Trackir Batnit C2 1P Bloc

O Malware Type Kt 05520159 031 1pm

Related Topics:

o Adding an Attribute to an Object

o Deleting an Attribute

« Deleting an Attribute Source

Adding an Attribute to an Object

You can link adversaries to a system object.
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To add an attribute:

1. Locate the Attributes pane on the object details page.

2. Click on the + Add Details link located to the top-right.
The Add Details dialog box opens with the Add Attributes tab selected by default.

Add Details

Add Source

3. Select an Attribute Type from the Attributes dropdown or enter a new type.
4. Select an existing Attribute Value from the dropdown or enter a new value.

5. Select a Sourcefrom the dropdown or enter a new source.

ﬂ You can select the + icon to add additional attributes.

6. Select Add Attributes.

Deleting an Attribute

You can delete an attribute from the object details page.

To delete an attribute:

ThreatQ User Guide, Version 4.30 290



THREA TQH Threat Library

1. Locate the Attributes pane on the object details page.

2. Select the checkbox next to the attribute to delete.

ﬂ You can select more than one attribute to delete

3. Select Delete.

The confirmation dialog box opens.

Are You Sure?

Deleting the selected attributes can not be undone.

Delete Attributes | Cancel \

4. Select Delete Attributes.
Deleting an Attribute Source
You can delete an attribute's source from the object details page.
To delete an attribute source:

1. Locate the Attributes pane on the object details page.
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2. Selectthe X next to the attribute's source.

The confirmation dialog box opens.

Are You Sure?

Deleting this attribute source can not be undone

Delete Attribute Source

3. Select Delete Attribute Source.

Adding a Source to an Object
You can add sources to a system object in its details pane.
To add a source:

1. Locate the Sources pane on the object details page.

2. Click on the + Add link located to the top-right.
The Add Details dialog box opens with the Add Source tab selected by default.

Add Details
Add Attributes Add Source

Add new source
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3. Select a Source from the dropdown provided.

-

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source

in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Selact a source

Status

| N

4. Select Add Sources.

Managing Tags
You can add and remove tags in the Tags pane on the object details page.

To add a tag:

1. Locate the Tags pane on the object details page.
2. Selectthe Tags text field and enter the tag.

3. Press [Enter] or [Return].

ﬂ Repeat steps 2-3 to add additional tags.

To delete a tag:

1. Locate the Details pane on the object details page.

2. Select the X next to the tag to delete.
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Description Pane

The Description Pane section of the object details page allows you to add a description for

the system object.
To update the Description pane:

1. Locate the Description pane on the object details page.
2. Select Edit.

3. Make the required changes and select Save.

Relationships Panes

The Relationship section of the object details page displays other system objects that have

been related to the current object.

You can link/unlink system objects from relationship panes and perform bulk updates
(related indicators pane only). You can click on a related object to navigate to its object

details page.

Relationships panes will only appear if a system object is already related
to the object. Use the Actions button to relate the initial object: Actions >
Add Relationship.

Related Topics:

« Indicators Pane

« Adversaries Pane

» Files Pane

o Investigations Pane

o Signatures Pane

« Events Pane
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Adversaries Pane

The Adversaries Pane allows you to link and unlink adversary to an object. You can also
add comments and adjust the adversary's confidence level. You can click on the Show in
Threat Library link to view the related adversaries in the Threat Library or on a specific
adversary nhame to open its object details page.

o Adversaries (1) # Show in Threat Library & Link

Confidence

© 4dd Comment

Praview

"l

The Adversary pane will only load if there is an existing adversary linked
to the object. Click on the Action Menu and select Add Relationship to
add the first adversary.

Related Topics:

o Linking Adversaries

o Configuring Confidence Level

« Commenting on Related Adversaries

« Unlinking Related Adversaries

Linking Adversaries
You can link adversaries to a system object.

To link an adversary:
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1. Locate the Adversaries pane on the object details page.

"1

The Adversary pane will only load if there is an existing adversary
linked to the object. Click on the Action Menu and select Add Rela-
tionship to add the first adversary.

2 Selectthe ¢ Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships
(l\_‘:‘

3. Use the supplied text field to select a file.

ﬂ Repeat Step 3 to select multiple adversaries.

4. Click Add.
Configuring Confidence Level
You can configure a related adversary's confidence level from the Adversaries pane.

To configure the confidence level of a related adversary:

1. Locate the Adversaries pane on the object details page.

2. Click the dropdown arrow to the right of the adversary, and slide the scale to the
desired confidence level.
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0 Adversaries (1) il Showin Threat Library & Link

O @ adversary

Confidence

© Add Comment

G\ The confidence level can be setto 0, 25, 50, 75, and 100. ]

The displayed confidence level will be modified to reflect your selection.

Commenting on Related Adversaries
You can add, edit, and remove comments to related adversaries.
To add a comment to a related adversary:

1. Locate the Adversaries pane on the object details page.

2. Select Add a Comment.

The Comments text field opens.

e Adversaries {1} i) Show in Threat Library & Link

25%" ~

Confidence

ar

3. Enter a comment.

4. Click Add Comment.

To edit a related adversary comment:
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1. Locate the Related Adversaries pane on the object details page.
2. Select Edit under the comment to update.

3. Update the comment.
4

. Click Save Changes.
To delete arelated adversary comment:

1. Locate the Related Adversaries pane on the object details page.

2. Select Delete under the comment to update.

A confirmation dialog box opens.

Are You Sure?

Deleting this comment can not be undone.

Delete Comment Cancel

3. Select Delete Comment.

Unlinking Related Adversaries
You can unlink related adversaries for an object.
To unlink related adversaries:

1. Locate the Adversaries pane on the object details page.
2. Select the checkbox(es) next to the adversary(ies) to unlink.

3. Select the i unink icon.
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Indicators Pane

The Indicators Pane allows users to link and unlink indicators to an object as well as perform

a bulk update to selected linked indicators.

Indicators (2) @ Show in Threat Library & Link

(] VALUE = SCORE STATUS = REFORTED = TYPE =

o @ 10 Review 024/3019 031 1pm P Address

- ] 0 Antive DAZ5E0E 0311 pm 1# Address
P

"l

The Indicators pane will only load if there is an existing indicator linked to
the object. Click on the Action Menu and select Add Relationship to add
the first indicator.

Related Topics:

o Linking Indicators

o Performing Bulk Updates to Related Indicators

« Unlinking Related Indicators

Linking Indicators
You can link indicators to a system object.
To link an indicator:

1. Locate the Indicators pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select an indicator.

ﬂ Repeat Step 3 to select multiple indicators.

4. Click Add.

Performing Bulk Updates to Related Indicators
You can perform bulk updates to linked indicators listed in the Indicators pane of an object.
To perform a bulk update:

1. Locate the Indicators pane on the object details page.

2. Select the checkbox(es) next to the indicator(s) to update.
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3. Select the # Bulkupdate jcon.

Bulk Update Tool Your changes will affect 2 Indicators

Prowide an additional source

Apply Attributes

Extend Date

The Bulk Update form loads.

4. Select the desired changes and click Apply Changes.

Unlinking Related Indicators
You can unlink related indicators for an object.
To unlink related indicators:

1. Locate the Indicators pane on the object details page.
2. Select the checkbox(es) next to the indicators to unlink.

3. Select the i unink icon.
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Files Pane

The Files Pane allows you to link and unlink files to an object.

%

Files (1) @ Shawin Threat Library

0 TITLE 2 SOURCES DATE ADDED =

o @ % Threat Quatient 03/12/2019 07:27am

You can view a quick summary of the file by clicking the on the eye icon to the left of the file
name or click on the name itself to navigate to its object details page. You can click on the

Show in Threat Library link to view the related events in the Threat Library or download a
copy of the file by clicking on the + icon .

The Files pane will only load if there is an existing file linked to the object.
Click on the Action Menu and select Add Relationship to add the first file.

Related Topics:

« Linking Files
« Unlinking Related Files

Linking Files
You can link Files to a system object.
Tolink afile:

1. Locate the Files pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple files.

4. Click Add.

Unlinking Related Files
You can unlink related files for an object.
To unlink related files:

1. Locate the Files pane on the object details page.
2. Select the checkbox(es) next to the files to unlink.

3. Select the i unirk icon.
Signatures Pane

The Signatures Pane allows you to link and unlink signature to an object. You can click on

the Show in Threat Library link to view the related signatures in the Threat Library or on a
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specific signature name to open its object details page.

0 Slgnatl.lres (1) iR Show in Threat Library & Link

[m] NAME = TYPE = DATE CREATED

o @ W i " B ONS traf tpct £45F snort 05N 2015031 Tpm

"1

The Signatures pane will only load if there is an existing signature linked
to the object. Click on the Action Menu and select Add Relationship to
add the first signature.

Related Topics:

« Linking Signatures

o Unlinking Related Signatures

Linking Signatures
You can link Signatures to a system object.
Tolink afile:

1. Locate the Signatures pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

{ ﬂ Repeat Step 3 to select multiple signatures.

4. Click Add.

Unlinking Related Signatures
You can unlink related signatures for an object.
To unlink related indicators:

1. Locate the Signatures pane on the object details page.
2. Select the checkbox(es) next to the signatures to unlink.

3. Select the # unink icon.

Investigations Pane

. L . .
{ Q ThreatQ Investigations requires a separate license.
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The Related Investigations pane displays any ThreatQ Investigation related to the object.
Adding and removing an object to an investigation is controlled through the Investigations

interface.
You can click on the investigation to open ThreatQ Investigations.
Events Pane

The Events Pane allows you to link and unlink events to a system object. You can click on
the Show in Threat Library link to view the related events in the Threat Library or on a spe-

cific event name to open its object details page.
9 Events (1) @ Show in Theeat Library & Link

[m] NAME = QCCURRED = TWPE =

(] @ 044172019 10-38am DS Attack

The Events pane will only load if there is an existing adversary linked to
the object. Click on the Action Menu and select Add Relationship to add
the first event.

Related Topics:

o Linking Events

o Unlinking Related Events

Linking Events
You can link events to a system object.
Tolink an event:

1. Locate the Events pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple events.

4. Click Add.

Unlinking Related Events
You can unlink related events for an object.
To unlink related events:

1. Locate the Events pane on the object details page.
2. Select the checkbox(es) next to the event(s) to unlink.

3. Select = unink icon.
Tasks Pane

The Tasks Pane allows you to create, link, unlink, and delete tasks associated with an
object. You can click on the Show in Threat Library link to view the related tasks in the

Threat Library or on a specific task name to open its object details page. You can also view
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a quick summary of the task by clicking the on the eye icon to the left of the task name.
@ Tasks (1) B Showin Theeat Library © Create & Link

[m] i NAME = ASSIGNED TO STATUS = PRICRITY =

O = & wvestigate th Daveid Klees To Da Mediurmn

"1

The Tasks pane will only load if there is an existing task linked to the
object. Click on the Action Menu and select Create Task to add the first
task.

Related Topics:

« Linking Tasks

« Unlinking Related Tasks

« Deleting Related Tasks

Linking Tasks

You can link Tasks to a system object from its object details page.

ﬁ You can also related a task to a system object while creating a task.

To link a task:

1. Locate the Tasks pane on the object details page.
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2 Selectthe ¢ Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple files.

4. Click Add.

Unlinking Related Tasks
You can unlink related tasks for an object.
To unlink related tasks:

1. Locate the Tasks pane on the object details page.
2. Select the checkbox(es) next to the files to unlink.

3. Select the # unink icon.
Deleting Related Tasks

You can delete Tasks related to a system object from its object details page.

To delete a task:
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1. Locate the Tasks pane on the object details page.
2. Select the checkbox next to the task to delete.

3. Selectthe @ oelete icon.

A confirmation dialog box opens.

Are You Sure?

Deleting this task can not be undone.

Delete Task Cancel

4. Select Delete Task.

Comments Pane

The Comments pane allows users to record comments about the system object for other

users to see.
The following functions can be performed:

o Adding Comments

o Editing Comments

o Deleting Comments

Adding Comments

ﬂ Users can also click on the Actions menu and select the Comment option.

From the Object Details page:
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1. Click on the expand icon [Zl to expand the Comments pane.

2. Click on the Add Comment link located at the top-right and lower-left of the pane.

The new comment text box opens.

E COMMENTS

David Klees (10/15/2018 06:45pm)
Suspicious Activity from IP

edit delate

David Klees (10/15/2018 06:46pm)

DDoS-related attack possible

edit delete

3. Enter a comment.

4. Click on the Add Comment button.

Editing Comments

From the Object Details page:
1. Click on the expand icon [£l to expand the Comments pane.

2. Click on the Edit link located beneath the comment to update.

The edit comment text box opens.

E COMMENTS + Add Comment

David Klees (10/15/2018 06:45pm) Hide

Suspicious Activity from IP

David Klees (10/15/2018 06:46pm) Hide
DDoS-related attack possible
adit  delate

Add a Comment
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3. Editthe comment.

4. Click on the Save Changes button.
Deleting Comments

From the Object Details page:
1. Click on the expand icon &l to expand the Comments pane.

2. Click on the Edit link located beneath the comment to update..

The delete confirmation dialog text box opens.

ARE YOU SURE?

Once deleted this comment can not be recovered

Delete Comment Cancel

3. Click on the Delete Comment button.
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Analytics

The Analytics tab provides a summary view of Adversary, Event, File, Indicator, and Sig-

nature Object Types.

"l

Search filters are not available for these views nor can you modify the
types of columns used. Use the Advanced Search to utilize these options.

Analytics pages include:

Adversaries Overview

Events Overview

Files Overview

Indicators Overview

Signatures Overview

Adversaries Overview

The Adversaries page provides an overview of all the adversaries within ThreatQ as well as

overlapping use of specific indicators.
There are three sections:

o Adversaries Summary Table

o Adversaries Overlap Table.

« Indicator Distribution Pie Chart

Adversaries Summary Table

The Adversaries Summary table lists adversaries by name, number of indicators, date cre-

ated, and the most recent event date associated with the adversary.
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ADVERSARIES

Showing 1 to 10 of 92 Row count: 10 *
ADVERSARY NAME = MLUMEER OF INDICATORS % DATE CREATED & MOET RECEMNT EVENT DATE @
Adversary Bravo 03/1872019 01:05pm
Agirated Rhinoceros 0371872018 01;09pm
Ajax Team 03/18/2019 01:24pm
Albino Rhino 03/18/2019 01:18pm
AMCHOR PANDA 03/15/2013 06:31pm 052H2018 01:44am
ANDROMED# SPIDER 03/15/2019 06:31 pm O301/2018 09:00pm
Appetizing Ferret 03/18/2019 01:09pm,

APT1 0371872019 07:04pm
Astonishing Pheasant 0371872019 01:09pm
BERSERK BEAR 03/15/2019 0B:32pm 1001902018 04:44am

The following functions are available:

Function Details

Opening the Adversary 1. Click the name in the Adversary Name column.
Details page for an

adversary

Performing a search for 1. Click the number in the Number of Indicators column to
related indicators set the adversary name as a search criterion and open

the Advanced Search page.

Opening the Event 1. Click the date in the Most Recent Event Date to open
Details page for an the Event Details page.

adversary event

Changing the number 1. Click the paging batch option located to the bottom-

of entries displayed in right of the table.

the table

Sorting the table by a 1. Click the column header. To reverse the column sorting
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Function Details

column order, click the header a second time.

Searching within the 1. Click within the search box at the top of the column,
Adversary Name and enter your search criteria.

column

Adversaries Overlap Table

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators.

ADVERSARY OVERLAP

DATE = OVERLAPPING ADVERSARIES = ADVERSARY NAMES % TYPE % OVERLAPPING INIMCATOR #

04/02/2019 02:10pm 2 ABCThreat, nameAdversary Emnall Subject rest123

The following functions are available:

Function Details

Opening the Adversary Details 1. Click the name in the Adversary Name

page for an adversary column.

Opening the Indicator Details 1. Click the identity in the Overlapping Indicator

page for an overlapping indicator column.

Changing the number of entries 1. Click the paging batch option located to the

displayed in the table bottom-right of the table.

Sorting the table by a column 1. Click the column header. To reverse the
column sorting order, click the header a
second time.
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Function Details

Searching within a column 1. Click within the search box at the top of the

column, and enter your search criteria.

Indicator Distribution Pie Chart

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators.

INDICATOR DISTRIEUTION
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The following functions are available:

Function Details

Viewing more information 1. Hover over a colored section of the pie chart to open

about a selected value a popup identifying the indicator.

The number of times the indicator was found within the
specified time frame, and what percentage of the total

number of indicators it represents.

Hiding or unhiding one of 1. Click the indicator on the left of the pie chart to
the values from the pie remove it; click a second time to reinstate it.
chart
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Function Details

Adjusting the time frame 1. Click the dropdown menu at the top right and select
of the information dis- the desired timeframe.
played

You can select from:

Last 24 Hours

o Last7 Days
Last 30 Days

o LastYear

« User-set custom range

Printing the graph or sav- 1. Click the hamburger menu = and select the desired
ing itas a PNG, JPEG, option.
PDF, or SVG

Events Overview

The Events page provides a high-level view of what types of events have occurred and how

frequently they are occurring.
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Events Overview

Analylics Mew Events
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To Access the Events Overview page:
1. In the navigation menu, choose Analytics > Events.
The Events Overview page opens.
The tab options include:

o Events History Scatter Plot

o Monthly Heatmap

« New Events Summary

Events History Scatter Plot

The scatter plot points are plotted by date (x-axis) and hour (y-axis). The legend under the

scatter plot identifies the different kinds of events shown.
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The following functions are available:
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Function Details

of the event types

Viewing an event’s name, date 1. Hover your mouse over an event on the scatter
and time, and source plot to see its name, date and time, and source.
21

:s;;lue:tsl?d}%???%é:ggéﬁ:mﬁﬁm issued to dionaea.carnivore.it with common name Nepenthes Development Team ¥
E 12 ' . = > " ; - + 0
9 b - "
. » l . ] L s L ]
0 ''m [ ] ] L ] n ] [ ] [ ] [ ]
Opening the Event Details 1. Click the event in the scatter plot.
page for one of the events _ . . )
For more information, see Object Details Page.
Hiding or unhiding one or more 1. Click the event type in the legend immediately

below the scatter plot to remove it from the

graph; click it again to reinstate it.
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Function Details

Adjusting the time frame of the 1. Click the dropdown menu at the top right and

information displayed select the desired time frame.
You can select from:

Last 24 Hours

o Last7 Days
Last 30 Days

Last Year

« User-set custom range

Printing or downloading the 1. Click the hamburger menu = and select the
scatter plot as a PNG, JPEG, desired option.

PDF, or SVGfile
Monthly Heatmap

The Monthly Heatmap table lists events that happened per adversary each month. Shading
of the monthly totals is used to allow you to quickly scan for patterns in the events and to

quickly detect events with higher monthly counts.

MONTHLY HEATMAP {3 Last Year =
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The following functions are available:

Function Details

Viewing an event’'s name and 1. Hover your mouse over an event on the
monthly count heatmap to see its name and monthly
count.
Jan 2018 Feb 2018 Mar 2018 Apr 2018 May 2018 Jun
338 team 0 anonymous: 2 0 o 0
anonplus 0 February 2018 0 0 0
anonymous. 0 2/7 0 [ 0
apt 1 1 0 0 0 0
apt-28 0 1 0 0 0
apt-37 0 1 0 0 0
cyber-berkut 0 1 0 0 0
fancy bear 0 0 0 0 0
group 123 0 2 0 [} 0
hidden cobra 0 0 0 0 1
oilrig 0 1 0 0 0
operation darkseoul 0 o 0 0 1
scarcruft 0 1 0 0 0
stone panda 0 0 0 0 1
Adjusting the time frame of the 1. Click the dropdown menu at the top right
information displayed and select the desired time frame.

You can select from:

o Last24 Hours

Last 7 Days
o Last30 Days
o LastYear

« User-set custom range

Printing the graph or Saving itas a 1. Click the hamburger menu = and select

PNG, JPEG, PDF, or SVG the desired option.
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New Events Summary

The New Events Summary table provides a breakdown of events by date, type, title, and

sources.
DATE - TYRE = TME = SOURCES
by date : Start t
11/21/2018 DZ:44pm Exfiltraticn Attack Event: 110 Johnryu
1119/2018 12:44am Login Compromise Attack Event: 109 JehnnyU
11172018 08:44pm ‘Watchlist Attack Event: 107 JohnryU
11/11/2018 07:44am Dos Amack Attack Event: 108 Johnmyu
11/06/201 8 05:44am SQL Injection Attack Attack Event: 112 JohnmyU
1170372018 11:44pm Malware Attack Event: 106 Johnryu
11/03/201 8 12:44am Command and Control Attack Event: 111 Johnmyll
10/28/2018 05:44pm Login Compromise Attack Event: 102 JohnryU
10/26/2018 01:44pm Exfiltration Attack Event: 103 Johnmyu
10/19/201 8 04:44am Command and Contral Attack Event: 104 Johnryl

<l z 3 45 6 7> Rowsperpage 10 =

The following functions are available:

Function Details

Opening the Event Details page 1. Click the eventtitle.

for one of the events _ _ ) )
For more information, see Object Details Page.

Changing the number of entries 1. Click the dropdown menu at the top right of
displayed in the table the table, and select the desired option.
Sorting the table by a column 1. Click the column header.

2. Click the header a second time to reverse sort

order.

_ o 1. Click within the search box at the top of the
Searching within a column o
column, and enter your search criteria.
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Files Overview

The Files Overview page provides you with a pie chart displays the percentage of different
types of files within the system and a table that lists the files, the date and time they were cre-
ated, their title, their source, their category, and associated keywords.

Files Overview

OVERVIEW

ThreatQ C5V File: 1%

Crowdstrike Intelligence: 2%
FireEye Analysis: 3%
Ceneric Test 7%

8

=

=

STIX: BE%
DATE = TITLE = SOURCE CATEGORY KEYWORDS
O Filter by date A, Start fyping, L Start typing, 1 Start typéing.
0320/2019 05:33pm Eenerate_campaign.py threatg@threatg.com CrowdStrike Intelligence &
03/20/2019 05:30pm techsupport.txt threatg@threatg.com CrowdStrike |ntelligence o
N tgt_threatq_et-cabbb0d2-2f16-43
03182019 01:4%9pm ] BOer-b3341 5463891 sl Super@threatg.com STIX &

Available views include:

« Files Pie Chart

« Files Table
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Files Pie Chart

The File Types pie chart displays the percentage of different types of files within the system.

OVERVIEW

Threald CFV File: 1% i Cuckos: 1%

CrawdStrike Intelligence: 2%

Threar] CSW Filie
FircEye Analysis: 3%

Files: 1

Ceneric Text: 7%

Values

STIX: BER

The following function is available:

Function Details

Viewing more information 1. Hover over a colored section of the pie chart to

about a selected file open a popup that gives the number of attach-

ment types.

Cuckoo: 1% FireEye Analysis
Files: 3

CrowdS 2%

FireEye Analysis: 3%

Generic Text: 7%

Printing the graph or Saving it 1. Click the hamburger menu = and select the
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Function Details

as a PNG, JPEG, PDF, or desired option.
SVG

Files Table

Immediately below the Browse pie chartis a table that lists the files, the date and time they

were created, their title, their source, their category, and associated keywords.

DATE TILE = SOURCE CATEGOAY KEYWORDS
Filter by date SEAMT typing... SEart typing... 3

03/20/2019 05:33pm generate_campaign.py threatg@threatg.com CrowdStrike Intelligence i

03/20/2019 05:30pm techsuppart . txt threatg@threatg.com CrowdStrike Intelligence iy
tgt_threatq_et-cabbbOd2-2f16-43

03/18/2019 01:49pm ) e :.}}41 e Super@threats.com STIX &y

03/18/2019 01:4gpm 71T PRCIABETEAER A Super@threatq.com STIX &
nd_threatq_indicator-cfbcdfod-d

03/18/2019 01:4%pm 068-4dc8-a57b-cda54868bf28.x Super@threats.com STIX )
m
nd_threatq_indicator-20788288-

03/18/201901:48pm 9690-4766-a314-6bBa18325a%91, Superi@threatq.com STIX =)
M
nd_threatq_indicator-443e4e59.

031872019 01:48pm Th29-4243-BeB0-5af3b7M07a34.x Super@threat.com STIX i
m
coa_threatq_coa-ccf236e2-3126

03/18/2019 01:47pm ryiiirs l—._, 2817 CA06H om Super@threatq.com STIX o)

031872019 01:47pm Campaign.xml Super@threats.com STIX iy
cam_threatq_campaign-8a56607

03/18/201901:46pm 2-5h&1-dfaf-aced-16525ba 144 x Super@threatqg.com aTix )

m

(“2 3 4 5 6 7 .. 11 » Rowsperpage 10 ~

The following function is available:

Function Details

Opening the File Details page for a 1. Click the name in the Title column.

file

Changing the number of entries dis- 1. Click the paging batch option located to the
played in the table per page bottom-right of the table.
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Function Details

Sorting the table by a column 1. Click the column header.

2. To reverse the column sorting order,

click the header a second time.

Searching within a column 1. Click within the search box at the top of

a column, and enter your search criteria.

Downloading a file 1. Click the download icon #=.

Indicators Overview

The Indicators Overview page provides an insight into what indicators have been added to
the system within the last 15 days, as well as an overview of how many indicators fall under

each indicator type.
To Access the Indicators Overview Page:

1. From the navigation menu, click on Analytics and choose Indicators.
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The Indicators Overview page will open with three view tab options at the to of the

page.
THREATQ 3

Indicators Overview

Cverview Mitwaork Hess

RECENTLY CREATED INDICATORS

25

12
10
5 4
; l
. N

Apr2 Apri Aprd Apr 7 Apr§ Aprg Apri0 Apr 11 Apri2 .\\pﬂ; Apr 14 hpr!s Aprig  Apriy

Indicators Created
o

STATUS HETWORK HOST TOTAL
Active 339 1] 339
Expired

Indirect

Review 2m
Whitelisted

Totals 541 541

The page is broken down into different Indicator class views that are accessible via the
tabbed navigation located at the top of the page.

The tab options include:

« Overview
« Network (Indicator Class = Network)

« Host (Indicator Class = Host)
Summaries included on the Indicator Overview Page Include:

o Recently Created Indicators Histogram

o Summary Status (Overview view only)
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« Most Recent 100 Indicators

Attributes Table (Network and Host views only)

Recent Sources (Network and Host views only)

Attack Phases (Network and Host views only)

Attack Phases

Attack Phases are the ways an indicator might be used and are listed as indicator attributes.
The Attack Phases pie chart displays the number of indicators that fall under each attack
phase.

ATTACK PHASES [ Lt 30 Days =

The following functions are available:

Function Details
View the Number of 1. Hover the mouse over a portion of the pie chart to view
Indicators for an Attack a popup the Attack Phase and number of indicators
Phase associated with it.

2. Clicking on a pie chart section will open the Indicator

Search page with the specific filter settings used for

ThreatQ User Guide, Version 4.30 328



THREA TQ H Analytics

Function Details

that selection.

Q_ Indicator Search

Adjust the Date Range | The default Date Range is 30 days.
for the Information Dis-
laved 1. Click the date range icon located to the top-right of the
aye
pay chart and use the dropdown menu select the desired

range.
Users can select from:

Last 24 Hours

« Last7 Days
Last 30 Days

Last Year

o User-set custom range

Hide a Values from the 1. Click on a Attack Phase in the legend to the left of the
Pie Chart pie chart to hide it.

The Attack Phase will be removed from the pie chart and

the source in the legend appear greyed out.
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Function Details

2. Click on the Attack Phase again to add it back to the
pie chart.

Attributes Table

The attributes list on the left side displays attributes related to indicators in your system.

ATTRIBUTES

Select an attribute below:

Showing 1o 10 of 30 fowcount: 10 